
Deltek Ajera 10
Getting Started: Project Managers

June 12, 2024



While Deltek has attempted to verify that the information in this document is accurate and complete, some 
typographical or technical errors may exist. The recipient of this document is solely responsible for all 
decisions relating to or use of the information provided herein.
The information contained in this publication is effective as of the publication date below and is subject to 
change without notice.
This publication contains proprietary information that is protected by copyright. All rights are reserved. No part 
of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, or 
translated into another language, without the prior written consent of Deltek, Inc.
This edition published June 2024.
© Deltek, Inc.
Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary 
information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is provided 
for use only in accordance with the terms of the license agreement. Unauthorized reproduction or distribution 
of the program or any portion thereof could result in severe civil or criminal penalties.
All trademarks are the property of their respective owners.
 
 
 
 
 
 
 
 

i – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



 

What you can do in your dashboards: Project managers 1
Your information needs 1
How do they work? 1

What you can do in the menu: Project managers 2
What reports and inquiries you might see 2

Lessons about the menu: Project managers 4
E-learning lessons for project managers 4
Industry webinars 4

Quick path through Ajera 5
Start a project 5

Budgeting bottom-up 5
Budgeting top-down 6

Manage your projects 8
How to get the most out of it 13
Where to see it 13
What it looks like 13

Manage your consultants and collections 14

Updating clients 20
About clients 20
Changing a client 20
Copying a client, vendor, employee, or contact 21
Deleting a client, vendor, or contact 21
Inactivating a client, vendor, or contact 22

Managing projects 23
About your Project Command Center 23
Concepts 24

Integrated with accounting 24
Project templates 24

ii – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



Estimating and budgets 25
Managing resources 25

Views 30
Your project list 30
Your project detail 30
Project Command Center reports 30
To select projects to view 30
To select project detail to view 31

Templates 34
To change a project template 34
To copy a project template 34
To delete a project template 34

Budgets 35
Budgeting bottom-up 35
Budgeting top-down 35
Activity type totals 35
Resources 35
Tasks 36
How activity type totals and resources work 36
Top-down budgets 36
Bottom-up budgets 36
Example 38
To budget with ajeraCore 43

Changes to projects 45
To change a project 45
To change a project status 46
To change a phase status 47
To delete a project 47
To add a phase while working with a project budget 47
To delete a phase 48
To add a resource 48
To delete a resource 49
To schedule a project 49
To include multiple clients on a project 51

iii – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



Client invoice adjustments 51
Add the adjustment 53
Select how the adjustment appears on the invoice 54
Add the adjustment 55
Select how the adjustment appears on the invoice 56
Deleting an invoice adjustment from Manage > Client Invoices 61
Deleting an invoice adjustment from >  Manage  > Project Command Center 61

Consultant management 62
To turn on consultant budgets 62
Step 1: Review the budget fields in company preferences 63
Step 2: Add the columns to the Manage tab 63
To add a labor budget with the Consultant Management add-on 63
To track consultant insurance 64
To delete a consultant budget 66
To delete an expense budget 66

Business Development 66
Setting up BD 67
Managing BD efforts 67

To change a marketing stage 68
To change a marketing final disposition 69
To copy a marketing stage 69
To copy a marketing final disposition 69
To delete a marketing stage 70
To delete a marketing final disposition 70
To inactive a marketing final disposition 70
To add a Business Development phase to an existing project or template 71
To update a BD project 71
To delete a BD project 72

Reports 72
Inquiries 73

Billing review 74
To display billing review notifications and the Billing Review Stage column 75
To change the Invoices inquiry 76
To review an invoice from the Project Command Center 76

iv – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



Schedule Manager 77
To add employees to a project 79
To change an employee on a project 80
To delete an employee from a project 80
Before you begin 81
To view project hours 81
Before you begin 83
To schedule hours by project 83
Before you begin 84
To view employee hours 85
Before you begin 86
To schedule hours by employee 86
To review your schedule 87
Before you begin 87
To export scheduled by project 87
Before you begin 88
To export schedules by employee 88

Entering and managing timesheets 89
About timesheets 89
Entering a timesheet 90
Submitting a timesheet 92
Printing a timesheet 92
Copying a timesheet 93
Using the timer to track start/stop times 93
Using the timer without tracking start/stop times 94
Tracking in/out times 95
Changing a timesheet 97
Unsubmitting a timesheet 100
Deleting a timesheet 100
Activities 100

To change an activity 101
Not available in ajeraCore or ajeraCore + add-ons 101
To copy an activity 103

v – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



To delete an activity 103
Overhead groups 104

To change an overhead group 104
To copy an overhead group 106
To delete an overhead group 106

Ajera Mobile Timesheets 106
Setting up Ajera Mobile Timesheets 106
To submit or unsubmit a timesheet 109
To correct rejected time 109
To delete time entries 110

For managers and supervisors 112
To approve a timesheet 112
To unapprove a timesheet 115
To approve time as a project manager 116
To view an employee timesheet 116
To view project time 119

Entering and managing expense reports 121
About expense reports 121
About expense reports with multi-company 122
Entering an expense report 123
Changing an expense report 126
Copying an expense report 129
Deleting an expense report 129
Printing an expense report 129
Submitting an expense report 130
Unsubmitting an expense report 130
Paying an expense report 131
For managers and supervisors 131

To approve an expense report 131

Understanding reporting options 134
Overview 134

Determining what you need 134

vi – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



What Ajera offers you 134
What to use when 134
Standard reporting or customization 135
Financial statements 136
Other financial reports 137

Other financial information 137
Relevant reports while you work 137
Project schedule information 138
Detailed project reports 138
Popular reports 139

Snapshot report 139
Progress report 140
Project Earnings report 141
Budget Variance report 142

Focused project information 143
Session journal reports 145
Session  inquiries 146
Other inquiries 146
Financial reconciliation 147
Explore! 147
Anatomy of a report 147
A close-up look at the reports toolbar 148
Customizing reports 148

Use   (Customize) 149
Modify an existing report or create your own report 149

Printing and exporting reports 150
Know which inquiry you need 150

Types of inquiries 150
Inquiries and inquiry descriptions 151

Anatomy of an inquiry 152
A close-up look at the Inquiry toolbar 152
Creating an inquiry 153

Work with columns 153
Set conditions 153

vii – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



Set time periods 153
Example 153

Printing and exporting an inquiry 154
Preview and print an inquiry 154
Export an inquiry 154

Templates for financial statements 154
Accessing financial statements 155
Anatomy of a financial statement design 155
Printing and exporting a financial statement 156
Additional training 156
Axium Consulting Services 156
Templates Library 156
Distribute reports 157

Reports produced with report views 157
Custom reports 159
Before you begin 159
To set up a custom report 159
Distribute inquiries 160

Show data pertaining only to a specific employee 160
Organize custom inquiries for distribution 160

Distribute financial statements 161
Unlimited access to reports and inquiries 162
Sharing reports and inquiries 162

Reports 163
Inquiries 163

Unlimited access to the Financial Statement Designer 163
Sharing financial statements 164
More than one job role 164

Reports 165
To select report options 166
To drill down on a report 167
To export a report 167

To include contract amounts on project reports 168
To change a report view 169

viii – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



To delete a report view 169
Inquiries 170

Saving a standard inquiry 171
Saving an inquiry you previously created 171
Change the order of an inquiry 171
Group inquiries together in a submenu 171
Move an inquiry to a different   submenu 172
Move an inquiry to   the main menu 172

To add a predefined inquiry column 175
To create a new inquiry column 176
To hide an inquiry column 178

Showing user data in a formula column 178
Showing user data in an inquiry 179
Showing user data in an link 180

To change an inquiry 180
To delete an inquiry 180
To add a link to an inquiry 181

Setting conditions for the link 181
To change an inquiry link 183
To remove a link from an inquiry 183
To set up conditions for an inquiry 183
To chance or delete inquiry conditions 185

Assigning a cutoff   date or date range 186
Assigning   a time period based on the current date or cutoff date 187

To display data in an inquiry for a specific time period 188
Exporting an inquiry to Excel 189
Exporting to Excel (.xls) 189
Exporting to Excel - Data Only (.xls, .xlsx) 189
Exporting to Excel Preview - Data Only 190

To export an inquiry to Outlook 190
To export an inquiry to Acrobat 191
To export an inquiry 191
To import an inquiry 191

Financial statements 192

ix – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



Design tab 192
Preview tab 193
Entering information 194
Using properties 195

To change a financial statement design 198
To copy a financial statement design 199
To delete a financial statement workbook 200

Step 1: Verify the rows 200
Step 2: Verify the columns 201
Step 1: Verify the rows 202
Step 2: Verify the columns 202
Step 1: Verify the rows 203
Step 2: Verify the columns 204

To print a financial statement 204
To export a statement workbook to another database 205
To export a financial statement to Excel 205
To import a financial statement workbook: 206
To enter formulas in the worksheet 207
To create footers in the statement 208
To repeat column or row headings in a statement 208
To hide a row or column: 209
To unhide a row or column: 209
To add, delete, or rename a worksheet 209
About other reporting dates 212
About importing 212
To create custom date properties 213
To change a custom date property 214
To delete a custom date property 215

Step 1: Set up the statement group 215
Step 2: Preview and print a statement group to verify setup 217
Step 3: Set security for the statement group 218

To change a statement group 218
To delete a statement group 220

Previewing or printing a statement group 220

x – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



Exporting a statement group to Excel 221
To export from the Financial Statements > <statement group> menu option: 221
To export from the Manage Financial Statements > Groups menu option: 222
To enter a company budget 222
To copy a company budget 223
To change a company budget 223
To delete a company budget 224

Index 225

xi – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.



What you can do in your dashboards: Project 
managers

Your dashboards provide real-time snapshots of information you need to make 
critical decisions without the need to interpret data or view multiple reports. 
Dashboards are customizable to reflect the workflow at your firm.  What you see on 
your dashboards depends on your security settings and whether or not you are set 
up to design your own dashboards. 
Don't see what you need? Work with your manager to determine your dashboard 
needs. 

Your information needs
As a project manager, your dashboards can be set up to help you:

 l See recent activity on your projects quickly.
 l Access and review invoices instantly.
 l Identify project slippage early.

These are just a few examples of what your dashboards can provide. 

How do they work?
The dashboards display the information that matters the most to you:

 l Home page: View an aggregate of your key information. With one look, you're instantly up-to-date. 
 l <Variable> pages: Click a link in a widget to go to a <variable> page that displays information specific 

to what you selected, such as the Project page.
This example illustrates how your dashboards may be set up:

(click to 
expand)

1 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

What you can do in your dashboards: Project managers



What you can do in the menu: Project managers
Typically, you can:

 l View your projects only.
 l Set up clients.
 l Enter timesheets.
 l Enter expense reports.
 l View your schedule, your project costs, and schedules in Schedule Manager.
 l Create projects, templates, and invoice groups in the Project Command Center.

What reports and inquiries you might see
The Ajera Administrator, accounting manager, and principal typically have unlimited access to all reports, 
inquiries, and financial statements. They then grant access to others, as needed, for viewing and printing 
individual reports, inquires, and financial statements.
They might grant you, as a project manager, access to the following reports and inquiries:

Reports
 l Activity List
 l BD Progress
 l Billing Report
 l Budget Variance
 l Client List
 l Commitment Management
 l Contact List
 l Executive Summary
 l Hours Distribution by Project
 l Manage Timesheets
 l Plan
 l Progress
 l Project Backlog
 l Project Earnings
 l Project List
 l Project Profit
 l Project Workload
 l Snapshot
 l Win Rate
 l Work-in-Progress Aging
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Inquiries
 l BD Phase
 l Client Invoice
 l Client Receipt
 l Marketing Stage
 l Phase
 l Project
 l Project Manager
 l Project Type
 l Reported Percent Complete
 l Resource
 l Resource & Task
 l Task
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Lessons about the menu: Project managers
Here's a quick look at the areas of the Ajera Online Help that  pertain especially to your work in the menu as a 
project manager.

E-learning lessons for project managers
In Ajera, you'll find two different types of e-learning lessons depending on what you need:

Video lessons.   See Ajera in action for those topics where you need to watch exactly what happens.

 Quick lessons.   See abbreviated instructions, as you follow along with numerous illustrations of the 
software.

Managing time and expense

Lesson Video lesson or quick lesson Duration
Approving time 3:12

Entering expense reports 2:54

Approving and paying expense reports 2:05

Updating tasks assigned to you 3:14

Reviewing employee tasks 1:58

Managing projects

Lesson Video lesson or quick lesson Duration
Managing BD Projects self-paced

Scheduling your employees 4:48

Using billing review as a project manager self-paced

Industry webinars
View webinars on architectural and engineering industry best practices. Sign up for our latest webinar or view 
Axium's free library of recorded webinars that are available anytime, on-demand.
This link goes to the main Axium website. 
Industry webinars
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https://help.deltek.com/Product/Ajera/8/Content/Videos/EnteringExpenseReports.mp4
https://help.deltek.com/Product/Ajera/8/Content/Videos/ApprovingPayingExpenseReports.mp4
https://help.deltek.com/Product/Ajera/8/Content/Videos/UpdatingTasksAssignedToYou.mp4
https://help.deltek.com/Product/Ajera/8/Content/Videos/ReviewingEmployeeTasks.mp4
http://learningcenter.axium.com/DocsAndLessons/quicklesson_ManagingBDProjects.pdf
https://help.deltek.com/Product/Ajera/8/Content/Videos/SchedulingYourEmployees.mp4
http://learningcenter.axium.com/DocsAndLessons/quicklesson_UsingBillingReviewforPMs.pdf
http://www.axium.com/support/webinars.aspx


Quick path through Ajera

Start a project

A Project Manager's Path through Ajera course
Here, you'll follow a typical workflow of how to perform your common project management tasks in Ajera.

Start a project 
Manage your project 
Analyze your project's success to date
Manage your consultants and collections

Budget the project
unavailable in ajeraCore

Note: If you use ajeraCore, skip this section of the lesson and proceed to Manage your project. For 
information on budgeting, see this topic in help (  > Help > Online Help): Budgeting with 
ajeraCore.

You budget and schedule a project on the Manage tab of the Project Command Center (  > Setup > 
Projects).

Budgeting
(unavailable in ajeraCore )
You can budget with as much or as little detail as you want,   depending on your needs and the complexity of 
your projects. It is most   common to begin a budget in one of these general ways:

Budgeting bottom-up
You may use this method when you want to determine the total contract   amount for a project based on the 
number of hours each phase or task should   require. Ajera calculates the project totals for you.
Bottom-up budgeting is useful when you want to develop a budget to do the following:
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 l Control the project hours   and costs.
 l Produce a project proposal.

You typically create bottom-up budgets for hourly based projects. Bottom-up   budgeting lets you specify the 
number of hours for each labor or expense.   When you enter hours, Ajera calculates the contract amount based 
on the   project's billing rate table or from average billing rates entered for the Employee   Type (  > Setup > 
General > Employee Types) or in  > Setup > Company > Preferences. Ajera calculates the cost from the 
employee’s   pay rate or from average cost rates entered for the Employee Type or in  > Setup >    Company > 
Preferences.

Budgeting top-down
You may use this method when you know the total contract amount or total   number of hours needed to 
complete a project. For some projects, the fee   is based on what the market can bear. In this case, you need to 
develop   a budget for each phase and task required to complete the project. This   top-down method also works 
well for developing feasibility budgets. 
When building a top-down budget, you enter the total contract amount,   total hours, or total cost for the project. 
You then specify the percentage   of the total project for each phase or subphase.

As you've learned, you perform your project work in the Project Command Center (  > Manage > Project 
Command Center). You budget and schedule a project on the Manage tab.

Schedule the project
unavailable in ajeraCore
Begin your project schedule on the Manage tab of the Project Command Center. Enter estimated start and 
completion dates and, as the project proceeds, update the schedule with actual dates. You will learn about 
managing employee schedules using Schedule Manager on the next page of this lesson. 

 1. Open the project (click  >  Manage > Project Command Center and in the project list at the top of 
the window, click the project).

 2. Click the Manage      tab.
 3. Review your work breakdown       structure in the project tree and make      any changes, if needed. 

Add resources      or add tasks, as needed.
About tasks:  
Because you use tasks to track the progress and scope of       a project, you enter hours for a task but 
not       cost amounts or rates. When using tasks, you continue to track project       costs through resources 
and phases. However, you can choose to roll up      task hours to resources or phases, which then does 
update cost amounts.

 4. To change the       type of information that currently appears on the Manage       tab, use         (Customize) to 
select the project      detail you want to view.

 5. As you schedule your project, you can work with dates as follows.
Gantt chart:
In addition to entering and changing dates directly in cells on the table, you can change dates using 
the Gantt chart (timeline) on the right of the window. You can also change dates by clicking and 
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dragging them in the Gantt chart. The Gantt chart always displays actual start and completion dates if 
available. Otherwise, it uses the estimated dates.
To show or hide the Gantt chart, click the Hide Gantt or Show Gantt button on the bottom of the 
window.
Changing dates as you work:
As you change actual start dates and estimated start dates, Ajera automatically updates any higher-
level dates or lower-level dates so that dates on phases are never earlier than the date of the phase or 
project that contains them.
Similarly, as you change estimated completion dates, Ajera automatically updates any higher-level or 
lower-level dates so that dates on phases are never later than the date of the phase or project that 
contains them. However, Ajera does not automatically update completion dates when you change a 
lower-level date.
You can change an estimated or actual start date in one of the following ways:

To Do this
Keep the same duration when 
changing a start date

 1. Right-click the date, and click Adjust start date.
 2. In the window that appears, enter the new start date, 

and click OK.
Ajera automatically adjusts the end date. It also adjusts the 
dates for a phase's subphases, resources, and tasks 
accordingly.

Change a start date without 
automatically adjusting the end 
date

Type the new start date directly into the cell on the table.

 6. You can build a schedule       in Ajera in a variety of ways, depending on what works best for you and       your 
firm. Here are some general guidelines for a typical way you may      work with a schedule at various 
stages of the project:

To Do this
Start a 
schedule

 1. In the row for the project,          enter the date when you plan to start and complete 
work in the Est Start         Date and Est Completion Date columns for the project.  
If you have already started work on the project,       enter that date in the Start 
Date column on the row for the project.

 2. Repeat these instructions         for phases and subphases, as needed.

Maintain 
a 
schedule

At regular intervals, you have probably planned to estimate the amount        of work that 
you have completed on the project and on its phases. For       the project, and for each 
phase:

 1. Enter the percent of work         that is complete in the % Complete column. 
 2. Enter the date that you         are reporting the percent complete in the % Complete 

Date column.
Ajera displays the most recent percent and date that were last entered. If you 
entered a percent or date in error, be sure to highlight the information and 
click the Delete button in both the % Complete and % Complete Date fields, 
click Save, and then enter the percent and date you want.
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To Do this
 3. Change estimated and actual         start and completion dates, as needed.

Complete 
a 
schedule

Enter the completion date for the project.

 7. When      you are finished working with the schedule, click Save.

Schedule employees
unavailable in ajeraCore
In Ajera, project managers, department managers, and principals can use Schedule Manager to schedule 
employees on projects, manage schedules, and analyze project performance and employee workload. 
Employees can keep up-to-date on their own schedules, as well.
As a best practice, add employees to your projects in the Project Command Center, and then schedule those 
employees in Schedule Manager. That way, budgeted hours and dollars from the Project Command Center 
are available to guide you. 
However, you can also add employees to projects in Schedule Manager, but budgeted hours or dollars may 
not be available. In that case, you can go to the Project Command Center and enter the budgeted hours or 
dollars there.
As you schedule, and as time is entered to the project, Ajera updates the actual hours and dollars. This makes 
it easy to tell which projects are going over budget and which employees are underutilized or overutilized.
Because the scheduling does not affect accounting, billing, or contracts, you can easily change schedules as 
needed. 

Manage your projects

Manage your project
You will learn how to use Ajera to perform some basic tasks in the day-to-day managing of your projects.
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Review and approve timesheets

 1. Click            >  Manage   >           Time & Expense. 
 2. Click the Time   by Project tab.
 3. To change which timesheets appear, click  (Change View).

 4. To see detailed time by   employee for the project, click the  next to the name of the project. 
 5. To see  hours   by date for the employee, click the  next to the name of the employee.

 6. To see the timesheet, double-click   the timesheet date.
 7. If you do not want to approve   certain hours on the timesheet, do one of the following:

 l Change the hours for your employee (if allowed through the  > Setup > Company > 
Preferences settings).

 l Reject the time   so the employee can review and change the timesheet. When you reject time, 
Ajera enters it on the client invoice with   a status of Hold.

9 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

Quick path through Ajera



The hours for rejected time appear in   bold to indicate that you rejected   them. If you reject time for a 
row or cell by mistake,   simply right-click, and click Reject again.
If you reject any hours on a timesheet, you cannot approve the timesheet.   It is automatically 
unapproved and unsubmitted. 

 8. To   enter any manager notes or comments for a cell, do the following:
 l If the Manager Notes column does not appear in the Hours   Detail table, click  (Customize), 

select the Manager notes   check box, and click OK.
 l Click the cell in the table at the top or middle of   the window that you want to enter notes for.
 l In the Manager Notes cell in the Hours Detail table, enter your notes.

 9. Do one of the following:

Review the status of tasks you assigned to team members
unavailable in ajeraCore
Supervisors or accounting managers (or other employees with security   access) can review, change, and 
delete tasks for employees, as follows:
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 1. Click  >  Manage >          Time & Expense. 
 2. Click the Tasks by Employee tab, which contains a list of tasks assigned to employees. 

 

 3. If you want to change the   tasks you see in the list, click  (Change View), make selections on the 
Change   View window, and click OK.

 4. If you want to show or hide   a column in the list, click  (Customize), select or clear the check box for 
the column,   and click OK. 

 5. Do one of the following:

To Do this
Change information  1. Change information   for a task, as needed.

 2. Click Save.

Add a task For an overhead project:
 1. Click the next available   row.
 2. Complete information   for the row.
 3. Click Save.

Delete a task  1. Click the task that you   want to delete.
 2. Click Delete.
 3. Click Yes   to the message asking if you want to delete the 

task.
 4. Click Save.

 6. Click Close.

To print or inquire further on the information, select an inquiry from   the  >  Report > Standard Inquiries   > 
Resource  menu.
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Update estimated start and end dates for projects and their phases
 1. Open the project (click  >  Manage > Project Command Center  and in the project list at the top of 

the window, click the project).
 2. Click the Manage tab.

 3. If you don't see the columns for estimated start and completion dates, click  (Customize) to add 
them.

 4. Click Save.

Update the RPC (% and date) for projects and phases
The Reported Percent Complete (RPC) is the amount of a project or phase that is complete as reported on a 
specific date in the project lifecycle. 
When you keep the RPC up-to-date, it helps you more accurately monitor the status of your project through 
Ajera's reports.
The RPC date is auto-populated with today's date.
You can sum up the RPC by selecting the % icon in the % Complete column. This will roll up the factored % 
complete based on the phase RPC's and contract amounts. The resource RPC do not roll up.

 1. Open the project (click  >  Manage  > Project Command Center, and in the project list at the top 
of the window, click the project).

 2. Click the Manage tab.
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 3. If you don't see the columns for reported percent complete, click  (Customize) to add them.
 4. Click Save.

To review a list of the reported percent complete for projects and phases, be sure to see the Reported Percent 
Complete inquiry. 

From the  >  Reports  menu, click Standard Inquiries > Project > Reported Percent Complete. You can 
easily print out inquiries and customize them as needed. For more information, in help (  > Help > Online 
Help), search for inquiries.

Monitor the current status of your project at a glance
Use the Snapshot report to manage day-to-day execution of your project. This   report can help answer 
questions, such as:

 l How is my project progressing?
 l What is available to bill?
 l How much budget (hours and   revenue) is left?
 l Who is working on my projects?

At a glance, you can view billed, spent, and WIP amounts, as well as   hours worked, to-date. You can view 
detail by labor, expense, and consultant.   You can further drill down to view spent and billed rates.
The project contract totals on this report are derived from the totals   that appear for projects on the Manage   tab.

How to get the most out of it
Be sure to enter contract amounts for the project and its phases as you work on them.  This gives Ajera good 
data at the project and phase level as long as you budget the project to the phase level. You enter and 
maintain contract amounts in the Project Command Center (  > Manage > Project Command Center> 
Manage tab).

Where to see it
In your Project Command Center, click the Snapshot   tab in the middle of the window. If you don't see it, click 

 (Customize) to add it.

What it looks like
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Manage your consultants and collections

Manage your consultants and collections

Overview
In a perfect world, your projects all come in on time and in budget. Your clients love your company and make 
their payments promptly and happily. Your cash flow is excellent, and business is only getting better and 
better.
In the real world, this is not always the case.
Bad weather delays work onsite, vendors raise their rates unexpectedly, things happen that are beyond your 
control.
Fortunately, some things are in your control - consultants and collections, for example. In Ajera, you can 
monitor and control consultant contracts, and track and collect on past-due client invoices with ease. So seize 
those tools and captain your company forward with confidence.

Consultants
An important aspect of any project is the ability to monitor and control consultant and expense contracts. 
These contracts are called commitments.

Why use consultant management
By managing consultant contracts, you can easily access the status of your commitments. For the life of a 
project, you have access to the amount invoiced from and paid to your consultants, as well as the amount that 
you invoiced your client and the amount that the client paid you. It is easy to manage pay-when-paid 
situations.
At the beginning, during contract negotiation, you can verify that a consultant’s insurance policies provide 
adequate coverage for the life of the project.
You can manage individual consultant budgets, also from the start of the project. You can track your budgeted 
consultant costs and fees directly to the project and phases. This gives you an accurate picture of your 
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commitments at each phase. You can even track multiple consultant and expense contracts for one project 
and phase.
As you enter vendor invoices, you can easily monitor consultant cost. Ajera automatically verifies invoices to 
the consultant cost budget and produces warning notices to ensure that consultants do not overbill and that 
projects stay within budget.
All the while, reports and inquiries provide real-time information that keeps you up-to-date on your 
commitments.

How to manage consultants in Ajera
To use consultant management, you perform these tasks:

 l Track consultant insurance, if needed.
 l Turn on consultant budgets and/or turn on expense budgets.
 l Set up a consultant or an expense budget.
 l Verify invoice distributions to cost budgets.
 l Produce the Commitment Management report and the Resource inquiry to view the status of your 

consultant and expense budgets. You can compare your consultant and expense budgets to what’s 
been invoiced and paid.

In the following graphic, precede each path with .

Consultant-related reports and inquiries
These reports and inquiries provide you with the level of detail you need to manage your commitments:

 l Commitment Management report
 l Consultant Pay When Paid report
 l Budget Variance report
 l Snapshot report
 l Project Earnings report
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 l Project Profit report
 l Billing report
 l Work-in-Progress Aging report
 l Vendor Insurance inquiry
 l Resource inquiry

Collections
Managing revenue flow, on paper and in the bank, is essential to forecasting cash flows and to improving your 
profitability. If your firm is not paid in a timely manner or is, in fact, not paid at all, your bottom line and your 
operational efficiency suffer.
To guard against this, Ajera provides you with several tools for tracking client invoices and monitoring 
accounts that are fast becoming past-due. You can then take appropriate action at each stage in the aging 
cycle and maintain control.

Track client invoices with reports and inquiries
When you set up and save a project in Ajera, it automatically creates a draft client invoice for you. As you 
enter time and expense, vendor invoices, and in-house expenses to the project, Ajera automatically adds the 
billing amounts to the draft invoice. During the project, you can review these reports and inquiries to keep up-
to-date on the status of your client invoices:

 l Client Invoice Aging report: Use this report to monitor cash flow and identify past-due accounts for 
collection calls. View a summary of outstanding balances, and drill into full detail of invoices and 
receipts. An aging of outstanding items is available at every level.
This report ages outstanding client invoices based on the invoice date or accounting date.
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 l Client Invoice inquiry: The standard columns in this inquiry provide general information, such as the 
status, client, project, invoice date, amount, and aging associated with the client invoice.
Supplemental information is available as predefined columns, such as invoice type and group; 
breakdown of invoice amount based on labor, expenses, and consultants; invoice footer and header 
text; and billing type and manager.

17 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

Quick path through Ajera



Track client invoices with billing review stages 
(unavailable in ajeraCore)
If you have do not have ajeraCore, you can use billing review stages to track the progress of your client 
invoices through the billing review process and beyond, if need be, to the collections stage. The invoices must 
be based on a standard invoice format or on a custom design created with the Client Invoice Designer.
A billing review stage indicates where an invoice is in the review, and can notify a reviewer when an invoice is 
ready. Billing review stages are optional and have no effect on the general ledger.
Ajera provides two stages by default, Pre-review and Final; you cannot change or delete them. When you set 
up a project or an invoice group, Ajera creates an invoice and sets it to the Pre-review stage. When you print 
an invoice as final, the billing review stage automatically updates to Final. You set up additional billing review 
stages in  > Setup > General > Billing Review Stages to mirror the other stages in your firm's billing review 
process.
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The Final stage, however, need not be the end of the process. You can set up a set of collections stages after 
that for tracking delinquent payments, each stage triggering a certain action from your firm. For example, at 15 
days past payment, you might assign a Reminder stage to the client invoice that notifies accounting to send a 
reminder letter to the client. At 30 days past, you might assign a Call stage to the invoice that notifies 
accounting to follow up with a phone call to the client. As time progresses, each stage can trigger an 
incrementally more forceful action, perhaps culminating in handing over the account to a collections agency or 
to writing off the invoice.

To use billing review stages, you perform these tasks:
 l Set up billing review stages.
 l Customize the Project Command Center and the Client Invoice List so you can view billing review 

stages.
 l Review invoices from the Project Command Center or from the Client Invoice List and assign billing 

review stages after the review.
 l Produce the Billing Review History inquiry to view the status of your client invoice during the billing 

review and collections process.
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Updating clients

About clients
When you set up clients, you make   all the related information available whenever you need to reference it   or 
use it. Set up information such as client names, addresses, contacts,   phone information, and so on. 

Changing a client
To change a client

 1. From the  >  Setup   menu, click Clients. 
 2. View clients in the list window differently,   if needed.
 3. Click the client you want to change, and click Edit. 
 4. In the name field, change   the client name, if needed.
 5. Change the client type,   if needed. 
 6. In the Date Established   field, change the date you started doing business with the client, if   needed.
 7. Multi-company only.  To link this client to a specific company in your organization, select the 

company. Ajera automatically selects the company in tasks involving the client to save you time. 
Otherwise, leave the Company field blank. 

 8. If you selected to automatically   number your invoices by client (  > Setup > Company > 
Preferences > Billing   tab), the Last Invoice Number field appears. 
If needed, change the number you want to   use as the starting point for numbering invoices. For 
example, enter 999   to start printing invoices with a number of 1000. If   blank, the first invoice has a 
number of 1. 

Note: If you enter characters in your invoice number, Ajera increments   only the numbers 
following the last character. When it reaches a limit, it   resets the numbers to zero. For 
example, 2004-00 is incremented up to   2004-99, and then restarted at 2004-00. If you 
expect to need more than   99 invoices, you would increase the number of digits in last 
section of   the number.

 9. Leave the Send   statement check box selected if you want to automatically include   this client when 
printing statements. Otherwise, clear it.

 10. If you set up finance charges   (  > Setup >Company > Preferences > Billing tab), the Create   finance 
charges check box appears. 
If you do not want to create finance changes   on any of this client's outstanding balances, clear this 
check box. Otherwise,   you are able to create finance charges for this client in Manage   > Finance 
Charges.

 11. If you selected the Create finance charges check box, enter   the percentage rate you want to charge 
this client if different from the   general rate you set up on the  > Setup >Company > Preferences > 
Billing tab.   

 12. The Prepayment Beginning   Balance field appears until you finish working with your beginning 
balances.   Enter or change the amount of prepayments for this client, as needed.
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Multi-company only. You can enter a prepayment in this field. Before you can apply the prepayment, 
you must first associate it with a project. To do this, see Associate a prepayment with a project in 
Entering beginning balance for client prepayments. 

 13. As needed, enter an Account ID associated with this client.
 14. As needed, change the phone   numbers and fax number for the contact. To the right of each number is   

the description for it, which you can also change.
 15. As needed, change the email   and website address for the client.
 16. Click the Address   tab to change address information for the client. To enter a mailing address that   is 

different from the address you just entered, clear the Same   as address check box. Type the mailing 
address. 

 17. Click the Contacts   tab. Change or enter up to twenty contacts for this client. In the Notes field to the 
right of each contact name, enter or change the description or any   notes about the contact. See 
Setting up contacts to add a new contact.

 18. Click the Attachments   tab, and change the attachment information,   as needed. 

 19. Click   the Notes tab to enter or change   any notes about the client.
 20. Click Save.
 21. Click Close.

Copying a client, vendor, employee, or contact
You can create a new client, vendor, employee, or contact based on an existing client, vendor, employee, or 
contact.

To copy a client, vendor, employee, or contact

 1. From the  >  Setup   menu, click Clients, Vendors, Employees,   or Contacts. 
 2. Click the item that you   want to copy, and click Copy. 
 3. Change the information for the item, as needed.
 4. Click Save.
 5. Click Close.

Deleting a client, vendor, or contact
You cannot delete   a client, vendor, or contact if it is currently used on a project. However,   you can make it   
inactive. 

To delete a client, vendor, or contact

 1. From the  >  Setup   menu, click Clients, Vendors, or Contacts. 
 2. Click the you want to delete, and click the Delete   button.
 3. Click Yes   to delete it.
 4. Click Close.
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Inactivating a client, vendor, or contact
If you inactivate a client, vendor, or contact, it cannot be used, but   it remains in the database and continues to 
appear on reports. 

 1. From the  >  Setup   menu, click Clients, Vendors, or Contacts. 
 2. Click the item in the list   that you want to make inactive, and click Edit.
 3. In the Status field, select Inactive. 
 4. Click Save.
 5. Click Close.
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Managing projects

About your Project Command Center
Learning Resource: Project Command Center Functional Guide
Your Project Command Center consists of these major areas:

Project list
Use this area to view pertinent information about your projects at a   glance. You can select which columns of 
information you want to view for   projects. You can also select to   see a Gantt chart (timeline).
Use the search to quickly find any project you selected to show in the project list. You can find a project by 
searching for project ID, description, or client.

Project detail
Use this area to work with the detailed information for a project. It   consists of a project tree, where you define 
and view the work breakdown   structure of your project. For each component in the project tree, detailed   
information appears in tabs on the right of the window.
Depending on your security settings, you may   see some or all of these tabs:

Project   Info tab
Use this tab to set   up and maintain general information for your project, in addition to billing   and invoice 
information.
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With Ajera, you can also track   and analyze your marketing efforts for projects. (This feature is unavailable in 
ajeraCore.)

Manage   tab
Use this tab to quickly sketch out a budget   for a potential project. After you win the project, budget it to the 
level   of detail you need. This tab is invaluable to project managers. With                     Ajera, you   can budget top-down or 
bottom-up.    
With Ajera or ajeraCore with Consultant Management add-on, you can also budget resources at any level of 
your project   work breakdown structure. You quickly add resources by a type of labor,   expense, or consultant. 
You can also schedule   your project to the level of detail you need, adding reported percent   complete and 
adjusting the schedule, as needed. 
In addition, with Ajera, you can add   tasks to closely track how the project is progressing.

Invoices tab
Use this tab to view the PCC Invoices inquiry,  which is accessible only from the Project Command Center. 
Use this inquiry to  review client invoice details and to preview client invoices. 
Unlike other inquiries, the PCC Invoices inquiry is the same for all  employees who have permission to view it. 
Any changes to the inquiry are visible to everyone  with access to it.

Note
:

Marketing and overhead projects will create a client invoice, which allows you to move marketing 
and overhead WIP to billable projects in client invoices.

Report   tabs 
Use these tabs to quickly review up-to-date   reports for the project you are currently viewing. Click       
(Customize) > Reports tab to select   the reports you want to view. 

Note: For ajeraCore, only the Snapshot report is available.

Concepts

About Ajera
Deltek designed Ajera to help architectural and engineering firms quickly produce accurate   estimates and 
complete projects on time and within budget.

Integrated with accounting
With Ajera, you have seamlessly integration of financial and project-related   information from time and 
expense entry, billing, and reporting. For example,   when building a budget, you can enter how many hours you 
expect it to   take to complete a task, and Ajera automatically enters the contract   amount using the rate table. 
On that same window, you can view an instant   report, which contains up-to-date information about the project, 
by clicking   a tab.

Project templates
Your firm may choose to work from project templates,   which help set standards for budgeting, naming 
conventions, work breakdown   structure, and security. 
When setting up Ajera, your firm can choose to work with templates   in one or all of the following ways:
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 l Use the industry-specific   templates provided, as-is.
 l Modify the industry-specific templates.
 l Create templates from scratch.

The industry-specific templates include the following:

Template Description
Quick project Use this template when you want to quickly start a project with a minimum   of detail 

and plan to enter the details later.

Top-down Use this template for projects that you want to budget top-down.

Bottom-up Use this template for projects that you want to budget bottom-up.

Top-down with 
Business 
Development

Use this template for projects that you want to budget top-down when using 
Business Development. It includes a Business Development phase to give you a 
head start at tracking your BD efforts.

Bottom-up 
with Business 
Development

Use this template for projects that you want to budget bottom-up when using 
Business Development. It includes a Business Development phase to give you a 
head start at tracking your BD efforts.

Estimating and budgets
You can easily create project budgets with Ajera. You can   use templates to help define essential information 
for estimating a project.   For detailed instructions about budgeting, see Budgeting   top-down and Budgeting 
bottom-up.

Managing resources
You can specify the resources that are required for   a project in several ways. You can start scheduling a 
project with unspecified   resources or resources specified only by employee type. As the project   progresses, 
you can change the resources to specify the exact names of   employees with their hours or percentage of the 
workload. You do not need to fully schedule all work so, if you choose to do so,   you can assign and manage 
only critical resources.
Working with the Gantt chart (timeline) and resources is simple because the   timeline is an interactive 
component of your work breakdown structure.
In Ajera, you also have reports that answer such questions as:

 l Do I have enough work? Too   much work?
 l Can I move projects around   to relieve timeline stress?
 l Can I project revenue in   the future?
 l Do I have the right type   of employee to complete the work that I have?

You can also add tasks when   you want to track the individual to-do items that comprise the work needed   to 
complete a phase or project.

25 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

Managing projects



About billing types
A billing type is a method for handling billing that reflects the contractual agreement with the client. Billable 
billing types available in Ajera are Time & Expense and fee-based1, which includes Fixed Fee, Percent 
Complete, Unit Price, and Percent of Construction Cost.
Different information is printed on an invoice depending on the billing type of the project. For example, a Time 
& Expense billing type prints   actual transaction detail, and a fee-based billing type prints an amount to bill that 
may not be based on actual   work performed. An invoice can contain both types of billing.
When you set up a project and select a billing type, you indicate the   way the client is billed according to the 
contract. You can change the   billing type at any time during the project lifecycle. 

1The project or phase is contracted to bill for the value of the work performed, not for the actual time and 
expenses expended. These projects or phases are identified with a billing type of Fixed Fee, Percent 
Complete, Unit Price, or Percent of Construction Cost.
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Billing type Description
Time & 
Expense

You bill the client for actual hours worked and expenses incurred on   the project. You 
can use this type if you bill the client with a billing   rate or a markup of cost.
For projects   set up with a Time & Expense billing type, and for fee-based projects   
where you have selected to bill labor, expense, or consultant as time   and expense 
and entered a contract amount, then if billing exceeds the   contract amount, Ajera 
alerts you by highlighting the invoice amount in   red. It also prints Maximum 
Exceeded on the draft invoice.   You can adjust the invoice amount, if needed.

Fixed Fee You charge the client a fixed amount for the project and bill a fixed   amount on each 
invoice.

Percent 
Complete

You charge the client a fixed amount for the project. You bill a percentage   of the total 
amount based on the amount of the project that is complete.

Unit Price You charge the client a price per each unit completed, such as square feet.
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Billing type Description
Percent of 
Construction 
Cost

You charge the client for the actual or estimated cost of construction   for the project. 

Nonbillable You do not charge the client for the project. You can enter and track   time and 
expenses, but the client cannot be invoiced. 

Marketing You track the marketing cost for the project. You can change this billing   type to one 
of the billable types after the project is won. You can enter   and track time and 
expenses, but the client cannot be invoiced.

Overhead You can optionally set up an overhead project to track your internal   expenses. You 
can enter and track time and expenses, but no client is   associated with the project 
and no invoice is produced. 

Note: You cannot   change an Overhead billing type to a billable type.

Adjustment
 

Appears only when working with an adjustment phase.
You increase or decrease an invoice amount by adding an invoice adjustment. When 
you add an adjustment, Ajera automatically assigns it a billing type of Adjustment, 
which cannot be changed.

About estimating and managing projects with Ajera
unavailable in ajeraCore
With Ajera, growing firms can quickly produce accurate   estimates and complete projects on time and within 
budget.
You can quickly estimate projects for proposals and later refine the   estimates to working budgets and 
schedules after the contract is won. In   addition, you have instant access to project-specific reports. 
Using Business Development,  you can also track and analyze your marketing efforts.
Here are some typical tasks that you may perform    to guide your project from a proposal to a completed job:
Set up the project
Begin the budget
Win the job
Manage the project
Review the client invoice
Close the project

Set up the project
Depending on what your company sets up as a standard practice, you add   projects by:

 l Selecting   a template
 l Copying   an existing project
 l Setting   up a new project
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Begin the budget 
You can begin by indicating that you are working on a proposal and that   your firm has not yet won the contract 
for the job. 
With the project open in the Project Command Center, on the Project   Info tab > General subtab,   select 
Preliminary in the Status   field. 

Note: A status   of Preliminary allows you to enter your marketing time to the project.   If you want to 
ensure that no time is entered to the project until the   contract is won, change the status to 
Hold.

You are now ready to begin working on an estimate in one of these ways:
 l Budgeting top-down
 l Budgeting bottom-up

Win the job
You win the contract.
Change the status of your project to Active. With the project open in   the Project Command Center, on the 
Project   Info tab > General subtab,   select Active in the Status field.   
If, based on your estimate, you choose not to enter a bid for the project,   or if your firm is not awarded the work, 
you can change the status to   Closed.

Manage the project
You are now ready to produce a working budget and schedule for your   project:

 l Refine and expand on the   budgeting information you already entered to produce the estimate. Change   
information as your project changes.

 l If you know the employees   or employee types working on the project, assign them to the appropriate   
phase or task. 

 l Produce   a schedule for project. 
 l Update   the RPC % Complete for each phase.
 l Ensure that the status of   each phase remains correct. For example, assign a status of Work Hold   to a 

phase if it is no longer available for time entry.
When you are finished budgeting the project, and if you no longer want   to allow any changes to it, click the 
Final   Budget button on the Manage   tab of the Project Command Center. You can still add or change 
schedules   or resources assignments when the budget is final. 

Review the client invoice
When a client invoice is ready for review before billing, you can use billing review stages to help move the 
invoice smoothly through the review process,  if the invoice is based on a standard invoice format or on a 
custom design created with the Client Invoice Designer.
A billing review stage consists of notes and a descriptive name that indicates where an invoice is in the 
review. Your billing review stages should mirror the ones used at your firm.
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During billing review, you preview the invoice from the Client Invoices window or from the Project Command 
Center. Enter your notes and select the next billing review stage when finished. Ajera can notify the next 
reviewer that the invoice is ready, and the review process continues as needed.
When you print the invoice as final, the billing review stage automatically updates to Final.

Close the project
After you have finally billed a project, be sure to enter actual complete   dates and other project notes according 
to your company's policy. In this   way, you can better evaluate this project for future estimating and marketing   
purposes. 

Views

About customizing your Project Command Center

Your project list
At the top of the Project Command Center is a list of your projects.   This list acts as a quick summary of your 
projects. You select   the projects and type of information that you want to see for those projects.   

Your project detail
unavailable in ajeraCore
After you select a project in the project list, detail for that project   appears on the lower area of your Project 
Command Center. You can select   the project detail you want to view or change.

Project Command Center reports 
You can show or hide these up-to-date reports, which appear on tabs   in the Project Command Center: 

 l Snapshot report
 l Progress report (unavailable in ajeraCore)
 l Plan report (unavailable in ajeraCore)

Click    (Customize), click the Reports tab,   and select the check box for each report you want to show. 
Clear the check   box for each report you want to hide. Click OK.

Selecting projects to view
When you open the Project Command Center (  > Manage > Project Command Center), a list of projects 
appears   at the top of the window. You can select which projects you want to appear   in that list.

To select projects to view
 1. From the Project Command   Center, click     (Customize) at the upper right of the window.
 2. On the Project   List tab, indicate the projects you want to see by selecting one   of the options directly 

under the Projects to Show heading:
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Select 
this 
check 
box

To see

All 
projects

Either all projects in your company or only projects for which you are   a project 
manager, depending on your security access.

Projects 
matching 
filter

Projects matching certain criteria that you select.
After you select this check box, a Filter area appears. Do the following:

 1. You can select to see projects   based on project status. As needed, select a 
check box corresponding to   the project status of projects you want to show.

 2. You can select to see   projects associated only with a specific project 
manager, billing manager, principal-in-charge,   marketing contact, or client. 
Make a selection, as needed, for each field.

Multi-company only. You can select to see projects associated only with a specific 
company. 

Selected 
projects

Individual projects that you specifically select. 
After you select this check box, a Projects table appears. Do the following:

 1. To select a project, click   a blank row of the Projects table and click   .
 2. Repeat this procedure for   each project you want to show in the list.

My 
projects 
only

Only projects for which you are the project manager, billing manager, principal-in-
charge,   or marketing contact.
After you select this check box, additional check boxes appear. Select   a check box, 
as needed, for projects you want to show as defined by your   role on the project. For 
example, a principal may want to view the projects   where they are the project 
manager separately from projects where they   are the principal-in-charge.

Note: This check   box is only available if the   View my projects only check 
box   is not selected in your security settings. 

 3. You can also define the   type of information you want to see for each project. The table at the   right of 
the window contains a list of columns grouped by category. Use   this list to select the columns you 
want to show in the Project List along   with the name of your project.

 l To   see all the columns within a category, select the Show   check box for the category.
 l To   select individual columns   of project information, expand the category by clicking the    

symbol, and click the Show check   box for each column you want to show.
 4. Click   OK.             

Selecting project detail to view
When you click a project in the project list at the top of your Project   Command Center, detailed information for 
that project appears on the lower   half of the window. You can determine the type of detail that you view   for 
your projects.

To select project detail to view
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 1. From the Project Command   Center, click     (Customize) at the upper right of the window.
 2. To change which information   appears on the Project Info tab   of the Project Command Center, click 

the   Phase Info tab on this window, and do the following:

Field Description
Phase 
Statuses

Select a check box to show only phases which match the status listed   for the 
check box. You can select as many check boxes as you want.

My phases 
only

Select this check box to show only phases for which you are the project   manager, 
principal-in-charge, or marketing contact.

My 
departments 
only

Select this check box to show only departments for which you are the project   
manager, principal-in-charge, or marketing contact.

table (at right 
of window)

Use this table to indicate which columns you   want to show to the right of the 
project tree, as follows:

 l To   show all the columns listed for a category, select the Show   check box 
for the category. To hide all columns for a category, clear   the Show check 
box.

 l To   show individual columns, expand the category by clicking the    
symbol, and click the Show check   box for each column you want to 
show. To hide a column, clear the Show check box.

 3.  unavailable in ajeraCore   - To change which information appears on the Manage   tab of the Project 
Command window, click the Manage   tab on this window, and do the following:

Field Description
Phase 
Statuses

Select a check box to show only phases which match the status listed   for the 
check box. You can select as many check boxes as you want.

My phases 
only

Select this check box to show only phases for which you are the project   manager, 
principal-in-charge, or marketing contact.

My 
departments 
only

Select this check box to show only departments for which you are the project   
manager, principal-in-charge, or marketing contact.

table (at right 
of window)

Use this table to indicate which columns you   want to show to the right of the 
project tree, as follows:

 l To   show all the columns listed for a category, select the Show   check box 
for the category. To hide all columns for a category, clear   the Show check 
box.

 l To   show individual columns, expand the category by clicking the    
symbol, and click the Show check   box for each column you want to 
show. To hide a column, clear the Show check box.

 4.  unavailable in ajeraCore   - Project Command Center reports appear as tabs. To show or   hide those 
tabs, click the Reports   tab on this window, and do the following:

 l Select the check box for each report that you want to   appear in the Project Command Center.             
 l Clear the check box for each report that you want to   hide.             
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 5. Click OK.             

Viewing the Gantt chart
unavailable in ajeraCore
Your Project Command Center can contain a Gantt chart (timeline) in   your project list and in your project detail 
on the Manage   tab. You can select to show or hide either of the Gantt charts.
Buttons for the project list Gantt chart appear at the upper right of   the window.
Buttons for the project detail Gantt Chart appear at the bottom of the   window on the Manage tab.
When you open the Project Command Center, the Gantt chart shows today's   date, which is highlighted with 
an orange bar. 

The timeline in the Gantt chart represents actual dates; if there are   no actual dates, it represents estimated 
dates.

To Do this
Show the chart Click the Show Gantt button.

Hide the chart Click the Hide Gantt button.

Zoom in See a shorter time span (such as individual days and weeks), by 

clicking    (Zoom In).

Zoom out
See a longer time span (such as months), by clicking    (Zoom 
Out).

See today's date at far left Right-click the date area of the chart, and select Today.

See beginning or end of a 
row at far left

Right-click the timeline in a row, and select Begin   or End. 

Note: The Begin   option is available if the row has an 
estimated or actual start date.   The End option is 
available if the row has an estimated or actual end   
date.

Manage tab only:

Change dates using timeline Click and drag the beginning or ending of a timeline in a row. 
The timeline shows actual dates; if there are no actual dates, it 
shows   estimated dates.

Update the chart If you change dates in the columns, click Save   to update the chart.
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Templates

Changing a project template

To change a project template

 1. From the  >  Setup   menu, click General > Project Templates.   
 2. In the project template   list at the top of the window, click the project template you want to change.
 3. On the Project   Info tab and the subtabs under it, make changes to the project   work breakdown 

structure and project   information.
 4. Review this information   for phases and make changes.
 5. Click the Manage   tab, and make changes to the budget   information.
 6. Click Save.

Copying a project template

To copy a project template

 1. From the  >  Setup   menu, click General > Project Templates.   
 2. Click the New   button at the upper right of the window. 

 3. Click Copy   existing template, and click  to select   the template that you want to copy.
 4. Click the Create   button. The existing template appears in the detail area of the Project   Command 

Center.
 5. On the General   subtab under the Project Info   tab, type the name of your new template in the 

Description field.
 6. On the Project   Info tab and the subtabs under it, make changes to the project   work breakdown 

structure and project   information, as needed.
 7. Review this information   for phases and make changes, as needed.
 8. Click the Manage   tab, and make changes to the budget   information, as needed.
 9. Click Save.

Deleting a project template

To delete a project template

 1. From the  >  Setup   menu, click General > Project Templates. 
 2. In the project template   list at the top of the window, click the project template you want   to delete.
 3. Click the Delete   button at the upper right of the window.
 4. Click Yes   to delete the project template.
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Budgets

About budgeting a project
unavailable in ajeraCore
In Ajera, you can budget with as much or as little detail,   depending on your needs and the complexity of your 
projects. It is most   common to begin a budget in one of these general ways:

Budgeting bottom-up
You may use this method when you want to determine the total contract   amount for a project based on the 
number of hours each phase or task should   require. Ajera calculates the project totals for you.
Bottom-up budgeting is useful when you want to develop a budget to:

 l Control the project hours   and costs
 l Produce a project proposal

You typically create bottom-up budgets for hourly based projects. Bottom-up   budgeting lets you specify the 
number of hours for each labor or expense.   When you enter hours, Ajera calculates the contract amount based 
on the   project's rate table or from average billing rates entered for the employee   type or in  > Setup > 
Company > Preferences. Ajera calculates the cost from the employee’s   pay rate or from average cost rates 
entered for the employee type or in  > Setup > Company > Preferences. 

Budgeting top-down
You may use this method when you know the total contract amount or total   number of hours needed to 
complete a project. For some projects, the fee   is based on what the market can bear. In this case, you need to 
develop   a budget for each phase and task required to complete the project. This   top-down method also works 
well for developing feasibility budgets. 
When building a top-down budget, you enter the total contract amount,   total hours, or total cost for the project. 
You then specify the percentage   of the total project for each phase or subphase.

About budgeting labor, expense, and consultants
unavailable in ajeraCore
When budgeting with Ajera, you work with labor, expense, and consultant   amounts on the Manage tab of the   
Project Command Center in the following ways:

Activity type totals

To enter and track totals for labor, expense, and consultants, click   the icon   in the Contract column to show 
these rows: Labor Total, Expense Total,   and Consultant Total. These totals are called activity type totals and   
are available for the project and for phases. 
The amount you enter for a project or phase automatically updates the   Labor Total. You can redistribute that 
total, as needed, by clicking the    icon and changing the amounts. If the contract amount of a phase is made   
up of more than one activity type total, you cannot directly change the   amount; instead, you click the  icon 
for the phase and make changes to its   activity type totals. 

Resources
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To enter and track a specific labor, expense, or consultant cost, add   a budget item for it, which is called a 
resource. Click the    icon in the Description column for the project or phase, and click Add Labor, Add   
Expense, or Add Consultant.   
For example, you may add a Labor resource to identify and track the   cost of a specific employee’s work on a 
phase.
If you enter a resource and a   contract amount for a Consultant or an Expense resource, Ajera can   track it as a 
commitment   to prevent overbilling from the vendor, if you have selected to track   budgets in  > Setup > 
Company > Preferences.

Tasks
Because you use tasks to track the progress and scope of a project,   you budget hours for a task but not   cost 
amounts or rates. When using tasks, you continue to track project   costs through resources and phases. 
However, you can choose to roll up   task hours to resources or phases, which then updates cost amounts. To   
add a task, click the  icon to the right of the project, phase, or resource   where you want to add the task.

How activity type totals and resources work
The amounts in the Labor Total, Expense Total, and Consultant Total   rows (activity type totals) interact with 
the rows you add for a Labor,   Expense, or Consultant resource as follows:

Top-down budgets
Ajera assumes you are entering a top-down   budget if you enter amounts for the project and upper phase levels 
before   entering amounts for the lowest-level phases or resources. You may choose   to do a top-down budget 
by entering a total, entering a percentage of   that total for each phase and each resource, and then clicking the 
% icon   to distribute the total to them. 

Note: If you plan to distribute your totals down to resources, be sure the resources   are not mixed in at 
the same level as any subphases. 

If you enter percentages for resources, Ajera   updates the activity type totals based on the amounts distributed 
to each   resource type.
If you do not enter percentages for resources,   you can still enter amounts for resources. However, these 
amounts do not   automatically update amounts for the phase and project. If the resource   totals do not sum to 
the upper levels of your budget, the    icon appears. You can click the  icon if you want to change the 
upper levels   to match the resources. To lock the upper levels   so that they are not accidentally updated from 

the resources, click the   unlocked lock to lock it .  

Bottom-up budgets
Ajera assumes you are entering a bottom-up   budget if you start entering amounts at the lowest levels of your 
budget   before you enter amounts for the project and upper-level phases. 
When preparing your budget from the bottom  -up, you enter lower-level phase, resource hours and/or dollars, 
or labor   task hours. These amounts update the project and any upper-level phases   and also update activity 
type totals based on the type of resource entered.   

About entering hours and rates for resources

Labor resources
When you enter hours for a labor resource, Ajera enters billing and   cost rates for you as follows:
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You enter Billing rate comes from Cost rate comes from
Only hours and no 
other columns

The average billing rate in  > Setup > 
Company > Preferences > Project tab
Multi-company only. The average 
billing rate in Setup > Company > 
Companies > Billing/Payroll tab

The average cost rate in  > 
Setup > Company > 
Preferences > Project tab
Multi-company only. The 
average cost rate in  > Setup 
> Company > Companies > 
Billing/Payroll tab

An employee in the 
Resource column

The billing rate table

Otherwise, it comes from  > Setup > 
Company > Preferences > Project tab

The employee’s cost rate

An employee type in 
the Type column

The billing rate table if it is set up with 
employee types
Otherwise, it comes from the average 
rate from the employee type setup,   or 

 > Setup > Company > Preferences 
> Project tab.

The average cost rate for the 
employee type

If blank, it comes from  > 
Setup >   Company > 
Preferences > Project tab.

An employee in the 
Resource column and 
an employee type in 
the Type   column

The billing rate table if it is set up with 
rates for the employee or   employee 
type or there are labor markup

The employee’s cost rate

Expense resources
When you enter hours or units for an expense resource, and you enter   an activity in the Type column, Ajera 
enters billing and cost rates for   you as follows:

You enter Billing rate comes from Cost rate comes 
from

A unit-based 
activity

The billing rate table if you set up a rate exception by 
activity
Otherwise, it comes from the activity setup.

The rate for the 
activity

Any other activity The billing rate table You enter it.

Consultant resources
When you enter a consultant resource, and you enter a vendor type in   the Type column or a vendor in the 
Resource column, the cost and billing   rate columns are unavailable. If you enter a vendor and a cost amount,   
the contract amount comes from the billing rate table.

About budgeting percent complete and percent of cost
You budget projects that you bill as Percent   Complete and Percent of Construction Cost by using the top-
down   budgeting method. 
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You enter contract amounts and then distribute   those amounts down to the lowest level of your budget. You   
distribute your budget amounts, as done in the following example, by using   the  icon located in the % Dist 
column.

Example
You have a project billed as Percent of   Construction Cost. 

Total cost of construction 750,000,000

Contract budget for project 10%

Total cost of construction 750,000

Of your project total:
 l 700,000 is labor.
 l 50,000 is for consultants.

You now want to enter these amounts and distribute them down to the   lowest level of your budget.
 1. On the row for the project,   enter a construction cost amount for 7,500,000. 
 2. In the % of CC (percent   of construction cost) column, enter 10%. Ajera then enters a contract   amount 

of 750,000.
 3. To allocate part of this   contract amount for labor and part for consultant, in the Contract column,   click 

the down arrow  to show rows for the activity type (Labor, Expense,   and Consultant).
 4. On the row for Labor Total,   enter 700,000. On the row for Consultant Total, enter 50,000.
 5. For each phase directly   under the project, in the % Dist column, enter a percentage of the total   project 

amount that applies to this phase. 

Note: The total of the percentages you enter for the phases must equal 100%.   Similarly, if you 
enter percentages for the lower levels of each phase,   they must equal 100%.

 6. You are now ready to distribute   the contract amount down to the phases. Click the icon in the % 
Dist column on the project row.   

 7. Ajera enters amounts for   each item in the Contract column.

Budgeting top-down
When you create a budget top-down, you follow this general process:

 1. Enter project budget totals.
 2. Distribute the project budget   down to phases, subphases, and resources based on a percentage of 

the   hours, cost, or contract amount.
When you enter hours, Ajera calculates the contract amount based on   the project's rate table or from average 
billing rates entered for the   employee type or  > Setup > Company > Preferences (if no rates are entered for 
the   employee type). Ajera calculates the cost from the employee’s pay rate   or from average cost rates entered 
for the employee type or  > Setup > Company > Preferences   (if no rates are entered for the employee type). 
If you use multi-company, the average and cost rates may be in  > Setup > Company > Companies.
If your company sets   up templates or uses Ajera's industry-standard templates, your budget   may already 
contain much of the structure and detail that you need. 
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Quick start with the Top-down template
The quickest way to get started budgeting top-down is to use the standard Ajera template, Top-down. 
Because the contract amount for phases   is based on the total contract amount for the project, this template is   
set up with standard percentages for the phases. 
You simply do the following:

 1. Set   up the project, if you have not already done so, using a Top-down   template.
 2. Enter the contract amount   for the project in the Contract column on the project row.

 3. Click the    icon in the % Dist column on the project row. 
Ajera automatically distributes the contract   amount to lower levels based on their percentages in the 
% Dist column.   If average cost and billing rates are entered in  > Setup > Company > Preferences,   
Ajera calculates average hours for labor contract amounts.

 4. To make any adjustments   or further work with your budget, review the instructions that follow.

Building your budget
As you work with your budget, you may perform some or all of these tasks   once or repeatedly, perhaps at 
different times. Here is a typical order   for the way you may go about building a budget for the first time:

To Do this
Open the 
project

 1. If you are not already working   with the project, open it by clicking it in the project 
list at the top   of window.

 2. Click the Manage   tab.
 3. If you do not see the type   of information you want to work with, select   the detail 

you want to view. 

Adjust work 
breakdown 
structure

 4. If needed, define the work   breakdown structure of your project or make 
adjustments to it by working   with the project tree.

 5. Add   resources and add tasks   to the project tree, where needed. 

Note: If you plan to distribute your totals down to resources, be sure the 
resources   are not mixed in at the same level as any subphases.  

You can choose to roll up task hours to resources   or phases, which then updates 
cost amounts. See Change   totals in this topic.

Enter totals  6. Enter totals on the project   row for any or all of the following: 

Note: If average cost   and billing rates are entered in  > Setup > Company 
> Preferences, Ajera calculates   hours, cost, and contract amounts 
based on your input for phase budgets. If you have multi-company, 
the average cost and billing rates may be in  > Setup > Company > 
Companies.

 l Hours/units (if a labor resource has an employee or employee type assigned 
to it, the budgeted hours and dollars appear in Schedule Manager. You can 
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To Do this
use Schedule Manager to manage employee schedules by week as the 
project proceeds)

 l Cost amount
 l Contract   amount (required for fee-based projects)

 7. If   needed, enter a breakdown of the total for activity types (labor, expense,   
consultant):

 l Click    in the Contract column to show rows for Labor Total, Expense   
Total, and Consultant Total.

 l Click    in the Contract column to hide the rows.

Lock 
contract 
totals?

 8. You   can instruct Ajera to lock your contract amount totals so that they cannot   be 
changed regardless of any changes you make to the budget for lower-  level 
phases and resources.

 l To allow changes to a contract   total, click the locked lock to unlock it .

 l To prevent changes to a   contract total, click the unlocked lock to lock it
.

Note: When you lock a phase amount, you cannot change any amounts in 
the % Dist   column.

Assign 
percentages 
to lower 
levels

 9. On the row for the phase   that you want to budget, in the % Dist column, enter a 
percentage of the   total project amount that applies to this phase. 
For example, if the design phase is 25% of   the project, enter 25 in the % Dist 
column for the design phase. Ajera   calculates the contract amounts of the phase 
for you. If average cost   and billing rates are entered in  > Setup > Company > 
Preferences, Ajera also calculates   hours and cost.

Note: The total of the percentages you enter for the phases must equal 
100%.   Similarly, when you later enter percentages for the lower 
levels of each   phase, they must equal 100%.

 10. Show   or hide the amounts for activity types (Labor, Expense, Consultant), as   
needed:

 l Click    in the Contract column to show the activity type breakdown.

 l Click    in the Contract column to hide it.
 11. Repeat this process for   each subphase and then each resource that you want to 

budget for the phase. 
About entering hours and rates for resources

Distribute 
contract 
amounts

 12. Click the % icon in the   % Dist column on the project row. 
Ajera automatically distributes the contract   amount to lower levels based on their 
percentages in the % Dist column.
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To Do this
Change 
totals?

 13. Ajera   does not automatically change hours/units, cost, or contract amount totals   
when you change lower-level amounts. In this way, you can control if and   when 
certain totals change. Instead, when a total no longer equals the   sum of its lower 
level amounts, Ajera displays a plus icon next to the name of the budget item 
for   that total. 
Depending on the goal for your budget, do   one of the following:
 l Adjust the lower-level items until they equal the total.   When a total equals the 

sum of its lower levels, the plus icon    disappears.
 l Change your total so that it equals the sum of the lower   levels by clicking the 

plus icon.

Recalculate 
cost or 
contract 
amounts?

 14. If you change cost or contract   amounts that are based on a cost rate or billing 
rate, or if you later   return to working on your budget and employee costs or billing 
rates have   changed, the  icon appears. Click it if you want to recalculate all 
cost and   contract amounts for the entire project based on standard rates as set   up 
in Ajera.

Make a 
budget 
final?

 15. If   your budget is final and you no longer want to allow any changes to it,   select the 
Final budget check   box. 
When a budget is final, you can no longer   change amounts in the budget (unless 
your project   security settings are set to allow changes to the Manage   tab); 
however, you can change schedule and resource assignments. If you   locked any 
contract amounts, they remain locked and cannot be unlocked   until you undo the 
finalizing of the budget.
You can only undo the finalizing of a budget   if you have security access to clear 
the Budget   is final check box on the Project   Info > Permissions subtab.

Save your 
work

 16. Click Save.

Budgeting bottom-up
When you budget bottom-up, you follow this general process:

 1. Enter amounts starting at   the lowest level of your work breakdown structure: resources, subphases,   
phases, and finally project.

 2. Review project totals.
When you enter hours, Ajera calculates the contract amount based on   the project's rate table or from average 
billing rates entered for the   employee type or  > Setup > Company > Preferences (if no rates are entered for 
the   employee type). Ajera calculates the cost from the employee’s pay rate   or from average cost rates entered 
for the employee type or  > Setup > Company >Preferences   (if no rates are entered for the employee type).
If your company sets   up templates or uses Ajera’s industry-standard templates, your budget   may already 
contain much of the structure and detail that you need.

Quick start with the Bottom-Up template
The quickest way to get started budgeting bottom-up is to use the standard   Ajera template, Bottom-up. 
Because the contract amount for the   project is based on the sum of the contract amounts for each resource   
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and each phase, this template is already set up with several standard   phases and several labor resources for 
each phase.

Building your budget
As you work with your budget, you may perform some or all of these tasks   once or repeatedly, perhaps at 
different times. Here is a typical order   for the way you may go about building a budget for the first time:

To Do this
Open the 
project

 1. If you are not already working   with the project, open it by clicking it in the project 
list at the top   of window.

 2. Click the Manage   tab.
 3. If you do not see the type   of information you want to work with, select   the detail 

you want to view. 

Adjust work 
breakdown 
structure

 4. If needed, define the work   breakdown structure of your project or make 
adjustments to it by working   with the project tree.

 5. Add   resources and add tasks   to the project tree, where needed.

Note: When using tasks, you continue to track project costs through 
resources   and phases. However, you can choose to roll up task hours 
to resources   or phases, which then does update cost amounts. See 
Change   totals in this topic.

Enter detail  6. For the first phase you   want to budget, begin at the lowest level in the project tree 
for that   phase and enter any or all of the following information: 

 l Hours/units (if a labor resource has an employee or employee type assigned 
to it, the budgeted hours and dollars appear in Schedule Manager. You can 
use Schedule Manager to manage employee schedules by week as the 
project proceeds)

 l Contract   amount (required for fee-based projects)

Note: When you enter   detail for a phase, Ajera uses the average cost and 
billing rates entered   in  > Setup > Company > Preferences to 
calculate hours, cost, and contract amounts   based on your input for 
phase budgets. 
When you enter a resource, Ajera   uses the cost rates from either the 
employee type or the employee, and   the billing rates from either the 
employee type, activity, or billing   rate table.
More about entering hours and rates for resources

 7. Do   the same thing until you have entered amounts for each level of the phase   and 
then for all the phases of your project.

Show or 
hide activity 
types?

 8. Show   or hide the amounts for activity types, as needed:

 l Click    in the Contract column to show the activity type breakdown.

 l Click    in the Contract column to hide it.

Change  9. Ajera   does not automatically change hours/units, cost, or contract amount totals   
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To Do this
totals? when you change lower-level amounts. In this way, you can control if and   when 

certain totals change. Instead, when a total no longer equals the   sum of its lower 
level amounts, Ajera displays a plus icon next to the name of the budget item 
for   that total. 
Depending on the goal for your budget, do   one of the following:
 l Change your total so that it equals the sum of the lower   levels by clicking the 

plus icon.
 l Adjust the lower-level items until they equal the total.   When a total equals the 

sum of its lower levels, the plus   icon  disappears.

Recalculate 
cost or 
contract 
amounts?

 10. If you change cost or contract   amounts that are based on a cost rate or billing rate, 
or if you later   return to working on your budget and employee costs or billing rates 
have   changed, the  icon appears. Click it if you want to recalculate all cost and   
contract amounts for the entire project based on standard rates as set   up in Ajera.

Make a 
budget 
final?

 11. If   your budget is final and you no longer want to allow any changes to it,   select the 
Final budget check   box. 
When a budget is final, you can no longer   change amounts in the budget (unless 
your project   security settings are set to allow changes to the Manage   tab); 
however, you can change schedule and resource assignments. If you   locked any 
contract amounts, they remain locked and cannot be unlocked   until you undo the 
finalizing of the budget.
You can undo the finalizing of a budget only   if you have security access to clear 
the Budget   is final check box on the Project   Info > Permissions subtab.   

Save your 
work

 12. Click Save.

Budgeting with ajeraCore

To budget with ajeraCore
 1. If you are not already working   with the project, open it by clicking it in the project list at the top   of 

window.
 2. Click the Manage   tab.
 3. If needed, define the work   breakdown structure of your project or make adjustments to it by working   

with the project tree. 
 4. If you want to view or work   with amounts by activity type, do the following:

 l Click  in the Contract column to show the activity type breakdown.

 l Click  in the Contract column to hide it.
 5. Complete these fields, as   needed, for the project and its phase
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For Do this
Construction 
cost

If budgeting or billing by the percent of construction cost, enter the   construction 
cost here.

% of CC If budgeting or billing by the percent of construction cost, enter the   percent of 
construction cost that represents your fee.

Unit 
description

If budgeting or billing the project or phase by unit price, enter a   description of the 
units.

Hours/units Enter the hours or units as follows:
 l For labor, enter or review   the hours required to complete the selected 

phase.
 l If budgeting or billing   by unit price, enter or review the units required to 

complete the phase   (such as the square feet). 

Unit price If budgeting or billing   for the project or phase by unit price, enter the price of each 
unit.

Cost Enter the cost amount.

Note: You cannot   change the cost unless one of your job roles has the 
View employee cost check box selected.

Contract Does not apply to Nonbillable, Marketing, or Overhead billing types - Enter the 
contract amount.

Start date Enter the date when work begins.

Completion 
date

Enter the date when work is complete.

Notes Enter any notes about the item.

 6. Click Save.

Changing budget totals
As you work with your project budget, you can choose to do the following:

To Do this
Lock 
contract 
totals?

You can instruct Ajera   to lock your contract amount totals so that they cannot be changed 
regardless   of any changes you make to the budget for lower level phases and resources.

 l To   prevent changes to a contract total, click the unlocked lock to   lock it .

 l To   allow changes to a contract total, click the locked lock to   unlock it .

Note: When you lock a phase amount, you cannot change any amounts in the 
% Dist   column.

Change Ajera does not automatically change hours/units,   cost, or contract amount totals when 
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To Do this
totals? you change lower-level amounts. In   this way, you can control if and when certain totals 

change. Instead,   when a total no longer equals the sum of its lower-level amounts, Ajera   
displays a plus icon next to the name of the budget item for that total.   
Depending on the goal for your budget, do   one of the following:

 l Adjust the lower-level items   until they equal the total. When a total equals the sum 
of its lower levels,   the plus icon disappears.

 l Change your total so that   it equals the sum of the lower levels by clicking the plus 
icon.

Recalculate 
cost or 
contract 
amounts?

unavailable in ajeraCore unless you have the Consultant Management add-on
If you change cost or contract amounts that are based on a cost rate   or billing rate, or if 
you later return to working on your budget and   employee costs or billing rates have 
changed, the  icon appears. Click it if you want to recalculate   all cost and contract 
amounts for the entire project based on standard   rates as set up in Ajera.

Changes to projects

About changing billing types
To calculate spent and billed amounts on existing entries, you can change the billing type for a project or   
phase from Nonbillable or Marketing to a billable type. 
For WIP entries, change   the status from Nonbillable to Billable on client invoices associated   with that 
project or that phase.

Changing a project

To change a project

 1. From the  >  Manage   menu, click Project Command Center. 
 2. In the project list at the   top of the window, click the project you want to change.

You can use the search to find any project you selected to show in the project list. Find a project 
typing any part of the name in the Search field. You can also search by project ID or client if you first 
select the ID or Client option.

 3. Change   the status of the project or phase,   as needed.
 4. Change the billing type, as needed.
 5. Work   with the project tree to add, change, reorganize, copy, or delete   phases, invoice groups, or 

billing groups.
 6. Click a tab and change the   project   information.

If you change the rate table for the project   and want the existing WIP entries to use the new rates, you 
must recalculate   the billing rates on the client invoices.

 7. Click Save.
 8. Click  Close.
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Changing project status

To change a project status

 1. From the  >  Manage   menu, click Project Command Center. 
 2. In the project list at the   top of the window, click the project you want to change.
 3. On the General   subtab of the Project Info tab,   in the Status field, make a selection:

Status Description
Marketing unavailable in ajeraCore

You want to track BD efforts and win rates, and   project your pipeline. Time and 
expenses can be entered to the project.   The client cannot be invoiced. 

Preliminary The project is not ready for billing. Time and expenses can be entered   to the project 
but the client cannot be invoiced.

Active The project is active. Time and expenses can be entered to the project.   The client 
can be invoiced. 
unavailable in ajeraCore - Ajera enters an invoice status   of Active and a billing 
review stage of Pre-review until you change them.

Hold Time and expenses cannot be entered to the project. The client cannot   be invoiced.

Work hold Time and expenses cannot be entered to the project. The client can be   invoiced.

Billing hold Time and expenses can be entered to the project. The client cannot be   invoiced. 

Closed The project is complete, but you still want to include it in reports.

Note: When you   select a status of Closed for a project, all phases for the 
project are   closed and any draft invoices are removed from the 
Manage Client Invoices   list.
CRM only: When you select a status of Closed for a project, the 
project will sync to CRM one final time regardless of the Sync to 
CRM option setting. The Sync to CRM option will then be 
deselected after the final sync if it is selected. The Sync to CRM 
option can be reselected in the PCC if further changes on the 
closed project are needed. It will only be included when Sync to 
Closed Projects is selected during a manual sync. 

Note:  l If you want to apply a prepayment for projects with a status other than 
Preliminary or Active, you must open the client receipts by client and not by 
project. 

 l If you want to enter a client receipt for projects with a status other than 
Preliminary, Active, or Billing Hold, you must open the client receipts by 
client and not by project.

 4. Click Save.
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Changing phase status

To change a phase status

 1. From the  >  Manage   menu, click Project Command Center. 
 2. In the project list at the   top of the window, click the project of the phase you want to change  . 
 3. In the project tree on the   lower left of the window, click the phase.

 4. On the General   subtab of the Project Info tab,   in Status field, click  and select a status for the 
phase. You can   change it at any time during the project lifecycle.  

Status Description
Marketing unavailable in ajeraCore

You want to track BD efforts and win rates, and project your   pipeline. Time and 
expenses can be entered to the phase. The client cannot   be invoiced. When the 
status of the phase is Marketing, Ajera automatically   sets the billing type to 
Marketing.

Preliminary The phase is not ready for billing. Time and expenses can be entered   to the project 
but the client cannot be invoiced.

Active The phase is active. Time and expenses can be entered to the project.   The client 
can be invoiced. Ajera enters a status   of Active until you change it. 

Hold Time and expenses cannot be entered to the phase. The client cannot be invoiced.

Work hold Time and expenses cannot be entered to the phase. The client can be   invoiced.

Billing hold Time and expenses can be entered to the phase. The client cannot be   invoiced.

Closed The phase is complete, but you still want to include it in reports.

 5. Click Save.

Deleting a project
You cannot delete a project once it has been used. However,   you can change the project status   to reflect the 
current situation. 

To delete a project

 1. From the  >  Manage   menu, click Project Command Center. 
 1. In the project list at the   top of the window, click the project you want to delete.
 2. Click the Delete   button.
 3. Click Yes   to delete the project.

Adding a phase

To add a phase while working with a project budget
 1. If you are not already working   with the project, open it by clicking it in the project list at the top   of the 

Project Command Center.
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 2. Click the Manage   tab.
 3. In the project tree at the   left of the Manage tab, click   the project or a phase under which you want to 

add a subphase.
 4. Click the New   Phase button. A blank phase appears lower in the project tree.   
 5. Type a name for the new   phase in the Description field on the General   subtab. 
 6. Move the phase, as needed,   using the Up or Down   arrow at the bottom of the window.

Deleting a phase
You cannot delete a phase once it has been used (nor can you delete   a subphase which you create under a 
phase if that phase had been used).   However, you can change the phase   status to reflect the current 
situation. For example, you can change   the status of the phase to Closed if you are no longer using the phase.

To delete a phase

 1. From the  >  Manage   menu, click Project Command Center. 
 2. In the project list at the   top of the window, click the project of the phase you want to delete.   
 3. In the project tree on the   lower left of the window, click the phase you want to delete.
 4. Click the Delete   button.
 5. Click Yes   to delete the phase.

Adding a resource
unavailable in ajeraCore

Note:
 

 You can   add resources to overhead projects to identify vacations and other nonbillable   time.
 You can add a labor resource in Schedule Manager. The resource appears in both Schedule 

Manager and on the Manage tab of the Project Command Center.

To add a resource
 1. If you are not already working   with the project, open it by clicking it in the project list at the top   of the 

Project Command Center.
 2. Click the Manage   tab.

 3. Click the    icon in the Description column where you want to add a resource, and then   select Add 
labor, Add expense, or Add   consultant. 
A new row for the labor, expense, or consultant   resource appears.

 4. In   the Type column for the resource you added, click the cell and then click   to select the type of 
resource.

For a You select
Labor resource An employee type

Expense 
resource

An activity

Consultant 
resource

A vendor type that is identified as a consultant (the Consultant   check box is 
selected for the Vendor   Type)
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 5. In the Resource column,   click the cell and then click        to select the resource. 

For a You select
Labor resource An employee

Expense 
resource

A vendor

Consultant 
resource

A vendor who is identified as a consultant (the Consultant check box   is 
selected for the Vendor Type)

 6. In the Reference/Commitment   # column, type a short description that helps you further identify a 
consultant   or expense resource. You use it to distinguish budget items when managing   vendor 
invoices.
Always enter an ID in this field. 

 7. To   get the most benefit from your reports, be sure to enter estimated start   and completion dates.
 8. Complete   the other fields, as needed.
 9. Click Save.

Deleting a resource
You can also delete a labor resource from Schedule Manager if it has no budget, percent distribution, task, 
notes, or start and end dates assigned to it.

To delete a resource
 1. If you are not already working   with the project, open it by clicking it in the project list at the top   of the 

Project Command Center.
 2. Click the Manage   tab.
 3. Click the resource that   you want to delete, and click the Delete   button.
 4. Click Yes   to delete the resource. If it is a labor resource, it is deleted both from the Manage tab of the 

Project Command Center and from Schedule Manager.

Scheduling a project
unavailable in ajeraCore
Begin your project schedule on the Manage tab of the Project Command Center. Enter estimated start and 
completion dates and, as the project proceeds, update the schedule with actual dates. To manage your 
employee schedules on a weekly basis, use Schedule Manager.

To schedule a project
 1. If you are not already working   with the project, click it in the project list at the top of window.
 2. Click the Manage   tab.
 3. Review your work breakdown   structure in the project tree and make   any changes, if needed. 

Add resources   or add tasks, as needed.
About tasks:
Because you use tasks to track the progress and scope of   a project, you enter hours for a task but 
not   cost amounts or rates. When using tasks, you continue to track project   costs through resources 
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and phases. However, you can choose to roll up   task hours to resources or phases, which then does 
update cost amounts.

 4. If you want to change the   type of information that currently appears on the Manage   tab, use     
(Customize) to select the project   detail you want to view.

 5. As you schedule a project, you can work with dates as follows:
Gantt chart:
In addition to entering and changing dates directly in cells on the table, you can change dates using 
the Gantt chart (timeline) on the right of the window. You can also   change dates by clicking and 
dragging them in the Gantt chart. The Gantt   chart always displays actual start and completion dates if 
available.   Otherwise, it uses the estimated dates.
To show or hide the Gantt chart, click the   Hide Gantt or Show   Gantt button on the bottom of the 
window.
Changing dates as you work:
As you change actual start dates and estimated start dates, Ajera automatically   updates any higher-
level dates or lower-level dates so that dates on phases   are never earlier than the date of the phase or 
project which contains   them.
Similarly, as you change estimated completion dates, Ajera automatically   updates any higher-level or 
lower-level dates so that dates on phases   are never later than the date of the phase or project that 
contains them.   However, Ajera does not automatically update completion dates when you   change a 
lower-level date.
You can change an estimated or actual start date in one of the following ways:

To Do this
Keep the same duration when 
changing a start date

 1. Right-click the date, and click Adjust start date.
 2. In the window that appears, enter the new start date, 

and click OK.
Ajera automatically adjusts the end date. It also adjusts the 
dates for a phase's subphases, resources, and tasks 
accordingly.

Change a start date without 
automatically adjusting the end 
date

Type the new start date directly into the cell on the table.

 6. You can build a schedule   in Ajera in a variety of ways, depending on what works best for you and   your 
firm. Here are some general guidelines for a typical way you may   work with a schedule at various 
stages of the project:

To Do this
Start a 
schedule

 1. In the row for the project,   enter the date when you plan to start and complete 
work in the Est Start   Date and Est Completion Date columns for the project.  
If you have already started work on the project,   enter that date in the Start 
Date column on the row for the project.

 2. Repeat these instructions   for phases and subphases, as needed.

Maintain 
a 

At regular intervals, you have probably planned to estimate the amount   of work that 
you have completed on the project and on its phases. For   the project, and for each 
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To Do this
schedule phase:

 1. Enter the percent of work   that is complete in the % Complete column. 
 2. Enter the date that you   are reporting the percent complete in the % Complete 

Date column.
Ajera displays the most recent percent and date that were last entered. If you 
entered a percent or date in error, be sure to highlight the information and 
click the Delete button in both the % Complete and % Complete Date fields, 
click Save, and then enter the percent and date you want.

 3. Change estimated and actual   start and completion dates, as needed.

Complete 
a 
schedule

Enter the completion date for the project.

 7. When   you are finished working with the schedule, click Save.

Including multiple clients on a project
You can add a client to a project by adding an invoice group1, where you identify the additional client.

To include multiple clients on a project

 1. From the  >  Manage   menu, click Project Command Center. 
 2. In the project list at the   top of the window, click the project that you want to add a client to.   
 3. Add   an invoice group for the additional client you want to include on   the project. 

While adding the invoice group, on the Invoice subtab under the Project   Info tab, enter the name of 
the additional client in the Client   field, and select a different invoice format if needed.

 4. Add   phases for the invoice group. 
While adding  a phase, click the Billing   subtab under the Project Info   tab and select a different billing 
type, if needed.

 5. Click Save.

Client invoice adjustments

About client invoice adjustments
An invoice adjustment is a charge or deduction that modifies the total client invoice amount. Adjustments 
appear as a separate line on the invoice. Examples of typical adjustments are administrative fees or 
discounts.
You can set up an invoice adjustment to be:

 l A percentage of the billed amount for an activity type,  or a flat fee
 l One time only on the current draft invoice, or on the draft invoice and all future invoices

1A grouping of phases for a project so as to create multiple invoices for the project. You use invoice groups to 
invoice additional services separately or to invoice multiple clients for a project.
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 l Identified as Labor, Expense, or Consultant
 l Associated with a general ledger account, where Ajera makes accounting entries for the adjustment

Where to add an adjustment
You can add an adjustment to an invoice in the following ways:

 l When working with client invoices (  > Manage > Client Invoices)

 l When working with the project (  > Manage > Project Command Center)

How Ajera calculates the adjustment
You can instruct Ajera to add the invoice adjustment as:

 l A fixed amount, which appears on the current draft invoice. If you add it in  > Manage > Project 
Command Center, it recurs on future draft invoices until you close it. If you add it in Manage > Client 
Invoices, it appears only on the current draft invoice.

 l A percentage of the billed amount (for an activity type), which appears on the draft invoice and recurs 
on future draft invoices. You can also enter a maximum amount for the adjustment if you add it in  > 
Manage > Project Command Center.

When you enter an invoice adjustment, you identify it as one of the following activity types:
 l Labor
 l Expense
 l Consultant

Where the adjustment appears in Ajera
Either way you add the adjustment, Ajera displays it as:

 l A phase in the Project Command Center (  > Manage > Project Command Center). Although the 
adjustment appears as a phase, it is a special type of phase. It contains only the information needed 
for an adjustment. After you create it, you cannot change it to a typical production phase.

 l A row on the invoice in  > Manage > Client Invoices

Where the adjustment appears on the invoice
Either way you enter the adjustment, it appears on the invoice in these areas:

 l Invoice Summary section
 l Invoice Total section at the end of the invoice

Adding a client invoice adjustment
You can add an invoice adjustment in either of the following ways:

 l  > Manage > Client Invoices

 l  > Manage > Project Command Center

If you want a nonrecurring adjustment
When you add an adjustment on a current draft invoice, it recurs on future draft invoices.
To add a nonrecurring adjustment, do one of the following:
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 l Enter a flat amount adjustment through  > Manage > Client Invoices.

 l Enter a maximum amount for a percent-based adjustment on the Manage tab of  > Manage > 
Project Command Center.

 l After producing the final invoice, change the status of the adjustment to Closed (  > Manage > 
Project Command Center>Project Info tab > General subtab).

When to add an adjustment in the Project Command Center

You must add the adjustment through  > Manage > Project Command Centerif you want to do the following:
 l Enter a tax code and tax rate for sales tax.
 l Enter a different flat amount for each draft invoice.

 Adding an adjustment in Manage > Client Invoices

 1. From the  >  Manage   menu, click Client Invoices. 
 2. Click the invoice you want,   and then click Edit. 

Add the adjustment
 3. Click the Add Adjustment button at the bottom left of the window. If you already added an 

adjustment to this invoice, first click the Invoice Adjustments tab and then click the Add 
Adjustment button.

 4. In the Description field, type the name of the adjustment.
 5. In the Activity Type field,  categorize the adjustment as a labor, expense, or consultant activity.
 6. Select the type of adjustment you want to add as follows:

To add this 
type of 
adjustment

Do this

A flat 
amount

 1. In the Adjustment Type field, select Amount.
 2. In the Amount field, enter the amount of the adjustment.

To decrease the invoice amount with this adjustment, enter a negative 
number.

Note: A flat amount you enter here does not appear on future draft 
invoices or in the Project Command Center. The amount field is 
blank in the Project Command Center.

A percent of 
the billed 
amount for 
an activity 
type

 1. In the Adjustment Type field, select Percent. 
 2. In the Amount field, enter the percent of the billed amount for the activity 

type (Labor, Expense, or Consultant) that you want Ajera to use to 
calculate the adjustment amount. Enter the percent without decimals, 
such as 25 for 25%.
For the current draft invoice and all subsequent invoices, Ajera calculates 
that percent and enters the resulting amount as the adjustment amount. 
The adjustment amount appears for the invoice in the Invoice Adjustments 
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To add this 
type of 
adjustment

Do this

tab.
Ajera calculates the amount based on the billed amount for the activity 
type total, not the  total billed amount. For example, if you entered a 10% 
adjustment for labor, Ajera calculates the adjustment as 10% of the billed 
amount for the labor associated with the invoice,  not 10% of all labor, 
expense, and consultant amounts.
If you want to set a maximum amount for the adjustment,instructions 
appear later in this topic.

 7. In the Revenue Account field, select the general account where you want Ajera to make entries for the 
adjustment.

If you leave this field blank, Ajera uses the account you selected in  > Setup > Company > 
Preferences > Income Statement Accounts tab > Miscellaneous field.

 8. To exclude the adjustment amount from the billed amount on project reports and inquiries, select the 
Exclude from billed for reporting check box. For example, you may not want a discount applied to 
amounts in your projects reporting, so you select this check box.

 9. Click OK.

Select how the adjustment appears on the invoice
 10. Click the Invoice Adjustments tab. It displays adjustments you added to the invoice, including the 

contract amount, activity type, and adjustment amount. 
 11. To also list the adjustment type, contract amount, prior billed amount, total billed amount, sales tax 

amount, contract remaining amount, or Notes, click  (Customize), make a selection, and click OK. 
You can enter amounts in the Total Billed Amount and Sales Tax Amount fields, as needed.

 12. If you want something other than Invoice adjustment to print on the invoice, enter it in the Notes 
column.
If you add more than one adjustment to the invoice, Ajera prints the total of all the adjustments along 
with the text you enter in the Notes column for each adjustment.

 13. Click Save.
 14. If you selected to add the adjustment as a percent and want to limit it to a maximum amount, do the 

following: 

 l Open the project associated with the invoice adjustment (click  >  Manage > Project 
Command Center, and click the project in the project list at the top of the window).

 l Click the Manage tab.
 l Locate the adjustment phase. Adjustment phases appear in orange, usually at the bottom of the 

project tree.
 l On the row for the adjustment phase, in the Contract field, enter the maximum amount  for this 

adjustment. 
 l If you entered a negative amount for the adjustment, be sure to include a negative sign when you 

enter the amount here.
 l Click Save.
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 15. If you selected to add the adjustment as a percent, you can instruct Ajera to exclude a specific phase 
when calculating the percent. If you have more than one adjustment, Ajera excludes the phase from 
all adjustments of the activity type you select (Labor, Expense, and Consultant).
To exclude the phase from calculations for the percent:

 l Open the project associated with the invoice adjustment (click  >  Manage > Project 
Command Center, and click the project in the project list at the top of the window).

 l Click the phase in the project tree.
 l Click the Project Info tab > Billing subtab. 
 l In the Exclude from Adjustments area of the window, select the Labor, Expense, and 

Consultant check boxes, as applicable. 

Adding an adjustment in the Project Command Center 

 1. Open the project (click  >  Manage > Project Command Center, and click the project in the project 
list at the top of the window).

 2. If you are using invoice groups, in the project tree on the left of the window, click the invoice group 
where you want to add the adjustment. 
If you are not using invoice groups, the placement of the adjustment has no effect; the adjustment 
applies to the entire project.

Add the adjustment
 3. Click the New Adjustment button at the bottom of the window.
 4. In the Description field (on the Project Info tab > General subtab), type the name of the adjustment. 

This name appears when you work with the adjustment on windows in Ajera. The words Invoice 
adjustment appear on the invoice unless you enter something else as described later in these 
instructions.

 5. Notice that when you add an invoice adjustment, Ajera displays it as a new phase, in orange in the 
project tree. 

 6. Select the status of the adjustment.

Select this 
status

To do this

Preliminary Do not include the adjustment on current or future draft invoices. 
For example, you want to set up the invoice adjustment but do not yet want to 
start adding it to invoices. 
When you make the project active, Ajera also makes the adjustment active.

Active Include the adjustment on current and future draft invoices.

Closed Do not include the adjustment on the current draft invoice or future draft invoices.
You do not want to delete the adjustment because you still want it to appear on 
project reports.

Ajera automatically enters a status of Active unless the project is currently not being billed because it 
has a status other than Active.  If the project status is other than Active or Closed, Ajera automatically 
assigns the adjustment a status of Preliminary. You can change the status of the adjustment, as 
needed.
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 7. Click the Billing subtab.
Ajera automatically assigns a billing type of Adjustment to the phase, which it uses to identify this 
phase as an adjustment and distinguish it from a production phase.

 8. In the Activity Type field, categorize the adjustment as a Labor, Expense, or Consultant activity.
 9. Select the type of adjustment, and enter an amount or percent, as follows:

To add this 
type of 
adjustment

Do this

A flat 
amount

 1. In the Adjustment Type field, select Amount.
 2. In the Amount field, enter the amount of the adjustment. 

If you want to decrease the invoice amount with this adjustment, enter a 
negative number.
If you expect the adjustment amount to change on future invoices and 
want to enter a different adjustment amount for each draft invoice, leave 
the amount field blank. You can then enter the amount to the draft invoice 
on the  > Manage > Client Invoices > Invoice Adjustments tab. 

A percent of 
the billed 
amount for 
an activity 
type

 1. In the Adjustment Type field, select Percent.
 2. In the Amount field, enter the percent of the billed amount for the activity 

type (labor, expense, or consultant) that you want Ajera to use to calculate 
the adjustment amount. Enter the percent without decimals: 25 for 25%.
For the current draft invoice and all subsequent invoices, Ajera calculates 
that percent and enters the resulting amount as the adjustment amount. 
The adjustment amount appears for the invoice in  > Manage > Client 
Invoices > Invoice Adjustments tab.
Ajera calculates the amount based on the billed amount for the activity 
type total, not the  total billed amount. For example, if you entered a 10% 
adjustment for labor, Ajera calculates the adjustment as 10% of the billed 
amount for the labor associated with the invoice,  not 10% of all labor, 
expense, and consultant amounts.

 3. To set a maximum amount for the adjustment, click the Manage tab. On 
the row for the adjustment phase, in the Contract column, enter the 
amount.
If you entered a negative amount for the adjustment, be sure to include a 
negative sign when you enter the amount here.

 4. Click the Project Info tab > Billing subtab.

 10. In the Account field, select the general ledger account where you want Ajera to make entries for the 
adjustment.

If you leave this field blank, Ajera uses the account you selected in  > Setup > Company > 
Preferences > Income Statement Accounts tab > Miscellaneous field.

 11. To exclude the adjustment amount from the billed amount on project reports and inquiries, select the 
Exclude from billed for reporting check box. For example, you may not want a discount to affect 
amounts in your project reporting, so you select this check box.

Select how the adjustment appears on the invoice
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 12. To apply sales tax, select the Apply sales tax check box, and enter the tax code and tax rate. The 
amount of sales tax that Ajera applies to the invoice appears on the  > Manage > Client Invoices > 
Invoice Adjustments tab, where you can then override it by entering a different amount, if needed. 

 13. Complete or change information in fields on the other subtabs, as needed. Any notes you enter about 
the adjustment automatically appear on the client invoice. 

 14. Click Save.
 15. If you selected to add an adjustment as a percent, you can instruct Ajera to exclude a specific phase 

when calculating the percent. If you have more than one adjustment, Ajera excludes the phase from 
all adjustments of the activity type you select (Labor, Expense, and Consultant).
To exclude the phase from calculations for the percent:
 l Click the phase in the project tree. 
 l Click the Project Info tab > Billing subtab. 
 l In the Exclude from Adjustments area of the window, select the Labor, Expense, and 

Consultant check boxes, as applicable. 
 16. If you want to identify the invoice adjustment on the invoice with text other than Invoice 

adjustments, follow the instructions for Changing an invoice adjustment in Manage > Client Invoices. 
Ajera uses the information on the Notes subtab, not the Description field, to identify the adjustment on 
the client invoice.

Changing a client invoice adjustment
You can change an invoice adjustment as follows:

From here You can change this

 > Manage > Client 
Invoices
See these instructions: 
Changing an adjustment in  
> Manage > Client Invoices

 l The adjustment amount for a flat adjustment
 l The amount Ajera calculated for a percent-based 

adjustment
 l The sales tax amount
 l The text that identifies the adjustment and prints on the 

client invoice

Also use  > Manage > Client Invoices to:
 l Enter a flat adjustment amount if you added the 

adjustment in the Project Command Center and set it up 
for applying a different amount on each invoice.

 l View the contract amount, prior billed amount, and 
contract remaining amount.

Project Command Center (
 > Manage > Project 

Command Center)
See these instructions:
Changing an adjustment in the 
Project Command Center  

 l The adjustment amount for a flat adjustment
 l The percent of the adjustment for a percent-based 

adjustment
 l The maximum amount for a flat or percent-based 

adjustment
 l The sales tax code and rate
 l The text that identifies the adjustment and prints on all 

subsequent client invoices in the invoice group
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From here You can change this
 l The name of the adjustment
 l The status of the adjustment
 l The type of adjustment (flat amount or percent)
 l The general ledger account associated with the 

adjustment
 l If the adjustment amount is included in billed amounts in 

project reports and inquiries
 l If you want Ajera to exclude a specific phase when 

calculating the billed amount for a percent adjustment

Changing an adjustment in  > Manage > Client Invoices

 1. From the  >  Manage   menu, click Client Invoices. 
 2. Click the invoice you want,   and then click Edit. 
 3. Click the Invoice Adjustments tab. 

Note: If this tab does not appear, then no adjustments were added to the invoice you opened.

On this tab, Ajera displays adjustments from previous draft invoices (flat amount adjustments and 
percent-based adjustments that exceeded the maximum) as zero adjustments for the current draft 
invoice. You cannot change these adjustments.

 4. To show or hide the adjustment type, contract amount, prior billed amount, total billed amount, sales 
tax amount, contract remaining amount, or notes, click  (Customize) and make a selection. You 
can change amounts in the Total Billed Amount and Sales Tax Amount fields.

 5. Change the adjustment amount, as needed.
If you change a percent-based amount:
If the adjustment is based on a percent and you change the amount, Ajera displays a message to let 
you know that it can no longer automatically calculate the amount as the billed amount changes for 
the project.  Ajera displays (m) in the heading of the Adjustment Amount column to indicate that you 
must now manually change the amounts for all percent-based adjustments listed on this tab. 

Similarly, Ajera  no longer updates the percent for the adjustment in the Project Command Center (  
> Manage > Project Command Center).
If you decide that you do want Ajera to automatically calculate the percent, right-click the row of the 
adjustment, and click Auto Adjustments. However, when you select Auto Adjustments, Ajera 
recalculates the amount for all the invoice adjustments based on a percent, not only the row you 
select. 
Ajera recalculates any sales tax, which you can change.

 6. Change the sales tax amount, as needed.
If you entered the adjustment from the Project Command Center along with a tax rate, and you 
change the amount here, Ajera cannot calculate the amount on future invoices. However, if you 
decide you want Ajera to calculate the sales tax amount again, right-click the row of the adjustment 
and click Recalculate Sales Tax.
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 7. To change the text that prints on the invoice to identify the adjustment, change the text in the Notes 
column. If this column is empty for all the adjustments, Ajera prints  Invoice adjustment on the 
invoice. Otherwise, it prints the text you enter in this field for each adjustment.

Changing an adjustment in the Project Command Center 

 1. Open the project (click  >  Manage > Project Command Center, and click the project in the project 
list at the top of the window).

 2. Click the adjustment phase that you want to change. Adjustment phases appear  in orange in the 
project tree.

 3. In the Description field (on the Project Info tab > General subtab), change the name of the adjustment, 
as needed.

 4. Change the status of the adjustment, as needed:

Select this 
status

To do this

Preliminary Do not include the adjustment on current or future draft invoices. 
For example, you already set up the invoice adjustment but do not yet want to 
start adding it to invoices. 
When you make the project active, Ajera also makes the adjustment active.

Active Include the adjustment on current and future draft invoices.

Closed Do not include the adjustment on the current draft invoice or future draft invoices.
You do not want to delete the adjustment because you still want it to appear on 
project reports.

 5. Change other information on the General subtab, as needed.
 6. Click the Billing subtab.
 7. Notice that you cannot change the billing type or the activity type.
 8. Change the type of the adjustment, and change the amount or percent, as follows:

For this 
type of 
adjustment

Do this

A flat 
amount

 1. In the Adjustment Type field, select Amount.
 2. In the Amount field, enter the amount of the adjustment. Enter the percent 

without decimals, such as 25 for 25%.
To decrease the invoice amount with this adjustment, enter a negative 
number.
To enter a different adjustment amount for each draft invoice, leave the 
amount field blank. You can then enter the amount to the draft invoice on 
the  > Manage > Client Invoices > Invoice Adjustments tab. 

A percent of 
the billed 

 1. In the Adjustment Type field, select Percent.
 2. In the Amount field, enter the percent. 
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For this 
type of 
adjustment

Do this

amount for 
an activity 
type

For the current draft invoice and all subsequent invoices, Ajera calculates 
that percent and enters the resulting amount as the adjustment amount. 
The adjustment amount appears for the invoice on the  > Manage > 
Client Invoices > Invoice Adjustments tab.
Ajera calculates the amount based on the billed amount for the activity 
type total, not the  total billed amount. For example, if you entered a 10% 
adjustment for labor, Ajera calculates the adjustment as 10% of the billed 
amount for the labor associated with the invoice,  not 10% of all labor, 
expense, and consultant amounts.

 3. To change the maximum amount of an adjustment, click the Manage tab. 
On the row for the adjustment phase, in the Contract field, change the 
amount.
If you entered a negative amount for the adjustment, be sure to include a 
negative sign when you enter the amount here.

 4. Click the Project Info tab > Billing subtab.

 9. In the Account field, change the general ledger account where Ajera makes entries for the adjustment.

If you leave this field blank, Ajera uses the account you selected in  > Setup > Company > 
Preferences > Income Statement Accounts tab > Miscellaneous field.

 10. To exclude or include the adjustment amount from the billed amount on project reports and inquiries, 
select or clear the Exclude from billed for reporting check box, as needed. For example, you may 
not want a discount to affect amounts in your project reporting, so you select this check box. 

 11. Change if you are applying sales tax, and the tax code and tax rate, as needed. The amount of sales 
tax that Ajera applies to the invoice appears on the  > Manage > Client Invoices > Invoice 
Adjustments tab, where you can then override it by entering a different amount, if needed. 

 12. Change information in the fields on the other subtabs, as needed. If you want to change the text that 
identifies the adjustment and prints on all subsequent invoices in this invoice group, change the text 
on the Notes subtab. If the subtab is blank, Ajera automatically uses the words Invoice adjustments 
to identify the adjustment on the invoice.

 13. Click Save.
 14. If you are calculating adjustments based on a percent, you can instruct Ajera to exclude a phase when 

calculating the percent. If you have more than one adjustment, Ajera excludes the phase from all 
adjustments of the activity type you select (Labor, Expense, and Consultant).
To exclude or include the phase from calculations for the percent:

 l Click the phase in the project tree. 
 l Click the Project Info tab > Billing subtab. 
 l In the Exclude from Adjustments area of the window, select or clear the Labor, Expense, and 

Consultant check boxes, as applicable. A check box appears only if you set up at least one 
adjustment with that activity type.

 l Click Save.
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Deleting a client invoice adjustment
You cannot delete an invoice adjustment after it appears on a final client invoice. If you no longer want to use 
the invoice adjustment, close the adjustment by changing the status to Closed through  > Manage > 
Project Command Center.
This topic contains instructions for deleting an adjustment and closing an adjustment.

Deleting an adjustment
You can delete an adjustment in the following ways if it has not yet appeared on a final client invoice:

Deleting an invoice adjustment from Manage > Client Invoices

 1. From the  >  Manage   menu, click Client Invoices. 
 2. Click the invoice you want to delete,   and click Edit. 
 3. Click the Invoice Adjustments tab.
 4. Right-click the invoice adjustment you want to delete, and click Delete Adjustment.
 5. Click Yes to delete the adjustment.
 6. Click Save.

Deleting an invoice adjustment from  >  Manage  > Project Command Center

 1. Open the project (click  >  Manage  > Project Command Center, and click the project in the 
project list at the top of the window).

 2. Click the adjustment phase you want to delete. Adjustment phases appear in orange in the project 
tree.

 3. Click the Delete button at the bottom of the window.
 4. Click   Yes to delete the adjustment phase.
 5. Click Save.

Closing an adjustment
To remove an adjustment from only the current draft invoice and want it to recur on future invoices, after you 
print the final client invoice, change the status of the adjustment back to Active.

 1. Open the project (click  >  Manage  > Project Command Center, and click the project in the 
project list at the top of the window).

 2. Click the adjustment phase that you want to close. Adjustment phases appear in orange in the 
project tree.

 3. Click the Project Info tab > General subtab.
 4. In the Status field, select Closed.
 5. Click Save.
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Consultant management

About commitment management
unavailable in ajeraCore unless you have the Consultant Management add-on
An important aspect of any project is the ability to monitor and control   consultant and expense contracts. In 
Ajera, these contracts are called   commitments.
Commitment management is a feature in Ajera for tracking amounts budgeted and paid to a consultant for a 
project. You can review the status of consultant budget items as you enter the associated vendor and client 
invoices.
Your budget consultant and expense costs and fees are tracked directly   to the project and phases. Tracking 
consultant and expense contracts from   the beginning of the project gives you an accurate picture of your 
commitments   at each phase. You can even track multiple consultant and expense contracts   for one project 
and phase. 
Ajera automatically verifies invoices to the consultant and expense   cost budget and generates warning 
notices to ensure that you are not overbilled   and that projects stay within budget. 
During contract negotiation, you can verify that a consultant’s insurance   policies provide adequate coverage 
for the life of the project.
To use commitment management, you perform these tasks:

 l Turn   on consultant budgets and/or Turn   on expense budgets.
 l Set   up a consultant or an expense budget.
 l Track   consultant insurance, if needed.
 l Verify   invoice distributions to cost budgets.
 l Produce the Commitment Management   report and the Resource inquiry to view the status of your 

consultant and expense budgets. You   can compare your consultant and expense budgets with what’s 
been invoiced   and paid.

Turning on consultant budgets
unavailable in ajeraCore unless you have the Consultant Management add-on

To turn on consultant budgets

 1. From the  >  Setup menu, click Company > Preferences.
 2. Click the Project   tab.
 3. In the Consultant Budgets   field, select one of the following:

Select To
Warn if over 
invoiced

Track consultant budgets. Ajera displays a warning message if you enter   
costs for the consultant that exceed the remaining amount of the budget   item.

Don't allow 
over invoicing

Track consultant budgets. Ajera does not allow you to enter costs for   the 
consultant that exceed the remaining amount of the budget item.

Warn if over 
invoiced - 
commitment # 

Track only consultant budgets that have a commitment # on the Manage tab 
of the Project Command Center.   Ajera displays a warning message if you 
enter costs for the consultant   that exceed the remaining amount of the budget 
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Select To
required item.

Don't allow 
over invoicing  - 
commitment # 
required

Track only consultant budgets that have a commitment # on the Manage tab 
of the Project Command Center.   Ajera does not allow you to enter costs for 
the consultant that exceed   the remaining amount of the budget item.

 4. Click Save.
 5. Click Close.

Viewing the Committed columns on the Manage tab
The Committed Cost Invoiced and Committed Contract Invoiced columns in the Project Command Center are 
for budget reporting purposes only and do not update the consultant or expense cost amounts on the Project   
Info tab > Beginning Balances   subtab. To enter the consultant or expense total cost and total billed 
amounts to-date for this phase, which are used for reporting and client invoicing, see Entering   beginning 
balances for projects.

If you cannot see the Committed Cost Invoiced and Committed Contract Invoiced columns on the Manage 
tab in the Project Command Center, follow the steps below to select the commitment options:

Step 1: Review the budget fields in company preferences

 1. From the  >  Setupmenu, click  Company > Preferences.
 2. On Project tab, ensure that the Consultant Budgets and Expense Budgets fields are not both set to 

Don't track. 
 3. If both are, change at least one of the fields to something other than Don't track. This enables you to 

add the Committed columns to the Manage tab.

Step 2: Add the columns to the Manage tab

 1. From the  >  Managemenu, click  Project Command Center.
 2. On the Manage tab, click  (Customize).
 3. In the Customize window, click the Manage tab.
 4. Expand the Billing & Invoicing description, and select the Commitment beginning balances 

check box.
 5. Click OK.

Adding a labor budget with the Consultant Management add-on
unavailable in ajeraCore unless you have the Consultant Management add-on
For any phase with an expense or consultant resource, add a labor budget to include labor amounts in your 
totals for the phase.

To add a labor budget with the Consultant Management add-on
 1. From the project list in   the Project Command Center, select the project for which you want to add 

labor amounts.
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 2. For the phase where you   want to add a labor budget, click the Manage   tab, click the  icon in the 
Description column, and select Add labor budget.               A row for the labor appears under the phase.

 3. In the row for labor, complete the following fields:

For Do this
Type Enter the type of labor. 

Resource Enter the labor resource.

Reference/Commitment 
#

Enter an ID that you want   to assign to this labor budget item.
Always enter an ID in this field. When later working with vendor 
invoices, you can enter the reference number to quickly review the 
project data and commitment amount.

Cost Enter the amount that you pay the consultant or vendor for this work.   

Contract Enter this amount or change it, if needed. It is the amount that you   
expect to bill the client. Ajera calculates it for you by multiplying   the 
cost amount by any markups from the applicable rate table. Required   
for commitments. 

Note: You can   reset all amounts for the entire project back to 
the amounts Ajera calculated   for you by clicking the  
icon.

Committed cost 
invoiced

If you have not yet selected the Project beginning balances 
complete check box on the Project tab of company preferences, 
enter the cost amount already invoiced from the vendor against this 
budget item.
If this column is not visible on the Manage tab, see Adding the 
Committed columns to the Manage tab.

Committed contract 
invoiced

If you have not yet selected the Project beginning balances 
complete check box on the Project tab of company preferences, enter 
the contract amount you have already invoiced to the client for this 
budget item.
If this column is not visible on the Manage tab, see Adding the 
Committed columns to the Manage tab.

Notes Enter any notes for this budget item. 

 4. Click Save.
 5. Click Close.

Tracking consultant insurance

To track consultant insurance

 1. From the  >  Setup   menu, click Vendors. 
 2. Double-click the consultant   for whom you are adding insurance information. 
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 3. The Insurance tab appears if the   vendor has a vendor type of Consultant (  > Setup > Vendors > 
General tab > Vendor Type field). 
Click the Insurance   tab. Enter the following information:

For Do this
Type Select the type of insurance. The Other 1 and Other 2 options are available   for you to 

track other insurance requirements.

Proof 
required

Select this check box to indicate that you require a proof of insurance   from this 
consultant.

Company 
name

Type the name of the insurance company issuing the policy.

Policy 
number

Type the number of the insurance policy.

Policy 
limit

Type the amount the insurance policy covers.

Effective Enter the date the policy becomes effective.

Expires Enter the date the policy expires.  

 4. To review the consultant   insurance information, from the  > Reports menu, click Standard 
Inquiries   > Vendor > Vendor Insurance. Use this inquiry to review and monitor the insurance 
coverage of your consultants. The inquiry contains a standard column called Expiration Date. You can 
add a predefined column called Insurance Expired if needed.

 5. In the Vendor window, click Save.
 6. Click Close.

Verifying invoice distributions to cost budgets
unavailable in ajeraCore unless you have the Consultant Management add-on
When entering the vendor invoice,   follow these instructions:

 1. On the Manage Vendor Invoice   window, the Commitment # field appears when you select a vendor 
only if   you set up a consultant   budget or an expense budget.

 2. Select the commitment   and phase.

Note: If you entered the budget at a level higher than the detail level   in your work breakdown 
structure, Ajera does not automatically enter   the phase here. Select the detail phase by 
clicking    in the Phase field.

 3. Enter the activity. 
If the expense commitment has an activity   type specified on the Manage tab   of the Project 
Command Center, Ajera automatically enters it into   this field. You can change it, as needed.

Note: Only activities set up with an activity   type of Consultant or Expense appear in the list. 

 4. Ajera automatically   enters the remaining budget amount in the Cost Amount field. 
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Note: If you entered the budget at a level higher than the detail level in your work breakdown 
structure, Ajera does not automatically enter the cost here. You must manually enter the 
cost to apply to the commitment.

 5. Click Save.
 6. Click Close.

Deleting a consultant budget
If you entered a vendor invoice against the consultant budget, you cannot   delete the consultant budget.

To delete a consultant budget

 1. From the  >  Manage   menu, click Project Command Center.
 2. In the project list at the   top of the window, click the project for the consultant budget you want   to 

delete.
 3. Click the Manage   tab.
 4. Click the Consultant row   of the budget item you want to delete, and click the Delete   button.
 5. Click Yes   to delete the resource.
 6. Click Save.
 7. Click Close.

Deleting an expense budget
If you entered a vendor invoice against the expense budget, you cannot   delete the expense budget.

To delete an expense budget

 1. From the  >  Manage   menu, click Project Command Center.
 2. In the project list at the   top of the window, click the project for the expense budget you want to   delete.
 3. Click the Manage   tab.
 4. Click the Expense row of   the budget item you want to delete, and click the Delete   button.
 5. Click Yes   to delete the resource.
 6. Click Save.
 7. Click Close.

Business Development

About Business Development
unavailable in ajeraCore
Use Business Development (BD) to help you plan and manage potential   new business. With BD:

 l It’s all in one centralized   location - the Project Command Center - where you can give your staff the   
level of access that’s right for them. 

 l You enter all the information   you need for a potential project one time, and should you win the work,   
that information is ready for you to begin working on and billing the   project.
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 l You can easily track the   progress of a potential project every step of the way - from the lead   to the 
final disposition.

 l Your BD efforts become part of Ajera’s dynamic data engine, where reports   and inquiries give you 
instant access to the analytics you need.

Setting up BD
Setting up a BD project is   the first step in a process that tracks your marketing efforts and sets   the stage for a 
billable project. 
You determine if and when   a project, or even phases of a project, are billable. In this way, you   can easily 
include your BD efforts and billable work for a project in   one place, while reporting on and billing its 
components separately. 
You control reporting and   billing for a project by assigning the project and its phases the correct   status, 
depending on the state of the project at the time.
To set up BD, do the following:

 l Set   up security for BD to limit information to those   who need it. For example, you may not want 
employees of a particular job role  to see actual cost and rate information.

 l Set   up marketing stages to identify your unique business development process.   You set up marketing 
stages to reflect the typical steps of the BD process   at your firm. For example, you can set up stages 
to track BD efforts such   as RFQ, RFP, Proposal, and so on.

 l Set   up marketing final dispositions to track the reasons you won, lost,   or declined the work. For 
example, you can set up final dispositions such   as Qualifications/Experience, Design Concept, 
Project Approach/Schedule,   and so on.

Managing BD efforts
When you work with BD, you do the following:

 l Set up   a BD project or template or add   a BD phase to an existing project or template. 
 l Update   a BD project to track the status of your BD efforts, including the   type and timing of your next 

actions.
 l Use   reports and inquires to help you review your BD efforts and plan for   the future.

Common marketing stages
The common industry-standard marketing stages, automatically set up   in Ajera, are:

Marketing 
stage

Long 
description

Definition

NBD New 
Business 
Development

A firm's general pursuit of clients so as to be considered in the 
selection   process for future projects

Lead Project Lead A firm's pursuit of a client regarding work on a specific project

RFQ Request for 
Qualifications

Often a first step in a formal selection process where a client 
requests   information about a firm's general qualifications to perform 
work on a   potential project
It typically does not list the scope of work or request a fee proposal,   
fees, or proposed project team information. Firms often respond to 
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Marketing 
stage

Long 
description

Definition

RFQs   with standard brochure-type materials. 
This stage most often has a firm due date associated with it.

RFP Request for 
Proposal

Request for firms to supply relevant experience and detailed 
information   (such as a fee proposal, schedule, scope of work, project 
approach, team   member resumes and consultants) for the delivery of 
the project
A project owner sends an RFP to a shortlist of qualified firms. The   
RFP can be the first step in the selection process, or it can follow the   
RFQ. 
This stage most often has a firm due date associated with it.

Proposal Proposal 
Submitted - 
Awaiting 
Action

Time period when the proposal due date has passed and the firm is 
waiting   to hear a decision about the next step, such as an interview 
for the selection   process

Interview Shortlisted 
for Client 
Interview

The presentation that may be the final stage of a formal selection 
process.   A project owner selects a short list of firms from   the 
proposals received to present their pitch for the project.   
This stage most often has a firm due date associated with it.

Final 
Disposition

Won, Lost, or 
Declined

The outcome of a firm's marketing efforts for a potential project

Common marketing final dispositions
Marketing final dispositions reflect the typical reasons your firm wins,   loses, or declines a project. 
Ajera automatically sets up these common marketing final dispositions. You can change or delete them, or 
add your own, as needed.

 l Fee
 l Qualifications/Experience
 l Project   Team
 l Project   Approach/Schedule
 l Design   Concept
 l Existing   Client Relationship
 l Other - See Notes

Changing stages and dispositions

Changing a marketing stage

Note: You cannot   change the Final Disposition marketing stage.

To change a marketing stage
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 1. From the  >  Setup   menu, click General > Marketing Stages.   
 2. Click the marketing stage  you want to change, and click Edit.
 3. In the Description field,   change the name of the marketing stage, if needed.
 4. In the Long Description   field, enter, change, or delete the long name for the marketing stage.   The long 

name appears when working with marketing stages (on the Project Info >   Business Development > 
Stages   tab of the Project Command Center).

 5. Click Save.   
 6. Click   and  to move the new marketing stage to the appropriate place in the list. 

The order of  marketing stages in this list   is important because it represents the sequential order of BD 
efforts   at your firm. This order appears on the Stages subtab in the Project Command   Center.        

Changing a marketing final disposition

To change a marketing final disposition

 1. From the  >  Setup   menu, click General > Marketing Final Dispositions.   
 2. Click the marketing final   disposition you want to change, and click Edit.
 3. In the Description field,   change the name of the marketing final disposition to reflect   the reason why 

you won, lost, or declined a project.
 4. In the Notes field, change   any notes about the marketing final disposition.
 5. Click Save.
 6. Click Close.

Copying a marketing stage

To copy a marketing stage

 1. From the  >  Setup   menu, click General > Marketing Stages.   
 2. Click the marketing stage   you want to copy, and click Copy. 
 3. Change the name in the Description   field.
 4. Add or change the long description   if needed.
 5. Click Save. The marketing stage appears below the current row. To move it, click the row and  click  

or . 
 6. Click Close.

Copying a marketing final disposition

To copy a marketing final disposition

 1. From the  >  Setup   menu, click General > Marketing Final Dispositions.   
 2. Click the marketing final   disposition you want to copy, and click Copy. 
 3. Change the name in the Description   field.
 4. Add or change notes if   needed.
 5. Click Save. The marketing final disposition appears below the current row. To move it, click the row 

and  click  or . 
 6. Click Close.
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Deleting a marketing stage
You cannot delete a marketing stage if it is currently being used. However,   you can make it inactive.   You 
cannot delete or inactivate the Final Disposition marketing stage.

To delete a marketing stage

 1. From the  >  Setup   menu, click General > Marketing Stages.   
 2. Click the marketing stage   you want to delete, and click the Delete   button.
 3. Click Yes   to delete it.
 4. Click Close.

Deleting a marketing final disposition
You cannot delete a marketing final disposition if it is currently being   used. However, you can make   it inactive. 

To delete a marketing final disposition

 1. From the  >  Setup   menu, click General > Marketing Final Dispositions.   
 2. Click the marketing final   disposition you want to delete, and click the Delete   button.
 3. Click Yes   to delete it.
 4. Click Close.

Inactivating a marketing stage
If you inactivate a marketing stage, it cannot be used; however, it   remains in the database and continues to 
appear on reports. You cannot   delete or inactivate the Final Disposition stage.

 1. From the  >  Setup   menu, click General > Marketing Stages.   
 2. Click the marketing stage   you want to inactivate.
 3. Click the Edit   button.
 4. In the Status field, select   Inactive.
 5. Click Save.
 6. Click Close.

Inactivating a marketing final disposition
If you inactivate a marketing final disposition, it cannot be used;   however, it remains in the database and 
continues to appear on reports. 

To inactive a marketing final disposition  

 1. From the  >  Setup   menu, click General > Marketing Final Dispositions.   
 2. Click the marketing final   disposition you want to inactivate, and click Edit.
 3. In the Status field, select   Inactive.
 4. Click Save.
 5. Click Close.
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Changes to BD projects and phases

Adding BD phases to projects and templates
unavailable in ajeraCore

To add a Business Development phase to an existing project or template

 1. Open the project or template.

 l To open a project, click  > Manage > Project Command Center,and click the project   in the 
project list at the top of the window.

 l To open a template, click  >  Setup > General > Project Templates,and click   the template in 
the list at the top of the window.

 2. In the project tree, click   where you want to add the new phase, and click the New   Phase button. The 
General   subtab for the phase appears.

 3. In the Description field,   type a name for the phase, such as Business Development.
 4. In the Status field, select   Marketing.
 5. Enter   information for the Business Development phase (following Steps 4 and   5 of instructions for 

setting up a phase).
 6. Add any additional BD phases   in the same way.
 7. Click Save.

Updating a BD project
Track and update your Business Development (BD) efforts by updating   information for each of its stages. 

To update a BD project

 1. From   the  >  Manage menu, click   Project Command Center. Click the project in   the list at the top 
of the window. 

 2. Click these tabs: Project Info >   Business Development > Stages.
About the buttons: 
To see any long names for marketing stages, click the   Long Description button. If your   firm 
changes or adds marketing stages, and you want to reflect those changes   in your list of stages for 
this project, click the Refresh   button.

 3. When the status of a stage   changes, click the stage and make a selection. For example, you begin   
writing the proposal, so you change the status of the Proposal stage from   Not Started to In Progress.
You can assign only one stage a status of   In Progress at a time.

 4. Change due   dates, start dates, and completion dates for stages, as needed.
 5. When the outcome of the   BD project is decided, for the Final Disposition stage in the table, select   a 

status of Won, Lost, or Declined.
 6. In the Final Disposition   field below the table, select the reason that you won, lost, or declined   the 

project.
 7. Do one of the following:
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If you Do this
Won the 
project

 1. To begin working on and   billing the project, click the project in the project tree. 
On the General subtab, change the status of   the project from Preliminary to   
Active. 

 2. Leave the status of the   BD phase as Marketing now and   even after you 
complete all project work and close the project. In this   way, Ajera includes it in 
reports and inquiries that you use to analyze   your past, current, and future BD 
efforts.
To see the status of the phase, click the   phase in the project tree, and its 
status appears in the Status field   on the General subtab.

Lost or 
declined 
the 
project

 1. In the Awarded To field,   select the firm that won the project.  
 2. Click the project in the   project tree. On the General subtab,   change the status 

of the project to Closed.
 3. Leave the status of the   BD phase as Marketing. In this   way, Ajera includes it 

in reports and inquiries that you use to analyze   your past, current, and future 
BD efforts.
To see the status of the phase, click the   phase in the project tree, and its 
status appears in the Status field   on the General subtab.

 8. Click Save.

Deleting a BD projects
You cannot delete a project once it has been used. However,   you can change the project status   to reflect the 
current situation. 

To delete a BD project

 1. From the  >  Manage   menu, click Project Command Center. 
 2. In the project list at the   top of the window, click the BD project you want to delete, and click the 

Delete   button.
 3. Click Yes   to delete the project.
 4. Click Save.

Producing BD reports and inquiries
unavailable in ajeraCore
Use reports and inquiries to track your wins and losses, analyze your   Business Development (BD) efforts, 
and make future plans.

Reports
Use these reports as follows:
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Use this 
report

To

BD 
Progress

Manage your tasks on open BD efforts in a variety of ways. You can look   forward at 
future tasks that need to be accomplished and look back on   performance and tasks that 
have already been completed.
You can select options to produce the report in the ways that best helps   you to analyze:

 l Projects your firm is pursuing
 l Tasks that need to be performed                        
 l Efforts by segments, such   as department or market segment (project type).

Win Rate Review your wins and losses over a period of time. It provides valuable   insight to trends 
and information which help your firm take action to   increase your win rate in the future.
Using the customize options, you can produce the report in different   ways. For example, 
you can analyze performance for

 l A certain market segment   (project type)
 l A department
 l An individual (project manager,   principal, or marketing contact)

You can also use the Win Rate report for competitive analysis to determine   your 
toughest competitors and the markets where you are losing to them.    

Project 
Workload

Forecast potential workload by reviewing a factored forecasted amount   for work you are 
currently pursuing.

In addition, you can choose to include or   exclude marketing cost on these reports:
 l Executive Summary
 l Project Earnings
 l Project Profit
 l Budget Variance

To include marketing cost, click  (Customize), and select   the Include marketing phases check   box. 

Inquiries
You can review or modify these standard inquiries to examine specific   aspects of your BD efforts:

This inquiry Contains
BD Phase General information, such as the hours worked and next task date, for   each BD 

phase
Click here for a list of predefined columns that   you can add to the BD Phase inquiry.

Marketing 
Stage

Information, such as the current status and due dates, for each marketing   stage of 
a BD phase
Click here for a list of predefined columns that   you can add to the Marketing Stage 
inquiry.
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Billing review

About billing review
unavailable in ajeraCore
What is billing review?
What are billing review stages?
How do you use billing review stages?
Why use billing review in Ajera?

What is billing review?
Billing review is the approval process that occurs before a client invoice is billed. The first person in the 
process reviews the invoice, makes comments or corrections, and passes it to the next reviewer. The 
process usually continues until the invoice is approved and can be billed. In cases involving outstanding 
invoices, the process might proceed through a collections stage until payment is received.

What are billing review stages?
In Ajera, you can use billing review stages to help move client invoices smoothly through the billing review 
process. The invoices must be based on a standard invoice format or on a custom design created with the 
Client Invoice Designer.
A billing review stage indicates where an invoice is in the review and can notify a reviewer when an invoice is 
ready. Billing review stages are optional and have no effect on the general ledger.
Ajera provides two stages by default, Pre-review and Final; you cannot change or delete them. When you set 
up a project or an invoice group or print an invoice as final and the project is not closed, Ajera creates an 
invoice and sets it to the Pre-review stage. When you print an invoice as final, the billing review stage 
automatically updates to Final.

You can set up additional billing review stages in  > Setup > General > Billing Review Stages to mirror the 
stages in your firm's billing review process. 
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How do you use billing review stages?
Review an invoice in the Client Invoice Preview window. This window is available from the Manage > Client 
Invoices > Preview button or from the  > Manage > Project Command Center > Invoices tab > Preview 
Invoice link. 
Click the Show Review History button to open the Billing Review History window. After entering your notes 
and adding any attachments, select a review stage to indicate that your review is completed. 
A notification can appear in the project list of the Project Command Center for the next reviewer. You can also 
filter the Client Invoice List window so that it displays only invoices requiring your review. 
At any time, you can view the billing review information for an invoice in the Billing Review History window. 
The billing review table lists all the preceding billing reviews for the invoice and can display notes, contacts, 
attachments, stages, and dates. You can do any of the following in the table:

 l Change the due date, attachments, contact, notes or stage of any row of the table.
 l Delete a row if you are the author or an administrator. 

Why use billing review in Ajera?
Ajera streamlines the billing review process in the following ways:

 l Review notes and attachments are kept with their corresponding client invoices. 
 l Reviewer notifications keep the billing review process moving smoothly.
 l Project managers can review their invoices easily on the Invoices tab of the Project Command 

Center. The tab contains the PCC Invoices inquiry, which displays invoice information for a selected 
project.

 l You can easily track the progress of your client invoices in the review process from either the Client 
Invoice List window or the Project Command Center. There is no need to open each invoice. 

 l You can extend this process through a collections stage, keeping track of outstanding invoices until 
payment is received.

Customizing the Project Command Center for billing review
Customize the Project Command Center so that the project list displays billing review notifications and the 
Billing Review Stage column. Also, change the PCC Invoices inquiry on the Invoices tab so that it displays 
the information you want.

 l To display billing review notifications and the Billing Review Stage column
 l To change the PCC Invoices inquiry

To display billing review notifications and the Billing Review Stage column

 1. From the  >  Manage menu, click Project Command Center.
 2. Click  (Customize) at the upper right of the  Project Command Center.
 3. On the Project List tab, expand the General Info category by clicking the  symbol.
 4. Select the Show check box for one or more of the following:

 l PM Action
 l BM Action
 l Prin Action
 l Acctg Action
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 5. On the same tab, expand the Billing & Invoicing category by clicking the  symbol.
 6. Select the Billing review stage check box.
 7. Click OK. The selected notification columns and the Billing Review Stage column appear in the 

project list.

To change the Invoices inquiry

About the Invoices inquiry

If your role has permission to change inquiries (  > Setup > Company > Roles > General tab > Manage 
custom reports and inquiries check box), you can change the PCC Invoices inquiry on the Invoices tab as 
you would any other inquiry except for conditions, which are not available.
Unlike other inquiries, the PCC Invoices inquiry is the same for all employees who have permission to view it (

 > Setup > Company > Roles> Projects tab > Invoices subtab). Any changes to the inquiry are visible to 
anyone with access to it.

If employees also have permission to change inquiries, they can change the inquiry or click   (Revert) on 
the inquiry toolbar to discard any changes to the PCC Invoices inquiry. 

 1. In the Project Command Center, click the Invoices tab. The PCC Invoices inquiry appears, providing 
information about invoices for a selected project.

 2. Change the inquiry, if needed. You cannot set conditions on this inquiry.
 3. Change the cutoff date if needed.
 4. Click Save.
 5. Click Close.

Reviewing invoices from the Project Command Center
About billing review
These instructions apply only to invoices that are  based on a standard invoice format or on a custom design 
created with the Client Invoice Designer.

To review an invoice from the Project Command Center

 1. From the  >  Manage menu, click Project Command Center. 
 2. In the project list, select your project.
 3. Click the Invoices  tab. 

If your security settings give you permission, you can change the inquiry or change the cutoff date, if 
needed.

 4. Select the invoice you want to view and click the Preview Invoice link. 
 5. Click the Show Review History button. The Billing Review History window provides a chronological 

record of the billing review stages for an invoice.
 6. To filter by one stage, use the Show Stage field to select the stage you want to appear in the billing 

review table.
 7. Click  to refresh the billing review history list with any changes including new rows added, changes 

made in existing rows, or date/time changes.
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 8. Click   (Customize) and choose the columns you want to appear in the billing review table.
 9. Review the preceding rows in the table to see what earlier reviewers found. You can do the following:

 l Change the due date, attachments, contact, notes, or billing review stage of any preceding row 
except the auto-generated Pre-review and Final stages. Your name and the date will appear in the 
modification columns.             

 l Delete a row if you are the author or the administrator.             
 10. Review the invoice, and in the next row of the table, enter notes related to your review. You can also 

add attachments and select a contact, if available. 
 11. When finished, select a billing review stage, enter a due date if needed, and click Save.

Schedule Manager

About scheduling employees on projects
unavailable in ajeraCore

Schedule Manager enables you to schedule employees on projects without affecting accounting, billing, or 
contracts. You can easily change schedules as needed.
Learning Resource: Schedule Manager Functional Guide

Who should use it?
In Ajera, project managers, department managers, and principals can use Schedule Manager to schedule 
employees on projects, manage schedules, and analyze project performance and employee workload. 
Employees can keep up-to-date on their own schedules, as well.

How does it work?
As a best practice, add employees to your projects and budget them in the Project Command Center, and 
then schedule those employees in Schedule Manager. That way, budgeted hours and dollars from the Project 
Command Center are available to guide you. 
However, you can also add employees to projects in Schedule Manager, but budgeted hours or dollars may 
not be available. In that case, you can go to the Project Command Center and enter the budgeted hours or 
dollars there.
As you schedule, and as time is entered to the project, Ajera updates the actual hours and dollars. This makes 
it easy to tell which projects are going over budget and which employees are underutilized or overutilized.

How do you view scheduling data in a report?
To view this data in a report format, you can add predefined columns related to Schedule Manager to these 
inquiries:
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 l Employee
 l Project
 l Phase
 l Resource
 l Task
 l Resource/Task

How do you set it up and use it?

 Do this Here To accomplish this
1. Set up  

security for 
the Schedule 
Manager

 > Setup 
> Company 
> Roles > 
Manage tab

Set security so that you can view employee schedules or 
schedule hours by project or employee. 

2. Set up 
scheduling 
preferences 
for color-
coding 

 > Setup 
> Company 
> 
Preferences 
> Schedule

Select colors to indicate when an employee's total scheduled 
hours for the week reach a threshold, which you specify.

3. Set up, 
budget, and 
add resources 
to your project

 > 
Manage > 
Project 
Command 
Center

Set up and budget your project in the Project Command 
Center.
Add employees at the same level within the project so that 
their hours roll up uniformly in Schedule Manager. When you 
assign a labor resource to a phase, you are telling Ajera that’s 
the level where you want to schedule.
Enter budgeted hours or dollars for each employee.

4.
 

Add 
employees to 
projects, if 
needed

 > 
Manage > 
Schedule > 
Projects tab

Add an employee to the project, if you did not add that person 
in the Project Command Center. 

5.
 
 

View project 
hours and 
Schedule 
hours by 
project

 > 
Manage > 
Schedule > 
Projects tab 

Manage schedules based on project performance, for all 
projects or only your projects. If you can, use the Available 
columns to keep track of how many hours or dollars are left to 
schedule.
Available = Remaining - Scheduled

View 
employee 
hours and 
Schedule 
hours by 
employee

 > 
Manage > 
Schedule > 
Employees 
tab

Manage schedules based on employee workload, for all 
projects or only your projects. If you can, use the Available 
columns to keep track of how many hours or dollars are left to 
schedule.
Available = Remaining - Scheduled

6. Review your 
schedule

 > 
Manage > 

Keep up-to-date on your workload, and make or request 
changes as needed.
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 Do this Here To accomplish this
Schedule > 
Employees 
tab

7. Export 
schedules by 
project to 
Excel

 > 
Manage > 
Schedule > 
Projects tab

Export schedules by project to Excel, and format and print as 
needed.

 Export 
schedules by 
employee to 
Excel

 > 
Manage > 
Schedule > 
Employees 
tab

Export schedules by employee to Excel, and format and print 
as needed.

Adding employees to a project
unavailable in ajeraCore
If you did not add employees to a project in the Project Command Center, you can add them in Schedule 
Manager. Any employees you add in Schedule Manager automatically appear as labor resources on the 
Manage tab of the Project Command Center.

Note:
 

You may want to enter budgeted hours or dollars for the employees in the Project Command 
Center so you can schedule against the budgets in Schedule Manager.

To add employees to a project

 1. From the  >  Manage menu, click Schedule. 

 2. Click  (plus sign) to expand the project you want.
 3. If an employee is not assigned to a project and enters time to it, Ajera highlights that unassigned 

employee in red. 

 l If that employee is in the correct phase and with the appropriate employee type, click  (red 
icon) to add that person to the project. 

 l If that employee is in the wrong phase, click   (blue icon) to open the Team Builder window.

Note: To add other employees to the project in Schedule Manager, click   to open the Team 
Builder window.

 4. In the ID & Description table on the left, click the phase where you want to add the employee. 

The  (gray icon) indicates that labor resources are assigned to that phase on the Manage tab of the 
Project Command Center.

 5. In the resource table on the right, click an empty row and do the following:
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Field Description
Employee 
Type

Click      (more button) and select the employee type.

Employee Click      (more button) and select the employee.

Note: If you select an employee but no employee type, Ajera automatically 
enters the employee type from the employee setup.

Budget Displays the budgeted hours for the resource, for reference only. If needed, you can 
change the budgeted hours on the Manage tab of the Project Command Center.

* 
(asterisk)

Indicates that you cannot delete the labor resource from the Team Builder window 
because it has a budget, percent distribution, task, notes, or start or end dates 
assigned to it on the Manage tab of the Project Command Center.

 6. Repeat Steps 4-5 for each employee you want to add to the project.
 7. To change the employee order in a phase, select an employee and click   or   . This also changes 

the order on the Manage tab of the Project Command Center.
 8. Click Close.

Changing an employee on a project
Changes you make to employee, employee type, or employee order in Schedule Manager automatically 
appear on the Manage tab of the Project Command Center.

To change an employee on a project

 1. If Schedule Manager is not already open, from the  >  Manage menu, click Schedule and expand 
the project you want.

 2. Click   (blue icon) to open the Team Builder window.
 3. In the ID & Description table on the left, click the phase that contains the employee you want to 

change.
 4. In the resource table on the right, change the employee or employee type.
 5. To change the employee order in a phase, select an employee and click   or   . 
 6. Click Close.

Deleting an employee from a project
You cannot delete an employee tagged with an asterisk (*) from Schedule Manager because it has one of the 
following assigned to it on the Manage tab of the Project Command Center: a budget, percent distribution, 
task, notes, or start or end date. However, you can delete the resource from the Manage tab.

To delete an employee from a project

 1. If Schedule Manage is not already open, from the  >  Manage menu, click Schedule and expand 
the project you want.

 2. Click   (blue icon) to open the Team Builder window.
 3. In the ID & Description table, click the phase that contains the employee you want to delete.
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 4. In the resource table on the right, click the employee and click the Delete button.
 5. Click Yes to delete the employee. 
 6. Click Close.

Viewing project hours
unavailable in ajeraCore
The Schedule Manager displays projects with recent activity.Such as:

 l Projects created within the past four weeks
 l Time entered during the past four weeks
 l Labor resources scheduled for current and future weeks

Project totals in Schedule Manager match the project totals in the Project Command Center.

Before you begin
 l Add employees to a project, if needed
 l Multi-company only: To view project hours by company, verify that company preferences are set up 

for multi-company.

To view project hours

 1. To open Schedule Manager click  >  Manage menu, click Schedule.

 2. To add a project to the Projects tab, click  (Search) and add the project. Search options include:
 l Project description
 l Project ID
 l Client, if available

Note: After adding a project through search, schedule time to it or leave it expanded if you want 
it to persist on the  Projects tab. 

 3. To change what information you see about the project, click  (Customize). You can change the 
following:

 l Increase time span: You can select from 0 to 4 past weeks or from 1 to 104 future weeks.
 l Filters: Ajera displays any applied filters at the top of Schedule Manager. To remove the filters, 

either click the X next to the applied filters in Schedule Manager, or open the Projects - 
Customize window and clear the filter options.

Filter Description

Project Manager The project manager associated with a project

Billing Manager  

Department The department associated with a project

Client The client associated with a phase or project

Principal The principal associated with a project
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Project type The project type associated with a project

Project Status The project status associated with a project

Phase Status The phase status associated with a project

Billing Type The billing type associated with a project

Company Multi-company only. For this filter to appear you need to be 
set up for multi-company. 
The company associated with a project

 l View project detail (columns): Applied columns will display in Schedule Manager window when 
selected.

Column Description

Hours budget The number of hours budgeted
This field references the Hours/Units column on the Manage tab of the Project 
Command Center.

Scheduled 
hours

The number of hours in the future scheduled in Schedule Manager

Available 
hours

The number of unscheduled hours remaining:
Hours Budget - (Hours Actual + Scheduled Hours)

Hours 
remaining

The number of budgeted hours remaining:
Hours Budget - Hours Actual

Spent 
remaining

The labor contract amount remaining:
Labor Contract - Spent Labor

Client The client associated with a phase or project

Project/Phase 
Status

The status associated with a phase or project. This field references statuses 
from the Project Command Center.

Labor contract The amount contracted to bill the client for labor expenses

Scheduled 
dollars

The amount scheduled to date in Schedule Manager
Ajera calculates the amount by multiplying the scheduled hours by the billing 
rate.

Available 
dollars

The amount of unscheduled dollars remaining:
Labor Contract - (Spent Labor + Scheduled Dollars)

Hours actual The actual number of hours spent to date for the project (on the Projects tab) and 
for the weeks displayed for the employee (on the Employees tab)
This field references the project's timesheets.

Spent labor The amount of labor expended on the project to date at the billing rates/markups
Ajera determines the spent labor amount from the billing rate table.
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Department  

Project 
Manager

The project manager associated with a project. This field references the project 
manager listed on a project in the Project Command Center.

Billing 
Manager

 

Estimated 
Start Date

The estimated start date associated with a project. This field references the 
estimated start date listed for a project in the Project Command Center.

Estimated 
Completion 
Date

The estimated completion date associated with a project. This field references 
the estimated completion date listed for a project in the Project Command 
Center.

 5. On the Schedule Manager, click  (plus sign) to expand a project. Project phases with labor 
resources appear.
In the columns to the left, Ajera calculates the hours for the project based on budgeted time and 
dollars from the Manage tab of the Project Command Center, project hours from Manage > Time & 
Expense, and scheduled hours from the columns to the right in Schedule Manager. 

 6. Scroll to the right to view employee hours by project:

In Schedule Manager, this Contains this
Shaded cells Timesheet hours entered to the project in past weeks

Columns with green headings Actual and scheduled hours for current week
As actual hours are entered to the project, Ajera updates the 
scheduled hours in the column to the left.

Columns to the right of the 
columns with green headings 

Scheduled hours for future weeks

 7. Schedule hours by project, if needed.

Scheduling hours by project
unavailable in ajeraCore
You can schedule by either project or employee.
Schedule by project to manage the employees on your projects at a high level. 
If you have permission to see all projects, you can also schedule by employee and manage your projects at a 
lower level.

Before you begin 
 l View project hours.

To schedule hours by project
 1. In the unshaded cells, enter the number of hours per week for each employee.
 2. To view the number of hours already scheduled for a week, right-click the week at the project, phase, 

or resource level. 
If you set color-coding preferences for scheduling, the hours are highlighted by those colors.
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 3. As you work, do the following as needed:

To Do this
Change the columns or number of weeks   1. Click  (Customize)  to open the Projects 

- Customize window.
 2. Select the columns or enter the number of 

weeks.

Filter at the project level by department, 
project manager, or both

 1. Click  (Customize)  to open the Projects 
- Customize window.

 2. Click the Filters tab and select a filter. 
Ajera displays the applied filters at the top 
of Schedule Manager. To remove the 
filters, either click the X or clear the filter 
option in the Projects - Customize 
window. 

Remove the red highlighting from an 
employee
The red highlighting indicates that the 
employee is not assigned to a project and 
entered time to it, or entered time using the 
wrong employee type.

One of the following:
 l Add the employee to the project. 
 l Ask the employee to correct the timesheet 

by removing the hours or changing the 
employee type.

Adjust all the scheduled hours to the right of 
the cursor a specific number of weeks, at 
the project, phase, or resource level

 1. Right-click the cell at the start or end of the 
group of hours you want to adjust. 

 2. Select forward (to the right) or backward 
(to the left), enter the number of weeks to 
adjust, and click the Adjust button.
The lower-level rows also adjust the same 
number of weeks. 

 4. Review the columns to evaluate project performance. Depending on your security settings, you may 
also see dollar amounts based on billing rates.  
For example, compare the Budget and Actual columns to determine where the project is now. View 
the Available columns to forecast where the project will be, given the current scheduling.

Viewing employee hours
unavailable in ajeraCore
Hour totals appear for employees who are budgeted in the Project Command Center or scheduled in Schedule 
Manager. Employee hours appear for the:

 l Number of past and future weeks selected in the Customize window
 l Hours entered or scheduled during those weeks

Before you begin 
 l Add employees to a project, if needed
 l Multi-company only: To view employee hours by company, verify that company preferences are set 

up for multi-company.
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To view employee hours

 1. To open the Schedule Manager click  >  Manage menu, click Schedule. 
 2. Click the Employees tab. 
 3. Click  (Customize) to choose the following options:

 l Increase time span: You can select from 0 to 4 past weeks or from 1 to 104 future weeks.
 l Filters: Ajera displays the applied filters at the top of Schedule Manager. To remove the filters, 

either click the X next to the applied filters in Schedule Manager, or open the Projects - 
Customize window and clear the filter options.

Filter Description
Employee Type The employee type associated with an employee

Department The department associated with an employee

Supervisor The supervisor of an employee

Employee 
Status

The status of the employee

Company  Multi-company only. For this filter to appear you need to be set up for multi-
company. 
The company associated with an employee

 l View project detail (columns)

Column Description
Hours 
budget

The number of hours budgeted
This field references the Hours/Units column on the Manage tab of the Project 
Command Center.

Scheduled 
hours

The number of hours in the future scheduled in Schedule Manager

Available 
hours

The number of unscheduled hours remaining:
Hours Budget - (Hours Actual + Scheduled Hours)

Hours 
remaining

The number of budgeted hours remaining:
Hours Budget - Hours Actual

Spent 
remaining

The labor contract amount remaining:
Labor Contract - Spent Labor

Client The client associated with a phase or project

Labor 
contract

The amount contracted to bill the client for labor expenses

Scheduled 
dollars

The amount scheduled to date in Schedule Manager
Ajera calculates the amount by multiplying the scheduled hours by the billing rate.

Available The amount of unscheduled dollars remaining:
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Column Description
dollars Labor Contract - (Spent Labor + Scheduled Dollars)

Hours 
actual

The actual number of hours spent to date for the project (on the Projects tab) and 
for the weeks displayed for the employee (on the Employees tab)
This field references the project's timesheets.

Spent labor The amount of labor expended on the project to date at the billing rates/markups
Ajera determines the spent labor amount from the billing rate table.

Department The department associated with an employee

Employee 
Status

The status of the employee

 4. On the Schedule Manager,  click  (plus sign) to expand an employee row. 
 5. Scroll to the right to view hours by employee:

In Schedule Manager, this Contains this
Shaded cells Timesheet hours entered to the project in past weeks

Columns with green headings Actual and scheduled hours for current week
As actual hours are entered to the project, Ajera updates the 
scheduled hours in the column to the left.

Columns to the right of the 
columns with green headings 

Scheduled hours for future weeks

If you set color-coding preferences for scheduling, the total scheduled hours for the week are 
highlighted by those colors.

 6. Schedule hours by employee, if needed.

Scheduling hours by employee
unavailable in ajeraCore
You can schedule by either employee or project.
Schedule by employee if you have permission to see all projects. You can make scheduling decisions based 
on employee workload and also manage employee workload as the project proceeds. 

Before you begin
 l View employee hours.

To schedule hours by employee
 1. In the unshaded cells, enter the number of hours per week for the employee.
 2. Review the columns to evaluate employee workload. Depending on your security settings, you may 

also see dollar amounts based on billing rates.  
For example, review the weekly totals to determine which employees are overutilized or 
underutilized. 
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Reviewing your schedule 
unavailable in ajeraCore
You can keep up-to-date on your work schedule in Schedule Manager. Only time entered in past weeks or 
scheduled in current and future weeks appears.
Depending on your security settings, you may view your schedule, or view and change your schedule. 

To review your schedule

 1. From the  >  Manage menu, click Schedule. 
 2. Click the Employees tab, and scroll to the right to view your hours:

In Schedule Manager, this Contains this
Shaded cells Timesheet hours entered to the project in past weeks

Columns with green headings Actual and scheduled hours for current week
As actual hours are entered to the project, Ajera updates 
the scheduled hours in the column to the left.

Columns to the right of the 
columns with green headings 

Scheduled hours for future weeks

 3. If you have permission, change your current or future hours as needed. Otherwise, contact someone 
who has permission to edit your schedule. 

 4. Click Close.

Deleting a project from Schedule Manager
You cannot delete or remove a project from Schedule Manager.
Instead, projects that are collapsed and have the least activity will disappear from the Projects tab after four 
weeks if no time is entered to the project.

Exporting schedules by project to Excel
You can export what you see on the Projects tab to Microsoft Excel. 
You can control which schedules are exported by selecting only expanded projects, applying filters, or both.

Before you begin
 l View project hours

To export scheduled by project

 1. Click  (Export). 
 2. Select your export settings:
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Select To
Export expanded 
projects only

Export schedules for only expanded projects on the Projects tab. 
If the check box is cleared, Ajera exports schedules for all displayed 
projects on the Projects tab.

Export with colors and 
shading

Export the colors and shading as applied on the Projects tab.

 3. Click the Export button. 
 4. Navigate to where you want to export the schedules, select the file type, and click Save.

Ajera exports only the data, no formulas or formatting. In Excel, you can create formulas, format the 
information, and expand or collapse rows by clicking  or .

Exporting schedules by employee to Excel
unavailable in ajeraCore
You can export what you see on the Employees tab to Microsoft Excel. 
You can control which schedules are exported by selecting only expanded employees, applying filters, or 
both.

Before you begin 
 l View employee hours

To export schedules by employee

 1. Click  (Export). 
 2. Select your export settings:

Select To
Export expanded 
employees only

Export schedules for only expanded employees on the Employees tab. 
If the check box is cleared, Ajera exports schedules for all displayed 
employees on the Employees tab.

Export with colors and 
shading

Export the colors and shading as applied on the Employees tab.

 3. Click the Export button. 
 4. Navigate to where you want to export the schedules, select the file type, and click Save.

Ajera exports only the data, no formulas or formatting. In Excel, you can create formulas, format the 
information, and expand or collapse rows by clicking  or .
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Entering and managing timesheets

About timesheets
The following is a typical sequence of events for processing time:

 1. An employee enters time.
 2. When finished entering all   the time for a week, an employee submits the timesheet.
 3. The supervisor, accounting   manager, or project manager reviews the timesheet and does the 

following:
 l Approves the timesheet.
 l Rejects time on the timesheet, entering comments about   the rejected time. The employee then 

corrects the rejected time and resubmits   the timesheet.
Depending on the options chosen when setting   up company time and expense entry preferences, the 
supervisor/manager   may have access to change an employee's timesheet.

Working with timesheets
The following events occur as you process time at your company:

When this 
occurs

This happens

Close or 
save a 
timesheet

Ajera saves the time you entered and updates the client invoice and   project information 
with it.

Submit An employee has finished entering time on a timesheet and is ready for   the 
supervisor/manager to review it. 
Now, to make any changes to the timesheet, the employee must first unsubmit   it.

Approve A supervisor/manager approves the time that the employee entered.   The timesheet 
appears as Approved in timesheet lists.
The timesheet can no longer be changed unless it is unapproved first.

Reject 
specific 
hours

When approving a timesheet, the supervisor/manager can reject specific   hours and 
optionally add any comments.
If a timesheet has any rejected hours, the timesheet appears as Time   Rejected in 
timesheet lists. The employee must correct the time and submit   the timesheet again.
The rejected hours appear in bold type on the timesheet for the employee   to review or 
change them.

Reject The supervisor/manager rejects the entire timesheet. The timesheet appears   as Time 
Rejected in the timesheets list. The employee must correct and   submit the timesheet 
again. Rejected time cannot be billed or paid.

Unsubmit An employee decides a timesheet is not ready for approval after all.
An employee can change a timesheet if it has not yet been approved.   However, an 
employee cannot change any time on the timesheet that has   already been billed or 
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When this 
occurs

This happens

paid.

Unapprove A supervisor/manager decides that they do not want to approve the timesheet   after all. 
However, any time that has already been   billed or paid can no longer be changed. 

Delete You cannot delete a timesheet if it has been submitted or if it contains   time that has 
been billed or paid.

Entering a timesheet
Learning Resource: Time Entry Functional Guide

Before you begin

 l Check the Don't Allow Entries Prior To Date on the  > Setup > Company > Preferences > 
General tab. You cannot enter time before that date.

To enter a timesheet

 1. From the  >  Manage   menu, click Time & Expense.   
 2. On the My   Timesheets tab, click the New   button. 
 3. For the timesheet ending   date, either leave the date that appears or change it to reflect the date to 

which  you want to enter time. 

Note: You can also enter your time by copying   an existing timesheet. 

 4. Click OK.   Your timesheet appears. It consists of three areas for entering your   time.

 5. Enter your time as follows:
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To enter Do this
Direct or 
project 
time

 1. In   the table at the top of the window, enter a project, phase, and then 
activity.
Multi-company only. If you enter time to a project that your company is not 
responsible for, Ajera creates intercompany entries. Be sure to reconcile 
your intercompany accounts regularly.

Note: For more information about the project, phase, or activity , 
click    (Customize) after clicking .

 2. Type   the hours you worked on the project/phase/activity for each day of the
   week.

 3. If notes are required on the timesheet, a Notes window appears when you 
leave a timesheet cell. If you do not enter notes in that window, Ajera clears 
the time you just entered.

 4. Repeat   these steps for each project/phase/activity you need to enter time 
for.

Overhead 
or 
nonproject 
time

 1. In the table in the middle of the window, type the hours in the cell   that 
correspond to the type of overhead and day of the week for the time   you 
want to enter.

 2. If notes are required on the timesheet, a Notes window appears when you 
leave a timesheet cell. If you do not enter notes in that window, Ajera clears 
the time you just entered.

Note: You can also enter hours using the timer. You can use the timer to track 
start/stop times, or you can use the timer without tracking start/stop times.
When you click or tab to a cell, the Hours   Detail table at the bottom of the 
window displays any detail for that   cell.

 6. If you worked overtime or   other premium time:
 l In the table for direct time or overhead time, click   the applicable cell.
 l In the Hours Detail table, type the overtime or premium   time hours. The cell in the table for direct 

time or overhead time is   outlined in red to show it is where you are currently entering time. 
 l In the Hours Detail table, change the regular hours,   if needed, so the total number of hours you 

worked for that project/phase/activity   on that day is correct.
 l If notes are required on the timesheet, enter them into the Notes field in the Hours Detail table. If 

you leave the Notes field without entering notes, a window appears reminding you that notes are 
required. 

When you move out of a row in the Hours Detail   table, the total number of hours appears in the cell in 
the table for   direct time or overhead time. A plus sign (+)   also appears to indicate that the cell total 
contains different types   of hours in addition to regular time.

 7. To attach a note for hours   you worked:
 l In the table at the top or in the middle of the window,   click the applicable cell.
 l In the Hours Detail table, enter   notes in the applicable cell.

A note symbol    appears in the cell in the table at the top of the window to indicate   that notes are 
attached. 
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 8. If   you enter a row by mistake, do one of the following:
 l Click the row, click the Delete button, and click Yes to delete it.
 l Right-click the row, click Delete   Row, and click Yes to delete it.

 9. If you need to clear the contents of a timesheet cell, right-click the cell, click Clear contents, and 
click Yes to clear the contents of the cell.

 10. Do one of the following:
 l If you are not ready to submit the timesheet, click   Close. You can open it later.   Ajera saves it 

under its week ending date.
 l If you are finished with the timesheet and want to send   it for approval, click the Submit   button. 

Once you submit a timesheet, you can no longer change it unless   you unsubmit it. Click Close.

Submitting a timesheet
Submit a timesheet if you are finished entering   the timesheet and want it approved. Once you submit a 
timesheet, you   can no longer change it unless you unsubmit   it. 
If you are already viewing the timesheet, just click the Submit   button. 

To submit a timesheet

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the My   Timesheets tab. 
 3. Submit the timesheet in   one of the following ways:

To submit it Do this
Without reviewing it first Click the timesheet, and click the Submit   button.

After reviewing it  1. Click the timesheet you   want to submit, and click Edit.
 2. Review the timesheet, and   make changes if needed.
 3. Click the   Submit button.

Printing a timesheet
Print a timesheet if you need a report of the entered time. 

To print a timesheet

 1. From the  > Manage   menu, click Time & Expense.  
 2. Click one of the following tabs:

 l My   Timesheets, if you want to print your own timesheet.
 l Timesheets by Employee, if you have Administrator privileges and want to print someone 

else's timesheet.
 3. Double-click the timesheet you want to print.
 4. Click the Print button. A preview of the timesheet report appears.

 5. Click  in the report toolbar.
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Copying a timesheet
To copy a timesheet

 1. From the  >  Manage   menu, click Time & Expense.   
 2. On the My   Timesheets tab, click the New   button. 
 3. For the timesheet date,   either leave the date that appears or change it to reflect the date you   want to 

enter time for.
 4. Select the Copy   timesheet from check box, and click the date of the timesheet you   want to copy.
 5. Click OK.   The timesheet appears.
 6. Change   the timesheet, as needed.
 7. Do one of the following:

 l If you are not ready to submit the timesheet, click   Close. You can open it later.   Ajera saves it 
under its week ending date.             

 l If you are finished with the timesheet and want to send   it for approval, click the Submit   button. 
Click Close.             

Using the timer to track start/stop times

This feature is only available from  > Manage > Time & Expense and is not available for  > Manage > 
Timesheets.
Use the timer to automatically record hours when   entering time.                    
The behavior of the timer depends on whether or not you are tracking work start and stop times.
This topic describes what happens if you are tracking start and stop times. In this case, you can record one 
interval of regular time and one interval of overtime per timesheet cell when entering time. If more than one 
overtime type is available, employees can record one interval per type.
If you are not tracking start and stop times, see Using the timer without tracking start/stop times.
Ajera Mobile Timesheets: You cannot track start and stop times with Ajera Mobile Timesheets on your 
mobile device.

To use the timer tracking

 1. From  > Manage menu, click   Time & Expense, and do the   following:
 l Open a  new timesheet:

 i. On the My   Time tab, click the New   button. 
 ii. For the timesheet ending   date, either leave the date that appears or change it to reflect the date

   you want to enter time for.  
 iii. Click OK.   

 l Open an existing timesheet:
 i. On the My Time tab, click the   date for the timesheet you want to open, and click Edit .

 2. Click the cell where you   want to add time.
 3. Click the Timer   button. The Timer appears displaying the current time, and it begins counting.   
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Note: The timer counts time based on the time increment that was selected on   the Time & 
Expense Entry tab of the Company Preferences window. For example,   if the time 
increment is set at Half Hour, the timer counts time in half-hour increments.
You can also change the elapsed time by typing   a new time or by clicking the plus or 
minus button to change the time   by the time increment set in company preferences. 
However, if no time   increment was selected in the Company Preferences window, the 
plus and minus buttons   do not appear.

 4. When you want to stop counting   time, click the Stop Timer button.   The time you worked appears in 
the cell. 

 5. If you are tracking work start and stop times, the timer automatically counts the   second session as 
overtime.
To count that second session as regular time,   add another row to your timesheet and start the timer 
from that row. 

 6. If it happens that you did   not work on the project during all the time you used the timer, you can   do one 
of the following:

 l Change the hours in the Hours Detail table.             
 l Change the start time or end time in the Hours Detail   table.

Note: Start and end times appear if the      Start/end time check box is selected in  (Customize) 
window of the timesheet. 

Using the timer without tracking start/stop times

This feature is only available from  > Manage > Time & Expense and is not available for  > Manage > 
Timesheets.
Use the timer to automatically record hours when   entering time.                 
The behavior of the timer depends on whether or not you are tracking work start and stop times. 
This topic describes what happens if you are not tracking start/stop times. In this case, you can record 
multiple intervals of regular time and overtime per timesheet cell while entering time. Ajera adds each 
successive interval to the total regular time or overtime recorded for the cell, and displays no start and stop 
times in the Hours Detail table.
If you are tracking start/stop times, see Using the timer to track start/stop times. 
Ajera Mobile Timesheets: You cannot track start and stop times with Ajera Mobile Timesheets on your 
mobile device.

Recording one time interval 

 1. From  > Manage menu, click   Time & Expense, and do the   following:
 l Open a  new timesheet:

 i. On the My   Time tab, click the New   button. 
 ii. For the timesheet ending   date, either leave the date that appears or change it to reflect the date

   you want to enter time for.  
 iii. Click OK.   

 l Open an existing timesheet:
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 i. On the My Time tab, click the   date for the timesheet you want to open, and click Edit .
 2. Click the cell where you   want to add time.
 3. Click the Timer   button. The Timer appears displaying the current time, and it begins counting.   

Note: The timer counts time based on the time increment that was selected on   the 
Time & Expense Entry tab of the Company Preferences window. For 
example,   if the time increment is set at Half Hour, the timer counts time in 
half-hour increments.
You can also change the elapsed time by clicking the plus or minus button to 
change the time   by the time increment set in company preferences. 
However, if no time   increment was selected in the Company Preferences 
window, the plus and minus buttons   do not appear.

 4. When you want to stop counting   time, click the Stop Timer button.   The time you worked appears in 
the cell. 

 5. If you restart the timer for the same cell on your timesheet, the timer automatically adds the second 
session to the regular time recorded for the cell. Each subsequent session is added to the regular-time 
total.
To record overtime, click the Overtime row in the Hours Detail table before clicking the Timer button. 
You can add subsequent sessions to the overtime total, if needed.

 6. If it happens that you did   not work on the project during all the time you used the timer, you can   
change the hours in the Hours Detail table.

Tracking in/out times
You can record in and out times for events, such as lunch/breaks, in the timesheet. 
Ajera Mobile Timesheets: You cannot track in and out times with Ajera Mobile Timesheets on your mobile 
device.

Before you begin

 l On the  >  Company > Preferences > Time & Expense Entry tab, select the Track Start & Stop 
Times check box.

 l Change the overhead groups for which you want to track in/out times:
 o Add a row for each in time and a row for each out time. Example:

 l Work Day In
 l Work Day Out
 l Lunch In
 l Lunch Out

 o In each of these rows, select an overhead project to track the overhead time, select a phase and 
activity, and leave the Pay field blank.

To track in/out times

 1. From the  > Manage menu, click   Time & Expense.
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 2. On the My   Time tab, click the New   button. 
 3. For the timesheet ending   date, either leave the date that appears or change it to reflect the date   you 

want to enter time for. Click OK.

 4. Click  (Customize) and select the Start/Stop Time check box. Click OK.
 5. In the Overhead table, click the cell where you want to track the in time. A red border indicates that the 

cell is selected. Example:
 l In the Work Day In row, click the cell for Monday.

 6. In the Hours Detail table, type the time in the Start Time cell and press the Tab key. In the Overhead 
table, 0 appears in the Total column. Example:

 l In the Regular row, type 8:00 AM for the start time. 

Note: For each overhead group item, enter only a start time or only a stop time. If you enter 
both, Ajera automatically calculates the interval and enters the total time into the 
Overhead table.

 7. In the Overhead table, click the cell where you want to track the out time. A red border indicates that 
the cell is selected. Example:

 l In the Work Day Out row, click the cell for Monday.
 8. In the Hours Detail table, type the time in the End Time cell and press the Tab key.  In the Overhead 

table, 0 appears in the Total column. Example: 
 l In the Regular row, type 5:00 PM for the end time.

 9. Click Save.
Example:
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Changing a timesheet
After you submit a timesheet, you can no longer change it unless you   unsubmit it or your 
supervisor/accounting manager rejects any time on   it.
After hours are paid or billed, you can add notes but you cannot change the hours. 

To change a timesheet

 1. From the  > Manage   menu, click Time & Expense.   
 2. Click the My   Timesheets tab. In the table, you can choose to:

 l View the sort order   or appearance of columns differently.
 l Add optional columns to see additional information. Click   (Customize), click the columns you 

want to add, and click OK.

Column Description
Submitted Indicates if the timesheet was submitted

Time rejected Indicates if any time on the timesheet was rejected

Supervisor 
approved

Indicates if the supervisor approved the timesheet

Project manager 
approved

Indicates if the project manager approved the timesheet

Accounting 
approved

Indicates if the accounting manager approved the timesheet

Target billable % Lists the targeted billable percent

Actual billable % Lists the actual percent billable

Paid Indicates if payroll has been processed for the employee

Regular Indicates total regular hours on the timesheet

Overtime Indicates total overtime hours for each overtime type set up in  >  Setup   > 
Company > Payroll > Pays. 

 l Change which timesheets appear in the table. Click   (Change View), enter the following 
information, and click OK.

To view 
timesheets

Do this

For a 
certain 
period

In the Date Range field, click the date or time period you want to view   timesheets 
for. To choose a range of dates, click Select   Dates and then enter the beginning 
and ending dates in the fields   that appear to the right.

Show only 
my 
employees

This option only appears if you are set up as an accounting manager, who by 
default sees all employees. 
Select the Show only my employees   check box to see only your own direct 
reports instead of a list of all employees.
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To view 
timesheets

Do this

Show 
multilevel 
employees

This option only appears if you are set up as a supervisor, not as an accounting 
manager, and your company preferences are set up to allow multilevel timesheet 
approval (  > Setup > Company > Preferences > Time & Expense Entry tab ).
Select the Show multilevel employees check box to see employees who report 
directly to you and those employees who report to supervisors who report to you. 

If submitted You can choose to see only timesheets that were submitted only by the employee,   
not submitted by the employee, or all timesheets. In the Employee  field, make a 
selection.

If 
supervisor 
approved

You can choose to see only timesheets that were approved by the supervisor,   not 
approved by the supervisor, or all timesheets. In the Supervisor   field, make a 
selection. 

If 
accounting 
approved

You can choose to see only timesheets that were approved by accounting,   not 
approved by accounting, or all timesheets. In the Accounting   field, make a 
selection. 

If project 
manager 
approved

You can choose to see only timesheets that were approved by the project manager,
   not approved by the project manager, or all timesheets. In the Project Manager  
field, make a selection.

 3. Click the date for the timesheet   you want to change, and click Edit.
 4. If needed, add optional columns to see additional information.

Click the    (Customize), click the columns you want to add, and click OK.

Column Description
Direct time table at top of window:

PM (Project manager 
approved)

Indicates if a project manager approved the time. The column is titled   
PM for Project Manager Approved.

Employee type View the employee type.

Hours Detail table:

Manager notes View or change manager notes.

Rejected by View who rejected the timesheet.

Rejected date/time View the date and time the timesheet was rejected.

Project manager 
approved by

View the project manager who approved the timesheet.

Project manager 
approved date/time

View the date and time that the project manager approved the 
timesheet.

Start/stop time View the starting and ending time for time counted with the timer.
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Column Description
Billed View if the time has been billed.

Paid View if payroll has been processed for the employee.

 5. Make   changes as needed:

To change Do this
The project, 
phase, or 
activity

Either begin to type it or click   .
Multi-company only. If you select a project that is not linked to your company, 
Ajera creates intercompany entries. 

Hours for direct 
time

In the table at the top of the window, change the hours in the applicable   cell.

Hours for 
overhead

In the table in the middle of the window, change the hours for the applicable   cell.

Overtime or 
other premium 
time

 1. In the table at the top   or in the middle of the window, click the applicable 
cell.

 2. In the Hours Detail table,   change the overtime or premium time hours.
 3. In the Hours Detail table,   change the regular hours, if needed, so the 

total number of hours you   worked for that project/phase/activity on that 
day is correct.
A plus sign +   appears in a cell to indicate that the cell total contains 
different types   of hours in addition to regular time.

Notes  1. In the table at the top   or in the middle of the window, click the applicable 
cell.

 2. In the Hours Detail table,   enter notes in the Notes column for the   hours 
you want to annotate.
A note symbol  appears in the cell in table at the top of   the window if 
notes are attached.

 6. To delete a row in the table   at the top or middle of the window, do one of the following:
 l Click the row, click Delete, and click Yes to delete it.
 l Right-click the row, click Delete row,   and click Yes to delete it. 

 7. To clear the contents of a timesheet cell, right-click the cell, click Clear contents, and click Yes to 
clear the contents of the cell.

 8. Do one of the following:
 l If you are not ready   to submit the timesheet, click Close.   You can open it later. Ajera saves it 

under its week ending date.
 l If you are finished   with the timesheet and want to send it for approval, click Submit. Click Close.
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Unsubmitting a timesheet
If you unsubmit a timesheet, you can make changes to it if it has not   yet been approved. However, you cannot 
change any time that has already   been billed or paid.

To unsubmit a timesheet

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the My   Timesheets tab.
 3. To see if a timesheet has   been submitted, click    (Customize), select the Submitted check   box, 

and click OK.
 4. Click the timesheet you   want to unsubmit.
 5. Click the Unsubmit   button.
 6. Click Close.

Deleting a timesheet
You cannot delete a timesheet if any of the time on it has already been   billed or paid.

To delete a timesheet

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the My   Timesheets tab.
 3. Click the date for the timesheet   you want to delete. The dates in the list are week ending dates. 
 4. Click the Delete   button. 
 5. Click Yes   to delete the timesheet.
 6. Click Close.

Activities

About activities
Activities are the type of work or expense charged to a project. You can specify cost and billing rate by 
activity. Reports and client invoices can be summarized or subtotaled by activity. For example, Drafting is a 
labor activity and Mileage is an expense activity.
Set up an activity to identify work and expenses items for establishing billing rates,   invoicing, and reporting. 
While setting up activities, you can create   and edit activity descriptions, cost and billing rates, accounts, and   
so on.
Ajera separates all costing and revenue activities into these three   categories:

 l Labor, which is related   to time entry
 l Consultants, which are separated   from general expenses because in architecture and engineering 

(AE) firms, consultants are often managed   separately from contract, budget, and billing perspectives
 l Expenses, which include   both expenses paid through vendor invoices and those expenses that have   

no out-of-pocket costs (in-house expenses)
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Changing an activity

To change an activity

 1. From the  >  Setup   menu, click General > Activities. 
 2. View activities in the list window differently,   if needed.
 3. Click the activity you want to change, and click Edit. 
 4. On the General   tab, change information as needed.

 l You can only change the nonbillable utilization type   if you chose an activity type of labor.
 l When the Unit based check box is selected, the cost or billing of   this activity is based on a unit 

rate. You can then change the unit description,   unit cost rate, or unit billing rate. You can also 
later change the unit   billing rate for a project by entering a different billing rate for this   activity on 
the applicable rate table. You can also change the rate on   the client invoice. 

Field Description
Description The name of the activity.

Activity 
type

The applicable category for the activity: Labor, Expense, or Consultant

Note: After   you use an activity, you can no longer change the activity 
type.

Non-
billable 
utilization 
type

For an activity type of Labor only. This field contains the utilization type1.
When an employee enters time for a labor activity to a billable project   or phase, 
Ajera reports it as Billable on the Employee Utilization report.
When an employee enters time for a labor activity to a nonbillable project   or 
phase, use this field to select the way you want to report that time   on the 
Employee Utilization report. If you do not make a selection, hours   entered to 
nonbillable phases for this activity do not appear in the utilization   columns on the 
Employee Utilization report but are reflected in the report   totals. 

Apply 
sales tax

Select the check box to apply sales tax to billing amounts for the activity.

Note: The Apply   Sales Tax option must be selected in  > Setup > 
Company > Preferences > Billing   tab, and sales tax must be set 
up for the project or phase associated   with the activity. Ajera 
applies sales tax to any labor or expense activities   for which you 
select this option.

Allow entry 
on expense 
reports

When the activity type is Expense, select this check box if you want   employees 
to be able to enter expenses for this activity on expense reports.

Allow entry 
on 
purchase 
orders

Not available in ajeraCore or ajeraCore + add-ons
When the activity type is Expense or Consultant, select this check box if you 
want employees to be able to enter purchase orders for this activity. 

1Defines employee time as direct or indirect, such as direct, sick, vacation, or marketing.
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 5. To base the cost or billing   of this activity on a unit rate, select the Unit   based check box and 
complete the following fields. 

Field Description
Unit 
description

The description for the units - It appears on reports and invoices. 
Enter the unit description in singular form. For example, mile or copy.     On reports 
and invoices, Ajera automatically capitalizes the first letter of the first word and 
makes the last word plural. It does not change the case elsewhere.  For example, if 
you enter ongoing CAD service, it appears as Ongoing CAD services.

Unit cost 
rate

The unit cost rate that you want to appear when using the activity  

Unit billing 
rate

The unit billing rate that you want to appear when using this activity.   To later change 
this rate for a project, you can enter a different billing   rate on the applicable rate table 
or on the client invoice.

 6. On the Cost/Expense   Accounts tab, change information as needed.
The fields on the Cost/Expense Accounts   tab are only available for nonlabor activities. Labor costs 
are distributed   to your expense accounts based on your company preferences as defined   during your 
initial setup of Ajera. 

Field Description
Billable The account you want to use when entering this activity to a billable   project or 

phase

Nonbillable The account you want to use when entering this activity to a project   or phase with a 
billing type of Nonbillable

Marketing The account you want to use when entering this activity to a project   or phase with a 
billing type of Marketing

Overhead 
expense

The account you want to use when entering this activity to a project   or phase with a 
billing type of Overhead
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Field Description
In-house 
credit: 
account

When you enter in-house expenses   to move cost from general expenses to direct 
cost, you can specify the   general account you want to credit.
Select the expense account you want to use for the credit entry when   the amount 
associated with this activity is moved from an overhead expense   to a project cost. 

Note: If you   do not want Ajera to create financial accounting entries when 
entering   in-house expenses, leave this field blank. For example, 
you may want to   enter some expenses to bill a client, but you do 
not want to redistribute   cost for financial reporting.

In-house 
credit: 
department

unavailable in ajeraCore unless you have the Departments add-on
Only applies if you are using departments - This field contains the department   you 
want to use for the credit entry when the amount associated with this   activity is 
moved from an overhead expense to a project cost. 

Note: Ajera   automatically enters the first department listed on the 
Department List   window (  > Setup > Company > Financials > 
Departments). Change   it, as needed.

 7. Click the Attachments   tab, and change the attachment information,   as needed. 

 8. Click   the Notes tab to change notes   about the activity.
 9. Click Save.

 10. Click Close.

Copying an activity

To copy an activity

 1. From the  >  Setup   menu, click General > Activities. 
 2. View activities in the list window differently,   if needed.
 3. Click the activity you want   to copy, and click Copy.   
 4. Change the description and   any other activity information   as needed.
 5. Click Save.   The activity appears below the current row. To move it, click the row and  click  or . 
 6. Click Close.

Deleting an activity
You cannot delete an activity   if it is currently being used. However, you can make   it inactive.

To delete an activity

 1. From the  >  Setup   menu, click General > Activities. 
 2. View activities in the list window differently   if needed.
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 3. Click the activity you want   to delete, and click the Delete button.   
 4. Click Yes   to delete it.
 5. Click Close.

Inactivating an activity
If you inactivate an activity, it cannot be used; however, it remains   in the database and continues to appear on 
reports. 

 1. From the  >  Setup   menu, click General > Activities. 
 2. Click the activity you want   to inactivate, and Edit  . 
 3. In the Status field, select Inactive.
 4. Click   Save.
 5. Click Close.

Overhead groups

About overhead groups
You can use overhead groups to set up specific overhead   project, phase, activity, or account information so 
that it defaults onto employee   timesheets, simplifying timesheet entry. If you want to track indirect time1 on 
employee utilization2 time reports, you need to use overhead groups.
When you set up an overhead group, you create overhead group items.   These items appear in the Overhead 
area of an employee's timesheet. When   you create an overhead group item, you link a pay to it. The pay 
determines   the way Ajera reports the time on an employee's paycheck stub (or if using   a payroll service, in the 
payroll file). 
You choose which items appear on an employee's timesheet by assigning   the employee to an overhead 
group. 

Changing an overhead group
When an employee enters time and is part of an overhead group, Ajera   uses that overhead group to determine 
the department (unavailable in ajeraCore unless you have the Departments add-on), associated 
financial   account, and employee utilization.

To change an overhead group

 1. From the  >  Setup   menu, click General > Overhead Groups. 
 2. Click the overhead group you want to change, and click Edit.
 3. On the Detail   tab, each row of the table contains an overhead group item. Overhead group   items 

appear in the Overhead area on employee timesheets. Change them   as needed.

1The dollar amount of wages and salaries not charged to projects, including wages of administrative, 
technical, and professional   employees that are not billed to projects. It also includes all paid leave.
2An industry standard used to help track and manage time on an individual level. With Ajera, you can track 
employee productivity using the Employee Utilization report. The report contains each employee's billable and 
nonbillable hours and cost. Information appears based on how you classify your labor activities into billable 
and nonbillable categories.
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Field Description
Status Options are:

 l Active: the overhead group is available for use.
 l Inactive: the overhead group cannot be used; however, it remains in   the 

database and continues to appear on reports.

Description The name of the overhead item (such as Vacation, Sick, or Administration)   as it 
appears on employee timesheets.

Project, 
phase, 
activity

To track overhead time to an overhead project, enter the project, phase,   and 
activity. This information can be used for  employee utilization1  reporting. 
Otherwise, you can leave them blank.

Note: If you are tracking in and out times in a timesheet cell,  you must 
select an overhead project. You cannot track in and out times with 
an account selected in the Account field.

Account Only available if the Project column is blank.
The account you want to use for tracking the cost associated with this   overhead 
time.

Pay Select a pay to indicate the way you want to report time on the paycheck   stub (or if 
using a payroll service, in the payroll file). For example,   if you select the Vacation 
pay, Ajera reports all time entered to this   overhead group item as Vacation on the 
paycheck stub.
Do not select an accrual pay.
If you select the Regular pay or do not select a pay, Ajera reports   the time on the 
paycheck stub as Regular. 

Note: Time employees enter in the table for direct time on the timesheet 
is   always reflected as Regular or Overtime pay on the paycheck 
stub (or if   using a payroll service, in the payroll file).

unavailable in ajeraCore unless you have the Payroll add-on   -  If you are 
processing payroll in-house, Ajera   uses the expense account from the pay (  > 
Setup > Company > Payroll > Pays)   when time is entered.

 4. 
Click the Attachments   tab, and change the attachment information,   as needed. 
   

 5. Click   the Notes tab to change any notes   for the overhead group.
 6. Click Save.
 7. Click Close.

1An industry standard used to help track and manage time on an individual level. With Ajera, you can track 
employee productivity using the Employee Utilization report. The report contains each employee's billable and 
nonbillable hours and cost. Information appears based on how you classify your labor activities into billable 
and nonbillable categories.

105 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

Entering and managing timesheets



Copying an overhead group

To copy an overhead group

 1. From the  >  Setup   menu, click General > Overhead Groups. 
 2. Click the overhead group   you want to copy, and click Copy. 
 3. Change the description and   overhead group information as needed.
 4. Click Save.
 5. Click Close.

Deleting an overhead group

To delete an overhead group

 1. From the  >  Setup   menu, click General > Overhead Groups. 
 2. Click the overhead group   you want to delete, and click the Delete   button.
 3. Click Yes   to delete it.
 4. Click Close.

Inactivating an overhead group
If you inactivate an overhead group, it cannot be used; however, it   remains in the database and continues to 
appear on reports. 

 1. From the  >  Setup   menu, click General > Overhead Groups. 
 2. Click the overhead group   you want to inactivate, and click Edit .
 3. In the Status field for   each overhead group item you want to make inactive, select Inactive.
 4. Click Save.
 5. Click Close.

Ajera Mobile Timesheets

What are Ajera Mobile Timesheets?
Ajera Mobile Timesheets combine the power of Ajera's timesheets with the mobility of your phone or tablet to 
record your time and submit accurate timesheets - anytime, anywhere.
All you need to use Ajera Mobile Timesheets is a supported mobile device and a web connection to access 
your Ajera server.

Setting up Ajera Mobile Timesheets
Contact your IT resources to set up and configure your network, firewall, and Internet technology.

Note: Because of the variations in firewalls, servers, network access, and Internet providers, 
Deltek cannot provide guidance on how you should configure your office.

Refer to the Ajera Installation Guide and Ajera Hardware/Software Requirements sheet for specific 
information on setting up Ajera for external web access.
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Learn how to:
 n Enter project or overhead time
 n Change time entries
 n Delete time entries
 n Correct rejected time
 n Submit or unsubmit timesheets

Icons

 moves backward to previous timesheets

 moves forward to future timesheets

 searches for projects by description, project ID, or client name

 displays available hour types

 indicates overtime on a time entry

 indicates notes on a time entry

 indicates rejected time

 indicates a locked timesheet (submitted, approved, billed, or paid)

 displays time entered; drop-down arrow displays on-screen keyboard

Entering time...
For a project
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 1. Use   (previous) and  (next) at the top of the screen to navigate to the relevant timesheet. 
Do not use your device's back and forth buttons; they navigate only through web pages not through 
timesheets.

 2. To switch to a specific day, tap on it and then tap                   Add.

 3. Enter a project description, project ID, or client name and tap    Search. 

Note: You can search on partial entries of project descriptions, IDs, or names. Searching 
requires an Internet connection.

 4. Choose the project, phase, and activity that you worked on. Your setup determines what displays.

 5.  Choose the appropriate hour type. 
You can toggle between regular and overtime hours. If you have more than two hour types, a list 
appears.

 6. Enter the time you worked on the project, phase, or activity, using the onscreen keypad or your device 
keyboard. 

 7.  Enter notes.  You can add notes to submitted, approved, or rejected timesheets. 
 8. Tap OK and then tap                   Save to save your entries.

Your mobile device holds your updates even if you lose your Internet connection. 
When your connection is restored, refresh your browser to sync your updates with your Ajera 
timesheet.

For overhead entries

 1. Use   (previous) and  (next) at the top of the screen to navigate to the relevant timesheet. 
Do not use your device's back and forth buttons; they navigate only through web pages not through 
timesheets.

 2. To switch to a specific day, tap on it and then tap                   Add.
 3. Choose one overhead entry. Only overhead groups set up for your organization appear on the list.

 4.  Choose the appropriate hour type. 
You can toggle between regular and overtime hours. If you have more than two hour types, a list 
appears.

 5. Enter the time you worked on the project, phase, or activity, using the onscreen keypad or your device 
keyboard. 

 6.  Enter notes.  You can add notes to submitted, approved, or rejected timesheets. 
 7. Tap OK and then tap                   Save to save your entries.

Your mobile device holds your updates even if you lose your Internet connection. 
When your connection is restored, refresh your browser to sync your updates with your Ajera 
timesheet.

Using a recent timesheet entry

 1. Use   (previous) and  (next) at the top of the screen to navigate to the relevant timesheet. 
Do not use your device's back and forth buttons; they navigate only through web pages not through 
timesheets.

 2. To switch to a specific day, tap on it and then tap                   Recent to see your projects from the last two 
weeks. You cannot use this option on approved timesheets.
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 3. Tap to select one or more overhead and/or project items;  appears next to your entries. 
To choose all project entries for a specific date, tap the date title bar.

 4. Tap                   Select Projects.
 5. If you chose more than one item, tap the one to which you want to add time. 

 6.  Choose the appropriate hour type. 
You can toggle between regular and overtime hours. If you have more than two hour types, a list 
appears.

 7. Enter the time you worked on the project, phase, or activity, using the onscreen keypad or your device 
keyboard. 

 8.  Enter notes.  You can add notes to submitted, approved, or rejected timesheets. 
 9. Tap OK and then tap                   Save to save your entries.

Your mobile device holds your updates even if you lose your Internet connection. 
When your connection is restored, refresh your browser to sync your updates with your Ajera 
timesheet.

Submitting or unsubmitting timesheets

To submit or unsubmit a timesheet
 1. Enter and save your time.
 2. On the timesheet window, look for icons or statuses that might prohibit you from submitting your 

timesheet. 
 3. On the main screen, tap Menu.

 l Tap Submit to send your final timesheet to your supervisor for approval.

Note: Timesheets are  locked when they are submitted, approved, billed, or paid. If your 
supervisor or accounting manager has the appropriate preferences set, they can change 
your submitted timesheet. Contact your Ajera administrator for details.

 l Tap Unsubmit to return a submitted timesheet to a draft state. Make any changes and resubmit 
for approval.

 4. Tap Home to return to the timesheet. 

Correcting rejected time
Your supervisor can reject individual hours on a timesheet and add notes indicating why the time was 
rejected.

To correct rejected time

 1. Use   (previous) and  (next) at the top of the screen to navigate to the relevant timesheet. 
Do not use your device's back and forth buttons; they navigate only through web pages not through 
timesheets.

 2. Tap rejected dates highlighted in red. 

 3. To correct a  rejected time entry, tap the entry.
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 4. Review the Rejection Notes to determine what you should fix. If no notes exist, contact your 
supervisor for details.

 5. Verify that you have chosen the correct project, phase, activity, and hour type. 
 6. Correct your time entry.

Note
:

You may need to delete the time in the cell or delete the row then reenter the time on a 
new row for the submit button to become available. 

 7. Your mobile device holds your updates even if you lose your Internet connection. 
When your connection is restored, refresh your browser to sync your updates with your Ajera 
timesheet.

 8. Resubmit your timesheet.

Changing timesheets
 l Entering time  
 l Deleting time entries
 l Correcting rejected time
 l Unsubmitting timesheets

Deleting time entries

To delete time entries

 1. Use   (previous) and  (next) to navigate to the relevant timesheet. 
Do not use your device's back and forth buttons; they navigate only through web pages not through 
timesheets.

 2. Tap the time entry you wish to delete.
You cannot delete  locked time entries (such as submitted, approved, billed, or paid).

 3. Tap Delete at the bottom of the screen. That time entry disappears.
 4. Your mobile device holds your updates even if you lose your Internet connection. 

When your connection is restored, refresh your browser to sync your updates with your Ajera 
timesheet.

FAQs
What version of Ajera am I using?
Go to the Ajera Mobile Timesheets main menu, where you'll see the words Ajera Mobile Timesheets, followed 
by your current Ajera version.

Connectivity
Why can't I access my timesheet on my mobile device?
Turn off private browsing on your device when working on your timesheet.

What happens if I lose my Internet connection?
Your mobile device holds your updates even if you lose your Internet connection. 
When your connection is restored, refresh your browser to sync your updates with your Ajera timesheet.
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How can I sync my mobile device with Ajera?
Refresh your browser to sync project updates, approvals, rejections, notes, or time entries.

Why are my timesheets slow to respond?
Ajera Mobile Timesheets is only as quick as the strength of your Internet signal. Connecting to a large Ajera 
database may also slow the responsiveness of your timesheets. Whenever possible, connect to the 
timesheets using a Wi-Fi signal.

How do Ajera Mobile Timesheets affect my data charges?
Because of the variations in Internet providers, Deltek cannot provide guidance on your specific data plans. 
Contact your device provider with your questions. Whenever possible, connect to your timesheets using a Wi-
Fi signal.

Navigation
How do I move back and forth through my timesheet?

Use   (previous) and  (next) at the top of the screen to navigate to the relevant timesheet. 
Do not use your device's back and forth buttons; they navigate only through web pages not through 
timesheets.

Projects
Why do I have to search for a project?
To minimize the impact to your data plan and performance, no project information is stored on the mobile 
device. You must connect to Ajera to find your project information.
You cannot search for projects if you lose your connection. Recent time entries do appear.

How far back can I see projects on the Recent list?
Recent entries include the last two full timesheet weeks plus the current week's entries.

Timesheets
How do I track start and stop times?
You must connect to Ajera to track start and stop times for periods like breaks, lunch time, or overtime. You 
cannot track start and stop times with Ajera Mobile Timesheets on your mobile device.

How can I access today's timesheet quickly?
Refresh your browser to go to today's time entries. 

Why are some days shaded on the timesheet?
Your Ajera administrator can set which days are accessible on your timesheet. You cannot add time to a 
shaded day.

Why do some projects or phases require a timesheet note?
Ajera can be set up to require notes for all new projects. Contact your Ajera administrator for details.

Can I change a submitted, billed, or paid timesheet?
You can unsubmit (Menu > Unsubmit) to return a submitted timesheet to a draft state. You cannot unsubmit 
an approved, billed, or paid timesheet.

Can I add notes to submitted timesheets?
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To make any changes to a submitted timesheet, you must be set up with the appropriate preferences Contact 
your Ajera administrator for details.

For managers and supervisors

Approving a timesheet
After a timesheet is approved, supervisors or accounting managers can   no longer change it, unless they first 
unapprove it. 
You can also choose to have project   managers approve time for a project. 
Learning Resource: Time Entry Functional Guide

To approve a timesheet

 1. From the  >  Manage   menu, click Time & Expense.
 2. Click the Timesheets   by Employee tab.
 3. In the table, you can choose   to:

 l View the sort order or appearance of columns differently.
 l Add optional columns to see additional information. Click     (Customize), select the columns 

you want to add, and click OK.

Column Description
Company Multi-company only. The company the employee works for

First name First name of the employee

Middle name Middle name of the employee

Last name Last name of the employee

Submitted Indicates if the timesheet was submitted.

Time rejected Indicates if any time on the timesheet was rejected.

Supervisor approved Indicates if the supervisor approved the timesheet.

Project manager 
approved

Indicates if the project manager approved the timesheet.

Accounting approved Indicates if the accounting manager approved the timesheet.

Target billable % Lists the targeted billable percent, as set up on the General tab of   the 
Employee window.

Actual billable % Lists the actual percent billable.

Paid Indicates if payroll has been processed for the employee.

 l Change which timesheets appear in the table. Click   (Change View) and enter information as 
follows:
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Column Description
For a certain period In the Date Range field, click the date or time period you want 

to view   timesheets for. To choose a range of dates, click 
Select   Dates and then enter the beginning and ending dates in 
the fields   that appear to the right.

Company Multi-company only. Select to view timesheets only for the 
selected company. 

Show only my employees This option only appears if you are set up as an accounting 
manager, who by default sees all employees. 
Select the Show only my employees   check box to see only 
your own direct reports instead of a list of all employees.

Show multilevel employees This option only appears if you are set up as a supervisor, not 
as an accounting manager, and your company preferences are 
set up to allow multilevel timesheet approval (  > Setup > 
Company > Preferences > Time & Expense Entry tab ).
Select the Show multilevel employees check box to see 
employees who report directly to you and those employees who 
report to supervisors who report to you. 

For a specific employee In the Employee field, enter the name.

If submitted In the Submitted field, make a selection. You can choose to 
see   only timesheets that were submitted, not submitted, or all 
timesheets.

If supervisor approved In the Supervisor Approved field,  make a selection. You can 
choose to see   only timesheets that were approved by the 
supervisor, not approved, or   all timesheets. 

If accounting approved In the Accounting Approved field, make a selection. You can 
choose to see   only timesheets that were approved by 
accounting, not approved, or all   timesheets. 

 4. Click the timesheet you   want to approve. If you want to approve it without looking at it, click   
Approve. Otherwise,   click Edit and follow   the remainder of these instructions.

 5. If needed, add optional columns to see additional information.
Click         (Customize), select the columns you want to add, and click OK.

Column Description
Direct time table at top   of window

P (Project manager 
approved)

Indicates if a project manager approved the time. The column on the   
window is titled P for Project Manager Approved.

Employee type View the employee type.
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Column Description
Hours Detail table

Manager notes View or change manager notes.

Rejected by View who rejected the timesheet.

Rejected date/time View the date and time the timesheet was rejected.

Project manager 
approved by

View the project manager who approved the timesheet.

Project manager 
approved date/time

View the date and time that the project manager approved the 
timesheet.

Start/stop time View the starting and ending time for time counted with the timer.

Billed View if the time has been billed.

 6. If you do not want to approve   certain hours on the timesheet, do one of the following:
 l Change the hours for your employee, if allowed through   your company preference settings.
 l Reject the time, as follows,   so the employee can review and change the timesheet.

To reject time 
for

Do this

A row Click the first cell on the left of the row, and then right-click and click  Reject 
Row.

A cell Click the cell, and then right-click and click Reject.

The hours for rejected time appear in   bold type to indicate that you rejected   them. When you reject 
time, Ajera enters it on the client invoice with   a status of Hold.
If you reject time for a row or cell by mistake,   simply right-click and click the Reject   option again. 

Note: If you reject any hours on a timesheet, you cannot approve the timesheet.   It is 
automatically unapproved and unsubmitted. 

The time can be corrected in one of the following ways: 

To correct time as Do this
The employee Delete the rejected hours, click Save,   make changes as needed   and re-

enter the hours, and submit the timesheet again.

The supervisor/ 
accounting manager

If your company preferences   for time and expense entry are set up to 
permit it, make   changes as needed. 
You can always submit or unsubmit a timesheet by right-clicking a 
timesheet   on the Timesheet List window and clicking Submit.

 7. To   enter any manager notes or comments for a cell, do the following:
 l If the Manager Notes column does not appear in the Hours   Detail table, click   (Customize), 

select the Manager notes   check box, and click OK.
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 l Click the cell in the table at the top or middle of   the window that you want to enter notes for.
 l In the Manager Notes cell in the Hours Detail table,   enter your notes.

 8. Do one of the following:

To Do this
Approve as a supervisor Select the Supervisor Approved   check box, and click  

Close. 

Approve as an accounting 
manager

Select the Accounting Approved   check box, and click  
Close.

Not approve the timesheet Click  Close.

Unapproving a timesheet
If you have already approved a timesheet but no longer want it approved,   you can unapprove it. The 
supervisor/accounting manager can make changes   to the timesheet if  is set up to allow it. Otherwise, the   
employee must review and change the timesheet. However, any time that   has already been billed or paid can 
no longer be changed.

To unapprove a timesheet

 1. From the  >  Manage   menu, click Time & Expense. 
 2. Click the Timesheets   by Employee tab.
 3. Unapprove the timesheet   as follows:

To Do this
Not see the timesheet 
first

 1. Click the Unapprove   button.
 2. Clear the Supervisor   approved or Accounting approved   

check box. Click OK.

See the timesheet first  1. Click the timesheet you   want to unapprove and click the Edit   
button.

 2. Clear the Supervisor   approved or Accounting approved   
check box.

 3. Click Close.

 4. Click Close.

Rejecting time
If you do not want to approve certain hours on the timesheet, do one   of the following:

 l Change the hours for your   employee, if allowed through your company preference settings.
 l Reject the time, as follows,   so the employee can review and change the timesheet.
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To reject time 
for

Do this

A row Click the first cell on the left of the row, and then right-click and click  Reject 
Row.

A cell Click the cell, and then right-click and click Reject.

The hours for rejected time appear in   bold to indicate that you rejected   them. If you reject time for a 
row or cell by mistake, right-click   and click Reject again. 

Note: If you reject any hours on a timesheet, you cannot approve the timesheet.   Ajera 
automatically unapproves and unsubmits it. 

The time can be corrected in one of the following   ways: 

To correct tie as Do this
The employee Delete the rejected hours, click Save,   make changes as needed   and re-enter 

the hours, and submit the timesheet again.

The supervisor/ 
accounting manager

If your company preferences   for time and expense entry are set up to permit 
it, make   changes as needed. 
You can always submit or unsubmit a timesheet by right-clicking a timesheet
   on the Timesheet List window and clicking Submit.

Approving time as a project manager

To approve time as a project manager
 1. View   the time for the project.
 2. Click the row you want to   approve, and click Approve.

Note: To unapprove time that you already approved,   click Unapprove.

 3. To reject time, click Reject. If you reject time by mistake, right-click the row and click Reject. 
When you reject time, the timesheet is marked   as Time Rejected on the employee's timesheet list. 
The employee must correct   the time and submit it for approval again.

Note: To reinstate rejected time, click Unreject. The timesheet returns to a state of waiting for 
approval.

 4. Click Close.

Viewing an employee timesheet

To view an employee timesheet
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 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the Timesheets   by Employee tab.
 3. In the table, you can choose   to:

 l Add optional columns to see additional information:

Company Multi-company only. The company the employee works for

First name First name of the employee

Middle name Middle name of the employee

Last name Last name of the employee

Submitted Indicates if the timesheet was submitted

Time rejected Indicates if any time on the timesheet was rejected

Supervisor approved Indicates if the supervisor approved the timesheet

Project manager approved Indicates if the project manager approved the timesheet

Accounting approved Indicates if the accounting manager approved the timesheet

Target billable % Lists the targeted billable percent:
Billable percent = (billable hours / hours on timesheet) x 100.00

Actual billable % Lists the actual percent billable:
Billable percent = (billable hours / hours on timesheet) x 100.00

Paid Indicates if client has paid for the time

 l Click     (Customize), select the columns you want to add, and click OK.
 l View the sort order   or appearance of columns differently. 
 l Change which timesheets appear in the table:

Click   (Change View) and enter information as follows:

To view timesheets Do this
For a certain period In the Date Range field, click the date or time period you want to 

view   timesheets for. To choose a range of dates, click Select   
Dates and then enter the beginning and ending dates in the fields   
that appear to the right.

Company Multi-company only. Select to view timesheets only for a specific 
company. 

Show only my employees This option only appears if you are set up as an accounting 
manager, who by default sees all employees. 
Select the Show only my employees   check box to see only 
your own direct reports instead of a list of all employees.

Show multilevel employees This option only appears if you are set up as a supervisor, not as 
an accounting manager, and your company preferences are set 
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To view timesheets Do this

 > Setup > Company > Preferences > Time & Expense Entry 
tab ).
Select the Show multilevel employees check box to see 
employees who report directly to you and those employees who 
report to supervisors who report to you. 

For a specific employee In the Employee field, begin typing the name or click   .

If submitted In the Submitted field, click the arrow  and make a selection. 
You can choose to see   only timesheets that were submitted, not 
submitted, or all timesheets.

If supervisor approved In the Supervisor Approved field, click the arrow  and make a 
selection. You can choose to see   only timesheets that were 
approved by the supervisor, not approved, or   all timesheets. 

If accounting approved In the Accounting Approved field, click the arrow  and make a 
selection. You can choose to see   only timesheets that were 
approved by accounting, not approved, or all   timesheets. 

 

Note: Accounting managers can view timesheets for all employees. A supervisor   can view 
timesheets for an employee when selected as the supervisor for   the employee in Setup > 
Employees.

 4. Click the timesheet you   want to view, and click the Edit   button.
 5. If needed, add optional columns to see additional information:

Click     (Customize), select the columns you want to add, and click OK.

Column Description
Direct time table at top   of window:

P (Project manager 
approved)

Indicates if a project manager approved the time. The column on the   
window is titled P for Project Manager Approved.

Employee type View the employee type

Hours Detail table:

Manager notes View or change manager notes

Rejected by View who rejected the timesheet

Rejected date/time View the date and time the timesheet was rejected

Project manager 
approved by

View the project manager who approved the timesheet

Project manager 
approved date/time

View the date and time that the project manager approved the timesheet
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Column Description
Start/stop time View the starting and ending time for time counted with the timer

Billed View if the time has been billed

 6. Click Close.

Viewing project time

To view project time

 1. From the  >  Manage       menu, click Time & Expense.      
 2. Click the Time      by Project tab.

Note: This tab is available if the Principal, Project manager, or Accounting manager check 
box is selected in  > Setup > Employees > General tab > Manager Type.

 3. In the table, you can choose      to:
 l Add optional columns to see additional information:

Click         (Customize), select the columns you want to add, and click OK.

Column Description
Company Multi-company only. Displays the company responsible for the 

project

Phase Displays the phases of projects

Submitted Indicates if the timesheet was submitted

Time rejected Indicates if any time on the timesheet was rejected

Supervisor approved Indicates if the supervisor approved the timesheet

Accounting approved Indicates if the accounting manager approved the timesheet

Project manager 
approved

Indicates if the project manager approved the timesheet

 l View the sort order      or appearance of columns differently.
 l Change which time appears in the table:

Click         (Change View), enter information as follows, and click OK:

To view 
timesheets

Do this

For a 
certain 
period

In the Date Range field, click the date or time period you want to view           timesheets 
for. To choose a range of dates, click Select           Dates and then enter the beginning 
and ending dates in the fields          that appear to the right.

For a 
certain 

You can choose to see only timesheets that have a project status of Marketing, 
Preliminary, Active, Hold, Work hold, Billing hold, or Closed. 
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To view 
timesheets

Do this

project 
status

In the Project Status area, select as many check boxes as needed.

If submitted In the Submitted field, click the arrow and make a selection. You can           choose to see 
only timesheets that were submitted, not submitted, or all          timesheets.

If 
supervisor 
approved

In the Supervisor Approved field, click the arrow and make a selection.           You can 
choose to see only timesheets that were approved by the supervisor,          not approved, 
or all timesheets. 

If 
accounting 
approved

In the Accounting Approved field, click the arrow and make a selection.           You can 
choose to see only timesheets that were approved by accounting,          not approved, or 
all timesheets. 

If project 
manager 
approved

In the Project Manager Approved field, click the arrow and make a selection.           You 
can choose to see only timesheets that were approved by the project          manager, not 
approved, or all timesheets. 

For a 
specific 
company

Multi-company only. Displays the timesheets of the selected company.

 4. To see detailed time by      employee for the project, click the plus sign  next to the name of the project. 
 5. To see more detail, hours      by date for the employee, click the plus sign  next to the name of the 

employee.
 6. To see the timesheet, double-click      the timesheet date.
 7. If you are a project manager and want to add notes to a timesheet cell, click   (Customize), select 

the Manager notes check box, and click OK. Then, select the timesheet cell, and enter your notes in 
the Manager Notes field in the Hours Detail table.

 8. Close any detailed information      by clicking the minus sign  next to it.
 9. Click Close.
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Entering and managing expense reports

About expense reports
The following is a typical sequence of events for processing expenses:

 1. An employee enters an expense   report.
 2. When finished entering all   expenses, the employee submits the expense report.

 3. If approvals are required (  > Setup > Company > Preferences > Time & Expense Entry tab), the 
supervisor and/or accounting   manager reviews the expense report and does one of the following:

 l Approves the expense report.
 l Rejects an item on the expense report, entering comments   about the rejected item. The 

employee then corrects   the rejected expense and resubmits the expense report. 
 4. After an expense report is approved (if approvals are required) or submitted (if no approvals are 

required), Ajera processes the expense report, which creates a vendor invoice for the non-credit card 
transactions and bank entries for the credit card transactions. 

Depending on the options selected on the  > Setup > Company > Preferences > Time & Expense Entry tab, 
the supervisor and accounting manager may have access   to change an employee’s expense report. After you 
pay the vendor invoice for the expense report, however, no changes can be made.
Learning Resources: Expense Entry Functional Guide

Working with expense reports
The following events occur when you process expenses at your company:

When this 
occurs

This happens

Save Ajera saves the expense report that you entered.

Submit The employee finished entering the expense report and is ready for the   
supervisor/accounting manager to review it.
Now, to make any changes to the expense report, the employee must first   unsubmit it. 
However, the supervisor or accounting manager can change   a submitted expense 
report if their company   preferences for time and expense entry are set up to permit it.   
Ajera processes the expense report unless company   preferences for time and 
expense entry require supervisor or accounting   approvals before processing.

Approve The supervisor/accounting manager approves the expense report submitted   by the 
employee. The expense report appears as   Approved on the expense report list. 
Ajera processes the expense report after the supervisor, accounting   manager, or both 
approve the expense report (depending on approval requirements   set up in company 
preferences   for time and expense entry).

Reject The supervisor/accounting manager rejects an item in the expense report.    
The expense report appears as Expense Rejected on the expense report   list. The 
employee must correct and submit the   expense report again.   
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When this 
occurs

This happens

Unsubmit The employee decides the expense report is not ready for approval after   all.
An employee can change the expense report if it has not yet been approved   or 
processed.

Unapprove A supervisor/accounting manager decides not to approve   the expense report after all.  
You can unapprove an expense report only if:

 l It was not yet approved   by all the required approvers (as set up in  > Setup 
> Company > Preferences > Time   & Expense Entry tab). 

Note: If you required only Supervisor or Accounting approval, and the 
expense   report is approved, you cannot unapprove it.

 l It has not yet been processed.   
About   changing a processed expense report 

Delete You cannot delete an expense report after it is submitted.

Processing Ajera creates a vendor invoice for the non-credit card entries, reflects the credit card 
entries on   the bank register, and makes entries available in client invoices. It   also 
reflects the changes on reports and financials.

Note: Ajera bases the accounting date on the transaction date.

When Ajera processes the expense report depends on how your approvals   are set up 
in company preferences   for time and expense entry:

 l If you do not require any   approvals, Ajera processes the expense report when 
the employee submits   it.

 l If you require only the   supervisor or accounting to approve the expense report, 
Ajera processes   it after that approval is made.

 l If you require both supervisor   and accounting approvals, Ajera processes the 
expense report only after   both the supervisor and accounting manager approve 
it.

After Ajera processes the expense report, you cannot unapprove it.
If you use multi-company, Ajera makes entries based on the employee's company, 
transaction type, and payment method. For more information, see About expense 
reports with multi-company.
About changing a processed   expense report

About expense reports with multi-company
About multi-company
To keep financial information separate, the setup of each employee, project, and bank account and credit card 
is linked to a company. When you enter an expense report, Ajera associates each transaction to its 
corresponding employee, project, or credit card.
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Ajera associates this transaction type With the company linked to the
Project-related Project

Nonproject-related and advances Employee

Personal expenses Credit card

As you enter expenses, Ajera creates intercompany entries when the companies involved are different.

Ajera creates 
intercompany entries for 

When this happens

Credit card-related 
transactions

Credit card company and transaction company are different and the 
expense is not a personal expense.

Noncredit card-related 
transactions

Employee company and transaction company are different.

Credit cards assigned to employees belong to the same company associated with the employee. For 
expenses other than personal expenses, Ajera creates intercompany entries if the credit card company and 
the employee company are different. Be sure to reconcile your intercompany accounts regularly.

Example
An employee works for Company 1 and uses the company credit card to charge an expense to a project that 
belongs to Company 2. The employee makes another expense to the project, this time paying with cash. 
In the expense report:

Ajera associates this With this
Employee Company 1

Credit card Company 1

Project Company 2

Credit card, project-related transaction Company 2

Noncredit card, project-related transaction Company 2

As a result:

Ajera creates these entries For this 
Employee Receivables/Accounts Payable and Due From Company 1 (employee company)

Credit Card Payable and Expense and Due From Company 1 (credit card company) 

Work-in-progress, Expense, and Due To Company 2 (project company) 

Entering an expense report
Learning Resources: Expense Entry Functional Guide
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To enter an expense report

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the My   Expenses tab.
 3. Click the New   button. 
 4. In the beginning and ending   date fields, enter the first and last date of expenses you are including   on 

this report. Ajera uses the ending date as the date of the vendor invoice   that it produces for this 
expense report. 

 5. Click OK.   
 6. Your name appears in the Employee   field. 
 7. Type a short description   of the expenses on this report. To enter a more lengthy description, enter 

your notes in the Notes field.
 8. Review the report dates   above the table to be sure they are correct, and change them as needed. 
 9. If you received an advance   payment for the expenses you are reporting on this expense report, enter   

the amount in the Advance Amount field. Ajera uses the expense report ending date as the date of the 
advance transaction on the vendor invoice. 

Example
: 

Your company issues you an employee advance of $500 for a weeklong conference. 
On your daily expense report, you enter the portion of the $500 advance spent that day.
 

 10. If you enter an amount in   the Total Amount field, as you enter expenses, Ajera displays the remaining   
amount. If you do not enter an amount, Ajera calculates it for you as   you add expenses. 

 11. Complete one row of the   table for each expense you want to enter:

For Do this
Date Enter the date of the expense.

Project If the expense is associated with a project, enter that project. Do   not enter a project 
if this is a personal expense.

Phase If the expense is associated with a particular phase of a project, enter   that phase. 
Do not enter a phase if this is a personal expense.

Expense 
Item

Select the type of the expense.

Payee Type the name of the recipient for the payment you made.

Units If you are entering a unit expense, type the number of units.
For example, if you are entering an expense for gas mileage, you would   enter the 
number of miles you drove.

Unit Rate If you entered a unit, Ajera enters the unit rate and amount for you,   based on the type 
of expense item you selected. You can change the rate,   if needed. 
For example, if you are entering an expense for gas mileage, and your   company 
reimburses you for 48.5 cents a mile, you would enter that amount   here.
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For Do this

Note: If you   change a unit rate, and then want to change it back to the rate 
Ajera   calculated for you, click the cell, and then click the Reset   
button.

Amount Enter the amount of the expense.
If you entered units, Ajera calculates the amount for you, which you   can change.

Reference Use this field to group and summarize similar   items on the credit card bank register. 
Enter any number on more than   one expense item for those items to be grouped 
together. 
For example, on your credit card, you have separate   charges for the hotel room and 
for parking at the hotel. On your expense   report, you enter H100 as a reference 
number for both the room charges   expense item and the parking expense item. 
If the expense is to be reimbursed on a vendor   invoice, this field is for reference only 
on the expense report.

Credit 
Card

If you charged the expense on a company credit   card, select the credit card.

Note: If you want an employee to view or edit this column, select the Use 
expense reports check box on the Setup > Employees > Time & 
Expense Entry tab and select at least one credit card in the credit 
card fields.   

Personal 
Expense 

Select this check box if this is a personal   expense and you charged it on a company 
credit card. Ajera then enters   the expense as a negative distribution on the vendor 
invoice for the expense   report. 

Notes Enter any notes   about the expense report.

 12. Add these optional columns   to the table, as needed:

Column Description
Import Click the  to open a list of import items.

You can only select one item to associate with an expense report row. 

Attachments Any attachments   related to the item
You can click the attachments   icon in the table to add, change,   or open 
attachments. 

The column displays  if there are   no attachments, and  if there are 
attachments. 

Notes Any notes entered by the employee submitting the expense report.

Manager 
Notes

Any notes entered by the manager approving the expense report.

Reject by The person who rejected the item.
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 13. To import credit card items, click the Import button. 
 14. Select individual items or click Select All to add credit card items to the expense report. 
 15. If you need to delete an   expense report item that you just added, click the row of the item, and   click 

the Delete button.
 16. Do one of the following:

 l If you are finished with the expense report and want   it to be processed (or approved, if your 
company requires approvals), click   the Submit button. Once you submit   an expense report, you 
can no longer change it unless you unsubmit it.                    
You can unsubmit an expense report only if your company requires approvals.

 l If you are not ready to submit the expense report, click   Save. You can open it later.              

Changing an expense report
After you submit an expense report, you can no longer change it unless   you unsubmit it or your   
supervisor/accounting manager rejects any expenses on it. You can unsubmit an expense report only if your 
company requires approvals (  > Setup > Company > Preferences > Time & Expense Entry tab).

To change an expense report

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the My   Expenses tab. 
 3. To change the list of expense   reports you are viewing on this tab, do the following, as needed:

 l Change which expense reports appear in the table. Click       (Change View), enter the following 
information, and click OK.

To view 
expense 
reports

Do this

For a 
specific 
period

In the Date Range field, click the date or time period you want to view   expense reports 
for. To choose a range of dates, click Select   Dates and then enter the beginning and 
ending dates in the fields   that appear to the right.

For a 
specific 
status

 l Select Employee to list expense   reports you submitted, expense reports you 
did not submit, or both.

 l Select Supervisor to list expense   reports that your supervisor approved, 
expense reports not approved, or   both.

 l Select Accounting to list expense   reports that accounting approved, 
expense reports not approved, or both.

 l Add optional columns to see additional   information about the expense reports. Click    
(Customize), click the columns you want to add, and click OK.

Column Description
Submitted If selected, it indicates the employee submitted the expense report.

Advance The amount of any advance given to the employee as reported on the expense   
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Column Description
report

Credit card 
amount

The amount of all items on the expense report charged on a company credit   
card

Personal 
expense

The amount of all items charged on a credit card that the employee reported   as 
a personal expense

Reimbursement 
amount

The amount that the company will reimburse the employee. It is the amount   of 
all expenses less advances and personal expenses.

Supervisor 
approved

If selected, it indicates that the employee's supervisor approved the   expense 
report.

Accounting 
approved

If selected, it indicates that the accounting staff approved the expense   report.

Expense 
rejected

If selected, it indicates that the expense report was rejected by the   supervisor 
or accounting staff.

Processed If selected, it indicates that the expense report created general ledger entries, a 
vendor invoice for non-credit card transactions, and bank entries for credit card 
transactions.

 l View   the sort order or appearance of columns differently.
 4. Click the row of the expense   report you want to change, and click Edit. 
 5. Change the general information   about the expense report:

Field Description
Description A short description of the expense report

Notes A more lengthy description of the expense report

Report dates:

Begin date The earliest date of expenses you include on this report

End date The latest date of expenses you include on this report

Report amounts:

Advance 
amount

The amount of any advance payment you received for the expense on this   
expense report

Total amount The total amount of all expense listed on the expense report.

 6. Add, delete, or change expense   report items, as needed.
Add an item:
Begin entering information on the next available   row.
Delete   an item:
Click the row of the   item, and click Delete.
Change an item:
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Field Description
Date The date of the expense

Project The project associated with the expense - Do not enter a project if this   is a 
personal expense.

Phase The phase associated with the expense - Do not enter a phase if this   is a personal 
expense.

Expense 
Item

A description of the expense

Payee The recipient of the payment you made for the expense

Units If units are associated with the expense, the number of units
For example, if you are entering an expense for gas mileage, you would   enter the 
number of miles you drove.

Unit Rate If units are associated with the expense, the amount your company will   reimburse 
you for each unit
If you change any of the unit rates, and then want to change all the   unit rates back 
to the rate Ajera calculated for you, click Reset.

Amount The amount of the expense

Reference Number used to group and summarize similar items   on the credit card bank 
register
For example, on your credit card, you have separate   charges for the hotel room 
and for parking at the hotel. On your expense   report, you enter H100 as a 
reference number for both the room charges   expense item and the parking 
expense item. 
If the expense is to be reimbursed on a vendor   invoice, this field is for reference 
only on the expense report.

Credit card If you charged the expense on a company credit   card, the credit card you used

Note: After you enter an amount, the Credit Card field becomes 
available for   entry.

Personal 
expense 

Select this check box if this is a personal   expense and you charged it on a 
company credit card. Ajera then enters   the expense as a negative distribution on 
the vendor invoice for the expense   report.

Optional columns:

Attachments Any attachments   related to the item
You can click the attachments   icon in the table to add, change,   or open 
attachments. 

The column displays  if there are   no attachments, and  if there are 
attachments. 
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Field Description
Notes Any notes entered by the employee submitting the expense report.

Manager 
notes

Any notes entered by the manager approving the expense report

Reject by The person who rejected the item

 7. Click Save.

Copying an expense report
You can create a new expense report by copying an existing report and modifying   it.

To copy an expense report

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the My   Expenses tab.
 3. Click the New   button. 
 4. In the beginning and ending   date fields, enter the first and last date you are reporting expenses   for. 
 5. Select the Copy   expense report from check box.
 6. In the table, click the   expense report you want to copy.
 7. Click OK.   
 8. Change information   for the expense report, as needed.

Note:  l Ajera automatically enters the expense report ending date as the transaction 
date. You can change this date.

 l After you enter an amount, the Credit Card field becomes available for   entry.

 9. Click Save.

Deleting an expense report
To delete an expense report

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the My   Expenses tab.
 3. Click the row of the expense   report you want to delete, and click the Delete   button.
 4. Click Yes   to delete the expense report.
 5. Click Save.

Printing an expense report
Print an expense report if you need a report of the entered expenses. 
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To print an expense report

 1. From the  > Manage   menu, click Time & Expense.   
 2. Click one of the following tabs:

 l My   Expenses, if you want to print your own expense report.
 l Expenses by Employee, if you have Administrator privileges and want to print someone else's 

expense report.
 3. Double-click the expense report you want to print.
 4. Click the Print button. A preview of the expense report appears.
 5. If there are uploaded attachments on the expense report, confirm whether to include the attached 

images and PDFs when printing.

 6. Click  in the report toolbar.

Submitting an expense report
Submit an expense report if you are finished entering   an expense report and want it to be processed (or 
approved, if you   company requires approvals). Once you submit an expense report, you can   no longer change 
it unless you unsubmit   it. 
If you are already viewing the expense report, just click the Submit button. 

To submit an expense report

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the My   Expenses tab. 
 3. Submit the expense report   in one of the following ways:

To submit it Do this
Without reviewing it first Click the expense report, and click the Submit   button.

After reviewing it  1. Click the expense report   you want to submit, and click Edit 
.

 2. Review the report, and make changes if needed.
 3. Click the   Submit button.

Note: You can unsubmit an expense report only if your company requires approvals (  > Setup > 
Company > Preferences > Time & Expense Entry tab).

    

Unsubmitting an expense report
You can only unsubmit an expense report if it has not yet been processed   (or approved, if your company 
requires approvals).
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To unsubmit an expense report

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the My   Expenses tab.
 3. To see if an expense report   has been submitted, click    (Customize), select the Submitted check   

box, and click OK. 
The Submitted column appears on the window.   A check mark appears in that column for an expense 
report if it has been   submitted.

 4. Click the expense report   you want to unsubmit.
 5. Click the Unsubmit   button.
 6. Click Close.

Paying an expense report
About the invoice
When the expense report is submitted, and then approved if your company   requires approvals, Ajera produces 
a vendor invoice for the employee's   expense report. 
The vendor invoice for the employee expense report lists:

 l All items not paid with   a company credit card.
 l Advances and personal items   charged to a company credit card. It lists these as distributions with   

negative dollar amounts, which reduces the total amount of the invoice.   Ajera also creates entries in 
the credit card account (  > Manage > Bank   Register) for all credit card items, including items 
entered as Personal   on the expense report.

Paying the invoice
To pay an expense report, pay   the vendor invoice for it as you would for any other vendor invoice.   On the 
Vendor Payments window, note that

 l The employee's name is listed   in the Vendor column.

 l To see all invoices for   an employee, click the  to the left of the employee's name.   

For managers and supervisors

Approving an expense report

To approve an expense report

 1. From the  >  Manage   menu, click Time & Expense.   
 2. Click the Expenses   by Employee tab.
 3. In the table, you can choose   to:

 l Show optional columns. Click     (Customize), select the   optional columns you want to show, 
and click OK.

 l View the sort order   or appearance of columns differently.
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 4. Click the expense report   you want to approve. To approve it without looking at it,   click Approve, and   
skip to Step 10 of these instructions. Otherwise, click Edit   and proceed to the next step of these 
instructions.

 5. To view optional columns for the expense report, click      (Customize), select the   optional columns 
you want to show, and click OK.

 6. To reject an expense, right-click   the row of the expense and click Reject. If you reject an expense by 
mistake,   right-click the row and click Reject   again. 

Note: If you reject an expense, you cannot approve the expense report. It is   automatically 
unapproved and unsubmitted. The employee must correct it,   and submit it again. 

 7. You   can also correct an expense if your company   preferences for expense entry are set up to permit 
it. Make the change,   and click Save.

 8. To   enter any manager notes or comments for an expense, do the following:
 l If the Manager Notes column does not appear, click  (Customize), select the Manager   notes 

check box, and click OK.
 l In the Manager Notes column for the expense, enter   your notes.

 9. Click Close.   The Time & Expense List window appears.
 10. Click the row of the expense   report you want to approve, and click Approve.
 11. Do one of the following:

To Do this
Approve as a supervisor Select the Supervisor  Approved check box, and click OK. 

Approve as an accounting 
manager

Select the Accounting Approved   check box, and click 
OK.

Changing a processed expense report

When and how is an expense report processed?
Ajera processes an expense report after an employee submits it, and   (if required in your company preference 
settings) a supervisor,   accounting manager, or both approves the report. 
When Ajera processes an expense report, it creates a vendor invoice,   reflects the credit card entries on the 
bank register, and makes entries   available in client invoices. It also reflects the changes on reports   and 
financials.

How do you change it?
If an expense report is already processed, the accounting manager can   change it if the Allow accounting 
changes   after processed check box is selected on the Time   & Expense Entry tab of  > Setup > Company 
> Preferences.  
However, you cannot delete a processed expense report item or change   the amount of it to zero. Instead, add 
a reversing item to the expense   report. If you use a vendor payment to pay or write off a processed expense 
report item, you cannot change anything but notes and attachments. Instead, enter a new expense report and 
add a reversing item to that expense report.
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When you add new rows to a processed expense report and save it, Ajera   automatically processes that 
information to the bank entry, vendor invoice,   and client invoice. You do not need to submit or approve the 
report again.
If the expense item is already billed on a client invoice or reconciled on a credit card bank statement, the 
accounting   manager can change only the Notes column on the report.

What if the expense report is not processed yet?
If an expense report is not yet processed, you can change   the expense report.
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Understanding reporting options

Overview

Determine what you need

Determine what you need
This provides a general overview of the reporting options  available to you and where to find them.

Reporting options
Financial reporting
Project reporting
General reporting
Audit reporting
Focusing on what you need

Reporting options

Determining what you need
A good first step is to evaluate your current reporting needs, and then match up your needs with what is 
available in Ajera. 
Here are some common situations that arise during this process:

 l You review the standard reporting in Ajera that is specifically designed for architectural and 
engineering firms. It is fine as is for your needs.

 l You don't see the exact same report you had in your previous software, but on further examination, 
you find that Ajera provides something as good or better. 

 l You see a reporting solution in Ajera that is close to what you need, but it needs some modification to 
work at your firm. 

 l You need a completely new custom report to accommodate your firm's exact needs.
In this unit of the course, you'll learn about the various reporting options available in Ajera.

What Ajera offers you
Ajera offers many options for you to obtain the information you need. There are three main types of reporting:

 l Reports
 l Financial Statement Designer
 l Inquiries

What to use when
Get started by obtaining a general understanding of which type of reporting is best for which need.
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 Report Financial Statement 
Designer

Inquiry

What is it best 
for?

Easily review standard 
information in a 
common format and 
organization.

Produce financial reports. Customize information 
that exists in standard 
reports. 
Research or analyze 
information, perhaps for 
problem solving,  that is 
not available in any 
reports. 

Which financial 
reports are 
available?

Balance Sheet
Company Budget 
Journal Entries 
Ledger
Profit and Loss 
Statement
Sales Tax Preparation 
Trial Balance 

Balance Sheet (template)
Company Budget (you can 
create it)
Key ratios (you can create 
it)
Profit and Loss Statement 
(template)
Statement of Cash Flow  
(template)

 

Customization? Options available 
through  
(Customize) on the 
report.
You can also import 
custom reports 
designed in Microsoft 
SQL Server Reporting 
Services 2005.

Many options for 
determining content and 
organization

Many options for 
determining content and 
organization

Where do you 
find it?

From the main menu, 
click  > Reports.
Additional project 
reports are available 
through  > Manage > 
Project Command 
Center.

From the main menu, click 
 > Reports > Financial 

> Financial statements.
If your security settings 
allow it, you can also click 

 > Reports > Manage 
Financial Statements > 
Designs.

From the main menu, 
click  >  Reports > 
Standard Inquiries.

Standard reporting or customization 
Ajera contains a comprehensive set of standard reports designed to meet the needs of architectural and 
engineering firms. Many of these reports may be exactly what you need.
However,  based on  specific business needs, your firm may need something slightly different or very different 
from the standard reports. In these situations, Ajera offers the following:

 l The ability to import custom reports that you or a consultant create using Microsoft SQL Server 
Reporting Services 2005
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 l Inquiries
 l Financial statements that you create through the Financial Statement Designer

You will find that many standard reports  are also available as standard inquiries.  Many firms like to use 
inquiries when they want specific content  that is not available in a standard report. 

Financial reporting
In Ajera tasks, you use standard reports, inquiries, and the Financial Statement Designer to review financial 
information.

Review this information Here
Financial statements such as balance 
sheets, profit and loss statements, and 
statements of cash flow

From the  >  Reports menu, click  Financial > 
Financial statements.
If your security settings allow you to create and manage 
financial statements (as set on the  > Setup > 
Company > Roles > General tab):

 l To create or preview statements,from the  >  
Reports menu, click Manage Financial 
Statements > Designs.

 l To create and manage financial statement 
groups, from the  >  Reports menu, click 
Manage Financial Statements > Groups.

Company Budgets report
Journal Entries report
Sales Tax Preparation report
Trial Balance report

From the  >  Reports menu, click    Financial.

Let's take a quick look at the financial reporting solutions.

Financial statements
You use the Financial Statement Designer to produce financial statements such as:

 l Balance sheets
 l Profit and loss statements
 l Statements of cash flow
 l Company budgets
 l Key ratios
 l Other financial statements needed by your firm

In addition, you can create statement groups to share financial statements with others and bundle several 
statements together for easy distribution and review. You'll learn more about statement groups in Prepare it for 
distribution.
Ajera provides templates for the following financial statements so you can either produce a statement more 
quickly or begin customizing a statement more easily:
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 l Balance Sheet
 l Profit and Loss Statement
 l Statement of Cash Flows

You open the Financial Statement Designer from the  >  Reports menu by clicking Manage Financial 
Statements > Designs. View the available templates by clicking the Open button.

Other financial reports
In addition to the dashboard and the detailed reports associated with it, and financial statements, Ajera offers 
some standard financial reports. From the  >  Reportsmenu, click Financial. 
Other financial information

You can also view project, client, vendor, bank register, and payroll reports. Click  > Reports.

You can also view financial information through inquiries. Click  >  Report > Standard Inquiries.

Project reporting
You can view the following types of information about your projects:

 l Relevant reports while you work on a project
 l Project schedule information
 l Detailed project reports
 l Focused project information

As you work with Ajera, you'll most likely find that all the information you need about your projects is available 
to you. 

Relevant reports while you work
See up-to-date, pertinent information about the project you are currently viewing.

While managing, budgeting, and scheduling projects in the Project Command Center (  > Manage > Project 
Command Center), you can do the following:

Click this tab To review
Invoices Client invoice details and to preview client invoices

Progress If a project is on time and on budget

Snapshot Billed, spent, and WIP amounts, as well as hours worked, to-date

Plan A project's budgeting and scheduling information
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Project schedule information

While working with your project and employee schedules in Schedule Manager (  > Manage > Schedule), 
you can easily see current information on the status of your project and how time is being spent. You can also 
export the information to Excel.

Detailed project reports
Monitor, analyze, and evaluate the success of your projects. Simply review the reports you need.

Click  > Reports > Project.
 l Executive Summary
 l Project Workload
 l Project Earnings
 l Project Profit
 l Project Backlog
 l Hours Distribution by Project
 l Budget Variance
 l Commitment Management
 l Billing Report
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 l Work-in-Progress Aging
 l Business Development

Popular reports
Following is a closer look at a few of the popular project reports. 
To learn more about project reports and what they can tell you, see A Project Manager's Path through Ajera.

Snapshot report

Use the Snapshot report to manage day-to-day execution of your project. This   report can help answer 
questions, such as:

 l How is my project progressing?
 l What is available to bill?
 l How much budget (hours and   revenue) is left?
 l Who is working on my projects?

At a glance, you can view billed, spent, and WIP amounts, as well as   hours worked, to-date. You can view 
detail by labor, expense, and consultant.   You can further drill down to view spent and billed rates.
The project contract totals on this report are derived from the totals   that appear for projects on the Manage   tab.
 
How to get the most out of it
Be sure to enter contract amounts for the project and its phases as you work on them.  This gives Ajera good 
data at the project and phase level as long as you budget the project to the phase level. You enter and 
maintain contract amounts in the Project Command Center (  > Manage > Project Command Center > 
Manage tab).
 
Where to see it

From the  >  Manage  menu, click Project Command Center  and then click the Snapshot   tab in the 
middle of the window. If you don't see it, click  (Customize) to add it.
 
What it looks like
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Progress report

Determine if your project is on time and on budget
Use the Progress report to help you determine if a project is on time and on   budget. You can compare the 
amount you spent on your project against the   budgeted amount and the reported percent complete amount on 
a project-to-date   basis. 
With this report, you can perform Earned Value Analysis   (EVA), an industry-standard method of determining 
the progress of a phase   or project at any point in time. EVA compares forecasted completion dates   and 
estimated costs to work that was completed (earned). The report illustrates   the comparison in a three-line 
graph, which shows the variance among schedule,   budget, and earned.
 
How to get the most out of it
To get the most benefit from this report, be sure to maintain this information for the project in the Project 
Command Center (  > Manage > Project Command Center> Manage tab):

 l Estimated start and complete dates
 l RPC (Reported Percent Complete)
 l Contract amount

In this way, you give Ajera good data for your report,  as long as you enter and update the budget and its dates  
to the phase level.
 
Where to see it

 1. Open the project (from the  >  Manage menu, click Project Command Center and in the project 
list at the top of the window, click the project).

 2. Click the Progress tab.
 
What it looks like
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Project Earnings report

Use the Project Earnings report to obtain a complete picture of your projects including   billing, cost, and profit.
You can do the following with this report:

 l Review work-in-progress (WIP)  and Receivables balances. 
 l See a write-off amount when   the WIP amount has been manually changed or the WIP status has 

been changed to Write-off.
 l Optionally include overhead   expenses in your project labor cost.
 l Print it with labor only,   or include expenses and or consultants.

You can summarize information by project manager, principal in charge,   project type, or department. You can 
drill down to project, phase, and   full detail information.
 
Where to see it

From the  >  Reports menu, click Project > Project Earnings.
 
What it looks like
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Budget Variance report

Use the Budget Variance report to monitor labor, expense, and consultant totals.
Use the graph view to see, at a glance, which projects need your attention.   The comprehensive budget 
information on the report includes contract amount,   amount spent, and amount remaining for labor, expenses, 
and consultants.
You can summarize information by project manager, principal in charge,   project type, or department. You can 
drill down to project and phase information.
 
Where to see it

From the  >  Reports menu, click Project > Budget Variance.
 
What it looks like
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Focused project information
When you need to focus on specific project information, you can use a project inquiry. 
You can work with one of these standard inquires to get at the specific information you need. For example, 
you can delete a column, move a column, or add a column. When you add a column, you can select it from a 
long list of available information, or enter a formula to display the unique information you need.

Click  > Reports > Standard Inquiries > Project .
 l Project
 l Phase
 l Project Type
 l Project Manager
 l Reported Percent Complete
 l Business Development

General reporting
This topic introduces you to reporting for other areas of Ajera. 
Ajera provides reports and inquiries for reviewing various information about the following:

 l Vendors (accounts payable)
 l Clients (accounts receivable)
 l Employees
 l Payroll
 l Banking

Click either the  >  Reports  menu.
Here's a list of reports and inquiries that are available for information on employees, clients, vendors, banks, 
and payroll. 
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To see a detailed description about a specific report or inquiry, click the link.

For information about Review these reports And these inquiries
Employees Employee Utilization

Employee Workload
Hours Distribution by Employee
Manage Timesheets
Rejected Time
Timesheet Status

Employee
Employee Type
Timesheet
Timesheet Detail
Expense Report
Expense Report Detail

Clients Client Invoice Register
Client Receipt Register
Client Invoice Aging
Client Statements
Monthly Receivables Balances
Cash Receipt Forecast

Client
Client Type
Client Invoice 
Billing Review History
Client Receipt

Vendors Vendor Amount to Pay
Vendor Check Register
Vendor Invoice Aging
Vendor Invoice Register
Consultant Pay When Paid
Consultant Insurance
Monthly Payable Balances 
Vendor 1099 Preparation

Vendor
Vendor Type
Vendor Invoice
Vendor Payment
Vendor Insurance 
Recurring Vendor Invoice 
Recurring Vendor Invoice Distribution

Banks Bank Entries Bank Account
Bank Entry
Bank Account Statement
Credit Card Statement

Payroll Check Activity
Subject-To
Deduction - Fringe Register
Deposit Summary
Accrual Pay Balance
940 Preparation
941 Preparation
Salaries Payable Balance
State Quarterly

Check Summary
Check Detail
Deduction
Fringe
Accrual
Subject To
Deposit Summary
940 Preparation Part 1
940 Preparation Part 2
941 Preparation
State Quarterly
Tax
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In addition, you can produce setup reports to review a summary of the options you selected and information 
you entered when setting up Ajera. 
For example, you can produce the Client Setup report to quickly reference various information about clients, 
such as the email address or contacts.

You can also review list reports and inquiries to print lists of various items you set up, such as employees, 
contacts, and so on.

Audit reporting
An important part of financial software is auditing and financial reconciliation. With Ajera, you can use the 
following to accomplish those tasks:

 l Session journal reports
 l Session inquiries
 l Other inquires
 l Reconciliation reports

Session journal reports
Session journal reports show entries created, changed, and deleted in a session.   They also show a recap of 
accounts affected by the entries.
You begin by viewing a list of session journals. You can select to see only sessions for a specific time frame if 
the list is too long. Next, you select the session journal you want to view.

To view session journal reports, from the  >  Reports menu, click Session Journals.
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Session  inquiries
A session  inquiry differs from a report in that you can more easily focus on the information you want. If you 
don't readily see what you need in the report, the inquiry provides a good way for you to research and 
investigate specific issues. For example, you can add columns for information you need to review.

To view session inquiries, from the  >  Reports menu, click Standard Inquiries > Session.

Other inquiries
In addition to session inquires, other types of inquires are also available to help you monitor your accounts and 
transactions, and to research a specific issue in detail. For example, when viewing the Timesheet inquiry, you 
can click a link to view the Transaction Labor inquiry, or when viewing the GL Account inquiry, you can click a 
link to view the GL Entry Accrual inquiry.

Be sure to review the inquires that are available to you. From the main menu, click  >  Reports > Standard 
Inquiries.
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Financial reconciliation
Developing precise procedures for reconciliation should be a top priority for every company. It is a guarantee 
your reports are accurate and your data is in balance.
As a best practice, we recommend that you reconcile monthly. You first determine if your Trial Balance report 
is in balance and then balance each of the control accounts to your Trial Balance report.
Through normal workflow, Ajera keeps the subsidiary ledgers and control accounts in balance. For example, 
when you print vendor checks, an entry is made to the Accounts Payable control account to reduce the 
balance by the total of the check. However, if you entered the amount of the check as a debit to the Accounts 
Payable account in Manage Journal Entries, then your Accounts Payable subsidiary ledger (Vendor Invoice 
Aging) would no longer be in balance with your Accounts Payable account on your Trial Balance report.

Focusing on what you need
Learn how to obtain the reporting you need, including the options available for customizing reporting to meet 
any special needs at your firm.

Explore!
Explore the different reporting solutions, and determine how to best use them for your firm's needs. Start by 
just clicking on the main  > task menu in Ajera to see what's available. (Some or all of the options may not 
be available to you depending on your security settings).

Get what you want

Obtain what you need
This describes how to produce reports, inquiries, and financial statements. It also describes where you can 
obtain additional resources for producing custom reporting.

Producing reports
Producing inquiries
Producing financial statements
Resources for custom reporting

Producing reports
In this topic, you'll learn the basics about producing reports. 
Ajera provides a set of reports designed for architectural and engineering firms. When viewing a report, it's 
easy to select custom options for it, navigate through it, and review information in it.

You begin by selecting the report you want from the  >  Reports menu. 

Anatomy of a report
Let's start by taking a look at a sample report and its various components.
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A close-up look at the reports toolbar
Use the toolbar to change the way you view the report, and to print or export the report.

Customizing reports
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You can customize reports in these ways:
 l Use  (Customize) on the window for the report. With it, you can change some general options.
 l Copy a standard report and modify it.
 l Create a report of your own.

Use   (Customize)

When viewing a report, you can use  (Customize)  to change some general options for the report's content. 
For example, on many reports, you can change the name of the report or the sort order.

Here's an example of some options available for the Project Earnings report:

Modify an existing report or create your own report

You or a consultant can modify an existing Ajera report or create a new report.
So that Ajera can use the report, the report must be created in Microsoft SQL Server Reporting Services 2005.
You may need to customize a standard Ajera report because the Customize options do not provide exactly 
what you need. First, see if you can obtain what you need by using or modifying an inquiry. Some firms prefer 
to modify an inquiry, instead of a report, because you can do it directly through Ajera.
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Printing and exporting reports
To preview and print a report:

 l To preview the report as it appears when printed, click     (Print Layout). Click the button again to 
return to the Viewing Layout.

 l To print the report, click   (Print).
To export a report:

 1. From the report you are   currently viewing, click    (Export), and then select Excel, Word, or 
Acrobat (PDF) file. The Save   As window appears.

 2. Select the location where   you want to save the exported file.
 3. Enter a name for the file.
 4. Click Save.

Producing inquiries
In this topic, you'll learn about using inquiries to get the information you need. Later in this course, you'll learn 
how to share them with others.
Ajera provides a set of standard inquiries that target information most commonly needed by architectural and 
engineering firms. The inquiries contain links to other standard inquiries.
One of the most powerful aspects of inquires is their flexibility. You can create, move, or remove columns and 
change the information and type of information that appears. For this reason, inquiries are very helpful when 
you need to see specific information in a certain way or when you need to get at information you can't find 
elsewhere so as to research an issue. 
When you need to customize an inquiry, you use a standard inquiry as a starting point; you do not create an 
inquiry from scratch. A good way to think of a standard inquiry is that it is like a template. Like any template, 
you do not overwrite the standard inquiry, but you change it and then save it with a different name. 

Know which inquiry you need
Because so much information is available through inquiries, it is important to develop a plan to help you know 
exactly what you need and how to get it. It helps to determine which inquiries contain what you need. In some 
cases, it also helps to know how to link an inquiry to another inquiry so that the information is simple to access 
and analyze.

Types of inquiries

Let's take a look at how Ajera groups inquiries on the main  > task menu and at some general examples of 
the type of information you'll find on inquiries within those groups:
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These 
types of 
inquiries

Contain information such as

Project Project dates, project manager, project type, hours budgeted, hours worked, total 
contract amount, spent amount, billed amount, work-in-progress (WIP), and Reported 
Percent Complete (RPC)

Employee Name, job title, employee type, contact information, hours worked on a project, 
phase, and activity, and expense report details

Resource unavailable in ajeraCore
Employee, employee type, activity, vendor, units/hours, actual start and completion 
dates, project descriptions, and phase descriptions

Client Client name, client type, contact information, client invoice details (write-off, 
outstanding, and aging), client receipt details (receipt method, total amount, amount 
by activity type, adjustment, prepayment, and deposit bank name)

Vendor Vendor name, vendor type, vendor contact information, vendor invoice information 
(write-off, outstanding, and aging), vendor payment details (bank name, payment 
number/reference, check date, invoice number, and amount), and vendor insurance 
details

In-house 
Expense 
Log

In-house expense status, description, log date, and notes

Department Department name and status

Bank Bank account names, account numbers, bank entry details (bank name, entry 
number, and amount), bank account and credit card statement details (bank name, 
statement beginning and ending dates, reconciled payments and deposits or charges, 
remaining amount, and statement beginning and ending balances)

Transaction Billing status, transaction type, date, activity, activity type, employee, employee 
type, hours type, units/hours, and cost, spent, and billed amounts

General 
Ledger

General ledger account details (account type, account group, and net profit) and 
general ledger entry details (accrual department and account, and cash basis 
department and account)

Payroll Check summary details (pay period, regular and overtime hours and amounts, total 
hours, gross pay, deductions, employee tax, net pay, employer tax, and fringe 
amounts), check detail (GL account and department, pay date, hours, and employee 
and employer amount), deductions, fringe benefits, accrued vacation and sick time, 
taxes, and 940 and 941 preparation

Session Session task, employee performing the task, and date and time of task

List Details for activities, contact names, and contact types

Inquiries and inquiry descriptions

To begin knowing what inquiries contain and which inquiries you will need:
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 l Look at the inquiries by opening them from the  Reports > Standard Inquiries menu.

 l Review the inquiry descriptions in help (  > Help > Online Help). To return to this course, click the 
Back button.

Anatomy of an inquiry
Let's take a look at a sample inquiry and its components. 
An important thing to remember about inquires is that you can control the type and amount of information in 
them.
In addition, you can link to other inquiries from an inquiry. For example, the Project inquiry lists general 
information about projects and contains links to the Phase inquiry, which contains detailed information for a 
project.

A close-up look at the Inquiry toolbar
Use the toolbar to change the way you view the inquiry, to change properties for it, and to save, print, or export 
it.
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Creating an inquiry
You create an inquiry by changing a standard inquiry.

Work with columns

Here are some ways you can work with columns to display the information you want on an inquiry:
 l Add a column by selecting it from a predefined list, or create a column by entering a formula.
 l Move columns so information appears in a logical order.
 l Delete columns to focus on only what you need and remove clutter.
 l Sort, group, or subtotal by column.
 l Set column properties to define its format.
 l Link the column to another inquiry to easily view related information.

Set conditions

In addition, you can set conditions for an inquiry, as needed, to limit the data that appears in the inquiry. For 
example, you may want to see only transactions for a certain date range or a specific client. Or you may want 
anyone who uses the inquiry to see only their transactions, not their coworkers' transactions.

Set time periods

You can set column properties or inquiry conditions so that data for a specified time period is displayed in an 
inquiry column or an entire inquiry.
Be sure you understand how time periods work on an inquiry and how they can affect the information that 
appears. For more information, see the following:

This link goes to help (  > Help > Online Help). To return to this course, click the Back button.
Displaying inquiry data for a specific time period

Example

For example, you reviewed the standard reports for Business Development, but you need some specific, 
additional information. Before getting started with your BD efforts for a new project, you want to first review 
historical and current information on existing BD projects. 
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You start by opening the standard inquiry, BD phase. You then add some predefined columns. You create 
other custom columns by using a formula. Your result might look something like the following:

Printing and exporting an inquiry

To open an inquiry, select it from the  Reports > Standard Inquiries or Custom Inquiries menu. 

Preview and print an inquiry

To preview and print an inquiry, click   (Print) on the toolbar and make a selection as follows: 
 l To set margins, page orientation, and paper type for printing the inquiry, select Page Setup.
 l To preview the inquiry as it appears when printed, select Print Preview. To then return to the normal 

view, select                    Print Preview again.
 l To print the inquiry, select Print.

Export an inquiry

You can export an inquiry to Microsoft Excel, Microsoft Outlook, or Adobe Acrobat (pdf). 

To export an inquiry, click   (Export) on the toolbar and make a selection.

Producing financial statements
You use the Financial Statement Designer to create financial statements such as balance sheets, profit and 
loss statements, statements of cash flow, company budgets (accrual only), key ratios, and other financial 
statements needed by your firm.

Templates for financial statements
Ajera provides templates for these financial statements:

 l Balance Sheet
 l Profit and Loss Statement
 l Statement of Cash Flows

Start by opening the template and clicking the Preview tab. In this way, you can quickly  get an idea of the 
type of changes you'll need to make, or see if you can use the template exactly as it is. You can then save the 
template with the name you want to call the financial statement, and then preview and print the statement 
when needed.
If you find the template is very different from what you need, you can also select to design a statement from 
scratch.
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To open a template, from the  >  Reports menu, click  Manage Financial Statements > Designs, and 
click the Open button.

Accessing financial statements

You view and work with financial statements from the following options on the  >  Reports menu. What you 
see on the menu depends on your security settings.

Anatomy of a financial statement design
The Financial Statement Designer provides a simple spreadsheet format that you use to design statements.  
You can define the contents and appearance of individual cells, entire rows, or entire columns with a few 
clicks of the mouse.
Let's take a look at a sample financial statement design and at some of its more important components.

Here's an example of the Design and Preview views of a Balance Sheet being designed.
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Printing and exporting a financial statement
You print a financial statement by selecting the financial statement group for it. If your security settings allow 
you access to the Financial Statement Designer, you can also print the financial statement from there.
You can export financial statements to Microsoft Excel, if needed.

Resources for custom reporting
To obtain additional knowledge or assistance in producing custom reporting, or obtain existing templates 
designed by others, be sure to check out the following options.

Additional training
Go to the Axium Client Support Center, and learn about the training classes being offered:
Training packages
Single classes

Axium Consulting Services
You can obtain assistance in creating custom reports, inquiries, financial statements, or client invoices by 
contacting Axium Consulting Services.
Learn more about obtaining assistance at the Axium Client Support Center > Consulting Services.

Templates Library
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The Templates Library consists of custom reports, custom inquiries, inquiry formulas, custom invoice 
designs, and custom financial statements. These materials are free of charge for the Axium user community 
and have been provided by members of the community.
With your client username and password, you can access the Axium Client Support Center's 
Knowledgebase, and click Find Solution. In the Solutions, you will find the Templates Library category 
which contains a variety of templates. 
All templates are free for you to download and use. While every design may not be a perfect match for your 
business, with a little customization, you can design an inquiry or report to do just what you want.

Distribute it

Distribute it
This describes how to  distribute custom reports, custom inquiries, and financial statements that you or a 
consultant create. 
It explains how to set security for reporting so it is easily available for those who need it and unavailable for 
others. 
It also describes some best practices for training others in your firm on how to use the various reporting.

Preparing it for distribution
Who sees what
Training others

Preparing it for distribution
In this topic, you will learn how to distribute custom reports, custom inquiries, and financial statements that 
you or a consultant create.

Distribute reports 

Standard reports appear automatically on the  > Reports menu for all employees who have security 
settings that allow them to see the reports.
In this lesson, you'll learn about distributing:

 l Reports produced with report views
 l Custom reports designed in Microsoft SQL Server Reporting Services 2005

Reports produced with report views

You can save options for the way you produce a report by creating a report view. You can then also distribute 
the report (produced with the options you saved) to others.
You run a report view just like a report; however, it produces a report based on report options that you already 
selected. The report view appears on the Reports menu for yourself and any others you give access to it 
through their security settings.
You might want to create a report view for a report if:

157 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

Understanding reporting options

http://www.axium.com/solutioncenter/default.aspx


 l Different employees will want to produce the report using the same options.
 l You want to create several versions of a report, each produced with different options.
 l You want different employees to see a version of a report with information that only pertains to them.

For example, you may want project managers to see the Project Earnings report with only their projects on it. 
You would create a view for the Project Earnings report and select Project Manager in the Limit By field.
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If you want any other employees to have access to the report view, you must provide access to the 
appropriate employees through  > Setup > Company > Roles > Reports tab > Allow check box. 

Custom reports

Before you begin
 l Ensure that the custom report is in a Microsoft SQL Server Reporting Services 2005 file, which has an 

extension of .rdl.

To set up a custom report
You can set up either your own report or a standard Ajera report that you modify as a custom report:

 l To use your own report, ensure that the .rdl file is in a location you can access, such as a shared 
network folder or your desktop.

 l To use a standard Ajera report:
 a. Copy the report from the \Ajera\Program\Standard Reports folder on the network drive where   

Ajera Server is installed to a location you can access, such as a shared network folder or your 
desktop.

 b. Using Microsoft SQL Server Reporting Services 2005, modify the report and save it as an .rdl file, 
with a new file name.

To add a custom report

 1. From the  >  Reports menu, click Manage Custom Reports.
 2. Click the Add button, navigate to the <custom report>.rdl file, and click Open to add the report to the 

Ajera database. The custom report appears in the Manage Custom Reports window.

Note: To select multiple custom reports, shift-click the .rdl files.
If the custom report you add has the same name as an existing report, the new report will 
override the current report.
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 3. Do the following: 

Field Description
Active Select this check box so that the report appears on the  >  Reports menu and 

is available   for use.

Name Change the name of the report, if needed.

Category Type   the name of the  >  Reports submenu where you want the report to 
appear. If   this field is blank, the report appears on the main  >  Reports menu.

Crystal 
Report

View only. If this check box is selected, it indicates that the report is a Crystal 
Report, which you cannot add, delete, or export in this window. Crystal Reports 
have an extension of .rpt.

 4. Click Save. The report appears on the  >  Reports   menu where you can select and run it like any 
other report.

To enable other employees to see this report,  select   it on the  >  Reports tab for the employees' 
role. See Changing a role. 

To return to this course, click the Back button.

Distribute inquiries
Standard inquiries and custom inquiries appear automatically on the Inquiry menu for all employees who have 
security settings that allow them to see inquiries. You'll learn more about security settings in the next lesson.

Show data pertaining only to a specific employee

You can set a condition for an inquiry so that the inquiry shows only the data pertaining to the employee who is 
viewing it. 
For example, you set a condition for the Payroll Accrual inquiry (Employee Key Is Current User). When 
employees log into Ajera and use the inquiry, they see only their accrued hours, not their coworker's hours. 
To set a current user condition for an inquiry:

 1. Open the inquiry for which you want to set the current user condition. From the  >  Reports > 
Custom Inquiries menu, select the inquiry you want.

 2. Click   in the upper right of the window. The Inquiry Properties window appears.
 3. Click the Conditions tab.

 4. In the field that contains text asking you to select a column, click the arrow  and select an 
employee key field (for example, Project Manager Key).

 5. In the field to the right, select Is Current User.
 6. Click OK.

You can also show data in a column or link so it pertains only to the employee who is viewing it. For more, 
information see Showing inquiry data pertaining only to the user. To return to this course, click the Back 
button.

Organize custom inquiries for distribution
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You want your custom inquiries to be easy to find and easy to use. This is especially important if you plan to 
share them with others. It's easy to change where an inquiry appears on the  > Reports > Custom Inquiries 
menu.

To Do this
Change the 
order of an 
inquiry

 1. From the  >  Reports > Custom Inquiries menu, click Manage Custom 
Inquiries.

 2. Click the inquiry.
 3. Click the Up or Down  arrow.
 4. Click Close.

Group 
inquiries 
together in 
a submenu

You can list inquires together in a submenu. For example, you may want to list 
several inquiries (Projects by principal, Projects by location, and Projects by project 
manager) together on a  > Reports > Standard Inquiries > Projects menu.

 1. From the  >  Reports > Custom Inquiries menu, click Manage Custom 
Inquiries.

 2. For each inquiry you want to appear on a submenu, type the name for the new 
submenu in the Menu column.

 3. Click Close.

Move an 
inquiry to a 
different 
submenu

 1. From the  >  Reports > Custom Inquiries menu, click Manage Custom 
Inquiries.

 2. On the row of the inquiry you want to move, in the Menu column, type the 
submenu where you want the inquiry to appear.

 3. Click Close.

Move an 
inquiry to 
the main 
menu

 1. From the  >  Reports > Custom Inquiries menu, click Manage Custom 
Inquiries.

 2. On the row of the inquiry you want to move, in the Menu column, highlight the 
entry and press the Delete key.

 3. Click Close.

Distribute financial statements
To share a financial statement that you designed, you create a statement group for it. You can create a 
statement group for either one statement only or for several statements you want to package together in a 
bundle.

Who sees what
You determine who can access specific areas of Ajera by defining roles and assigning employees to them. 
Those employees then have access to areas of Ajera based on the settings you define for their security 
access.
Often the accounting manager and principal have unlimited access to all reports, inquiries, and financial 
statements. They then grant access to others, as needed, for viewing and printing individual reports, inquiries, 
and financial statements.
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Unlimited access to reports and inquiries
For those in your firm that need unlimited access to all reports and inquiries, you set one option which allows 
them to do the following:

 l View and print all reports, and manage custom reports
 l View and print all inquiries, change existing inquiries, and create custom inquiries

 > Setup > Company > Roles > General tab

Sharing reports and inquiries
Some of your reports and inquiries may be confidential. Other reports may need to be shared with only certain 
employees in your firm. Yet other reports may need to be available for many of your employees. 
For reports and inquires, you set security for each report and inquiry so you can carefully control access to it. 
It's a simple and easy way to ensure that your information is available to the right people.
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Reports

 > Setup > Company > > Reports tab

Inquiries

 > Setup > Company > > Inquiry tab

Unlimited access to the Financial Statement Designer
For those in your firm that need access to create, produce, and distribute financial statements using the 
Financial Statement Designer, you set one option.

 > Setup > Company > > General tag
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Sharing financial statements
Your financial statements must often remain confidential, available only to those who need to prepare or 
review them.
Only members of roles who have been granted unlimited access to the Financial Statement Designer can 
create, produce, and distribute the financial statements that they create in the designer. 
Those employees then make individual statements available to other roles by using statement groups. 
Statement groups are a simple way of making statements appear on the  > Reports menu for only 
employees of a specific role . 

 > Setup > Company > > Reports tab

More than one job role
If an employee has more than one role, the tasks and information that person can access is determined by the 
role with the greatest access. For example, if a person has the roles of Employee and Administrator, the 
Administrator security settings take precedence.
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Reports

About reports
Learning Resource: Reports Functional Guide
You have access to view   and produce the reports selected   for your job role. If you have more than one job role, 
the role with the greater access takes precedence.
As you produce a   report, you can do the following:

 l Use the reports   toolbar to navigate in, view, print, or export a report.
 l Drill   down on many reports to get the exact level of detail you need. 
 l Change the type or amount   of information on a report by selecting report options. You can reuse   the 

options every time you produce a report by saving them as defaults.   
 l Create report views,   which are versions of reports with specific options already selected.   After you 

set up a report view, it appears on the Reports menu along with   other reports.
 l Customize Ajera   reports or use your own custom reports.

Basic tasks

Producing reports

 1. From the  >  Reports   menu, click the report you want to produce.

Note: When you are working on a window, you can often print related reports   directly from that 
window. Click Save,   click     (Reports), and make a selection.
The report appears in a View Layout. To see   the report as it appears when printed, click 

   (Print Layout).

 2. View the report as needed:
Using the toolbar and buttons:

To Do this
Navigate in, view, 
print, or export the 
report

Use the toolbar.

Change the type or 
amount of 
information

Select any available options at the top left of the window, or click     
(Customize) to select customized report options.
If you select any options at the top left of the window, click   (Refresh) at 
the top right of the window to   display the report again using the options you 
just selected.

Drilling down and sorting:
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To Do this
See 
more 
detail

Depending on the drill-down information, drill down to detail in one   of these ways:

 l Click a  symbol. To close the drill-down detail, click   the  symbol.

 l Click blue   text or numbers. To close the drill-down detail, click  in the 
toolbar. 

Sort by 
column

Click the  symbol above the column you want to sort. 

A symbol appears to indicate that the column   is now sorted from first to last (either 
alphabetically or numerically   depending on the contents of the column).

To sort from last to first, click the symbol. A  symbol appears.

To return the report to the original sort order, click    (Refresh) in the toolbar directly 
above the report.

Note: The new   sort order remains only until you close the report. For many 
reports,   you can change the sort order so that it remains for future 
viewing by   using     (Customize) to select report options.

Selecting report options

To select report options

 1. From the report you are   viewing, click     (Customize). 
 2. Select the options you want   to use for producing the report.
 3. If you want to use these   same options every time you produce the report, click the Save   as Default 

button.
 4. Click OK.

Using the reports toolbar

Use this 
button

To do this

Currently not used. May be used on reports built exclusively for your   
company.

View the first page.

View the previous page.

View the next page.

View the last page.

Return to the original parent report you were   viewing before you selected to 
view a detailed report. 
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Use this 
button

To do this

From within some reports, your pointer appears   as a hand when on blue text 
or numbers so you can click them to view a   detailed report for that 
information. 

Stop your request to produce the report.

Print the report.

To first preview the report as it appears when printed, click   .

See the Print Layout view of the report, which shows the report as it   appears 
when printed. Click the button again to return to the Viewing   Layout.

Open the page setup options for printing the report.

Export the report to:
 l Microsoft   Excel
 l Microsoft Word
 l Adobe   Acrobat (.pdf)

Zoom in or out to make the report larger or smaller on your screen.   
Click the arrow and make a selection.

Drilling down on reports
On many reports, you can drill down through information on the report   to see more detail. 

To drill down on a report

 1. Move your pointer over the   area of the report you want to see more detail for.

 2. If your pointer changes   to  (magnifying glass), more detail is available.
 3. Double-click the item.The detailed information appears as another   tab on your window.
 4. On many reports, you can   continue to drill down by repeating the previous steps of these instructions.
 5. Use   the report toolbar to navigate in, print, export, or close the tab.

Exporting a report

To export a report

 1. From the report you are   currently viewing, click    (Export), and select Excel, Word, or Acrobat 
(PDF) file. The Save   As window appears.

 2. Select the location where   you want to save the exported file.
 3. Enter a name for the file.
 4. Click Save.
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About including contract amounts in project reporting
When calculating amounts on project reports, Ajera uses the lowest levels   from your project tree, rolls them 
up to higher levels, and then finally   rolls those amounts to the project.
When you add a new subphase under an existing phase in your project   tree, Ajera is designed to do the 
following on your project reports:

 l Include amounts and hours for the newly added subphase.
 l Not include   contract amounts and hours for the newly added subphase. Ajera does not   include 

contract amounts or hours until you enter the correct amounts,   per your contract, to the newly-added 
subphase.

To include contract amounts on project reports
When you add a new subphase under a phase without resources, redistribute   the contract amounts to that 
subphase. If the phase has resources, delete   the resources and reenter them under the subphase you are 
adding.

Custom reports

Inactivating or deleting custom reports 
You can inactivate or delete custom Microsoft SQL Server 2005 Reporting Services reports (.rdl) in the 
Manage Custom Reports window. 
These instructions do not apply to custom reports created in Crystal Reports (.rpt). 

 1. From the  >  Reports   menu, click Manage Custom Reports. 
 2. To inactivate a custom Microsoft SQL Server 2005 Reporting Services report so it no longer appears 

in the Reports menu, clear the Active check box.
The report is inactive and no longer appears on the Reports menu. It remains in the Manage Custom 
Reports window if you want to make it active later.

Note: If you created report views from the report you want to make inactive,   you must first 
delete   those report views. 

 3. To delete the report from the Ajera database and remove it from the Manage Custom Reports window, 
click the report and click the Delete button.

 4. Click Save.

Managing custom Crystal reports
In Ajera, you can inactivate or delete custom reports created in Crystal Reports, which have an extension of 
.rpt. You cannot add custom Crystal reports.
If you have custom reports or invoice formats in Crystal Reports, contact your Ajera consultant.

To inactivate or delete custom reports created in Crystal Reports:
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 1. From the  >  Reports menu, click Manage Custom Reports.
 2. Click the custom Crystal report you want to inactivate and clear the Active check box.
 3. Click Save. 

The report is inactive and no longer appears on the Reports menu. It remains in the Manage Custom 
Reports window if you want to activate it later.

Note: If you created report views from the report you want to make inactive,   you must first 
delete   those report views. 

 4. To remove the report from the Manage Custom Reports window, go to the \Ajera\Program\Custom 
Reports folder   on the network drive where Ajera is installed and remove or delete the .rpt file.

Report views

About report views
A report view is a collection of report options that you save, name, and reuse so as to run a report in a 
specified way. Use report views to customize a standard report to meet a specific need, then use security to 
limit employee access to the custom view.

Note: You can   also create a report view for a custom report.

You might want to create a report view for a report if:
 l Different employees will   want to produce the report using the same options.
 l You want to create several   versions of a report, each produced with different options.
 l You want different employees   to see a version of a report with information that pertains only to them.

For example, you may want project managers   to see the Billing Report with only their projects on it. 
You would create   a view for the Billing Report and select the Display Projects Limited   By Project 
Manager option.

Changing report views
When you change a report view, be aware that other employees may be   using it.

To change a report view

 1. From the report of the report   view that you want to change, click  (Customize ). 
 2. Click Views. A Views window appears listing any views that were already created   for this report.
 3. Click the view you   want to change, and click Edit.
 4. Make your changes, and click   OK.
 5. Click Close.

Deleting report views
Before you delete a report view, first consider that other employees   may be using it.

To delete a report view

 1. From the report of the report   view that you want to delete, click  (Customize). 
 2. Click the Views   button. A Views window appears listing any views that were already created   for this 

report.
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 3. Click the view that you   want to delete, and click the Delete   button.
 4. Click Yes   to delete the view.
 5. Click Close.

Inquiries

About inquiries
Learning Resource: Inquiry Basics Functional Guide
Ajera contains a set of standard inquiries, each one targeting information   that is most commonly needed by 
architectural and engineering firms. In   addition, inquiries contain links to other inquiries so that you can see   
supporting information or drill down to more detail with just one click.
However, a standard inquiry is just the beginning. You use each standard   inquiry as a starting point for 
creating an inquiry that includes the   exact information you want to see, in the way you want to see it.
As you create an inquiry or later   change it, here are some of the things you can do:

 l Select   columns that you want to add to the inquiry. If you have something   specific in mind, you can 
even create   your own column using a formula.

 l Move,   delete, and sort columns. You can also group information.
 l Add   links from one inquiry to another. You can even select to show only   certain information when 

linking to another inquiry.
 l Set   conditions to limit your inquiry so as to focus on only specific information.   For example, you may 

want to see only active projects on the Project inquiry. Or you may want anyone who uses the inquiry 
to see only their information, not their coworkers' information.

 l Export an inquiry to Microsoft Outlook, Microsoft Excel, or Adobe   Acrobat.

Right-clicking
When you work with inquiries, you often begin performing a task by right-clicking   a column heading.

Inquiry toolbar
The inquiry toolbar appears at the top of each inquiry. Along with   right-clicking a column heading, it is the other 
main way of performing   tasks.

Links
Links appear in blue. When you click a link, it displays another inquiry   that contains supporting information or 
more detail.
When you view an inquiry by clicking a link to it from another inquiry,   you can then temporarily set conditions 
for it or add links on it, but   they are not saved. You must set the conditions on the link you use to   open the 
inquiry. You can also access the inquiry from the  > Reports > Standard Inquiries menu and then set 
conditions for it and add links on it. However, you   can add, change, or remove columns for an inquiry when 
accessing it through   a link and then saving that inquiry as a custom inquiry. 

Saving inquiries
There are different ways to save an inquiry depending if you are creating   a new inquiry from a standard inquiry 
or just from an inquiry you previously   created.
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Saving a standard inquiry
Save a new inquiry you create from a standard   inquiry in one of the following ways:

 l Click   the Save button to save your new   inquiry with the same name as the standard inquiry. Any links 
in other   inquiries that point to the standard inquiry are redirected to the inquiry   that you save here 
instead.

 l Click   the Save as button to save your   inquiry with a unique name. Any links in other   inquiries that 
point to the standard inquiry continue to point to the   standard inquiry, not the inquiry you save here. 

Your changed version appears on the  > Reports > Custom Inquiries menu with the exact same name   as 
the standard inquiry. 
After you click the Save   as button, type the new name in the Custom Inquiry Name field,   and click OK.
After you save an inquiry, it appears on   the menu. You can make it visible to other employees by selecting it in
   their role settings.

Saving an inquiry you previously created
Save an inquiry you created   in one of the following ways:

 l To save your changes as a new inquiry, click the Save as button, type the new name in   the Custom 
Inquiry Name field, and click OK.

 l To apply your changes to the existing inquiry, click   Save.

Basic tasks

Managing the Custom Inquiriesmenu

You can change the way inquiries you create appear on the  >  Reports > Custom Inquiries  menu.
Change the order of an inquiry
Group inquiries together in a submenu
Move an inquiry to a different submenu
Move an inquiry to the main menu

Change the order of an inquiry

 1. From the  >  Reports   menu, click Custom Inquiries  > Manage Custom Inquiries.   
 2. Click the inquiry.
 3. Click    or   .
 4. Click Close.

Group inquiries together in a submenu
You can list inquires together in a submenu. For example, you may want   to list several inquiries (Projects by 
principal, Projects by location,   and Projects by project manager) together on a  > Reports > Custom 
Inquiries > Projects   menu.

 1. From the  >  Reports   menu, click Custom Inquiries > Manage Custom Inquiries.   
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 1. For each inquiry you want   to appear on a submenu, type the name for the new submenu in the Menu   
column.

 2. Click Close.

Move an inquiry to a different   submenu

 1. From the  >  Reports   menu, click Custom Inquiries > Manage Custom Inquiries.   
 1. On the row of the inquiry   you want to move, in the Menu column, type the submenu where you want   

the inquiry to appear.
 2. Click Close.

Move an inquiry to   the main menu

 1. From the  >  Reports   menu, click Custom Inquiries > Manage Custom Inquiries.   
 1. On the row of the inquiry   you want to move, in the Menu column, highlight the entry, and press the   

Delete key.
 2. Click Close.

Using the Inquiry toolbar
Use the Inquiry toolbar as follows.

Use this button To do this
Display the previous inquiry you viewed when clicking links to other   inquiries.

Update the information in the inquiry to reflect any changes made in   Ajera since you 
opened the inquiry.

Zoom in to increase the size when viewing the inquiry.

Zoom out to decrease the size when viewing the inquiry.

 

Search for specific information in the inquiry.
 1. Type the text, date, or   number you are looking for.
 2. Click the Find   button.
 3. Click the Next   button to display the next occurrence of it.

Print, preview the printed version, or change the page setup.
To preview the inquiry as it appears when printed, click Print   > Print Preview. To 
then return   to the normal view, click Print   > Print Preview again.
To set margins, page orientation, and paper type for printing the inquiry,   click Print > 
Page   Setup.
To print the inquiry, click Print   > Print.
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Use this button To do this
Export the inquiry to Microsoft Outlook, Microsoft Excel, or Adobe Acrobat.

These buttons appear only when the inquiry is longer than one page.   Page through 
the document as follows:
Click the arrow to display the first page, previous page, next page,   or last page, 
respectively.
Type the page you want, and press Enter.
Click the Show All Rows button   to see all the data.

 l Save   another version of a standard inquiry with the same name.
 l Overwrite an inquiry you   created with your changes.

Save an inquiry with a different name.

Click to show any hidden columns. The headings of hidden columns are dimmed in 
the inquiry.
To hide the hidden columns again, click Hide Hidden. 

Set up general properties   and set conditions   for the inquiry.

View help topics about inquiries.

Working with inquiry columns
Change your inquiry so that it contains columns that reflect the exact   information you want, in the order you 
want to see it.
Do any of the following as needed:
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To Do this
Add a column  1. Right-click a column heading   where you want to add the new column, 

and click either Add   column to the left or Add column   to the right.
 2. In the Column field, select   the column that you want to add.
 3. In the Heading field, type   the name of the column. 
 4. In the Width field, type   the width of the column in inches. Use decimals 

such as .50 for one half of an inch.
 5. As needed, link   the column to another inquiry.
 6. Click OK.

Note: If you   added a custom field with a display name that ends with 
a closed parenthesis,   it is excluded from the list of columns. If 
you want to use the custom   field in an inquiry, change its 
display   name.

Create a column Create a new column using   a formula

Link to another 
inquiry

Add a link

Move a column  1. Right-click the column you   want to move.
 2. Select either Move   column to the left or Move column   to the right.

Delete a column  1. Right-click the column you   want to delete.
 2. Select Remove   column.

Note: If the column uses a formula that is referenced in a condition or 
another formula in the inquiry, a warning and a proceed/cancel 
option appear. If the formula is referenced in a link, no warning 
appears.

Hide a column Hiding an inquiry column.

Change a column Right-click the column, and click Properties.   Change the properties for the 
column.

Show only data for 
a specific time 
period

Display   inquiry data for only a specific time period.

Show only data for 
the current user

Showing only inquiry data pertaining to a user.

Sort by a column Right-click the column and select one of the following: 
 l Sort ascending - shows numbers   from lowest to highest, or shows 

text in alphabetical order
 l Sort descending - shows numbers   from highest to lowest, or shows 

text in reverse alphabetical order
You can also further sort the inquiry by selecting another column to   sort. Ajera 
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To Do this
then sorts the inquiry by applying the sorts in order of the   columns from left to 
right, 

Undo a sort Right-click the column and select Clear   sort.

Group by a 
column

When you group by a column, it groups data in the inquiry into categories   
corresponding to the entries in that particular column. 
Right-click the column heading, and select one of the following: 

 l Group expanded - shows all the   categories with the applicable data 
under them.

 l Group collapsed - shows only   the categories, and you click a plus 
sign next to a category to see the   data for it. 

You can also group within groups by selecting another column to group. 
You can group as many as five columns, creating five different sublevels; after 
this, the grouping options are no longer available.

Ungroup a column Right-click the row of a grouped category, and select Ungroup.

Adding a predefined inquiry column
Inquiries contain these types of columns:

 l Columns that automatically   appear when you open the standard inquiry
 l Columns you can add to an   inquiry by simply selecting them from a list (predefined columns)
 l Columns   you can create by writing a formula

To add a predefined inquiry column

 1. Right-click a column heading   where you want to add the new column, and click either Add   column to 
the left or Add column   to the right. The Column Properties window appears.

 2. Click    in the Column field, and select the column that you want to add. 
You can select a regular column or a key   field column.

 3. In the Heading field, change   the name of the column, as needed.
 4. In the Width field, change   the width of the column in inches, if needed.   Use decimals such as .50 for 

one-half of an inch.
 5. You can display   inquiry data for only a specific time period.
 6. Do one of the following   depending if the column contains text, numbers, or dates:
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If it 
contains

Do this

Text  l Click the Text   Format tab.
 l To wrap text to the next   line within a column, select the Wrap   text check box. 

Be sure to select this check box to see all the text for some columns such as 
Address or Phone Numbers.

 l To show only the beginning   of all the text that can appear for an entry in the 
column, select the   Limit number of characters displayed   check box. In the 
Characters Displayed field, enter the maximum number   of characters to show 
for an entry in this column. If you leave it blank,   all characters appear.

Numbers  l Click the Number   Format tab.
 l Change the number of decimal   places you want to show, if needed.
 l In the Negative Amount field,   either leave the selection to show negative 

amounts with parentheses   or select to show them with a minus sign.
 l If you want zero amounts   to appear as a blank, leave the Blank   if zero check 

box selected. To show zeros for zero amounts, clear   the Blank if zero check 
box.

 l If you want to print a total   line, leave the Show totals check   box selected. 
Otherwise, clear the check box. 

 l The formula for the column must be in the format of either A/B or A/B * 100. 
Otherwise, an error message appears and you cannot save the column until 
you correct the formula or clear the Percent column check box. 
To indicate that the values in the column are percentages, select the Percent 
column check   box. This ensures that the percentages total correctly. 

Dates  l Click the Date   Format tab.
 l In the list, click the date   format that you want for dates in the inquiry.

 7. As needed, link   the column to another inquiry.
 8. Click OK.

Note: If you   add columns containing the same information but with different date ranges   (for 
aging, for example), you can click the Properties   button on the Inquiry toolbar and set 
conditions on them.

Creating a new inquiry column
If you do not see the column you want to add   from the predefined list of columns, you can create your own 
column   by defining a formula for it. 

To create a new inquiry column

 1. Right-click a column heading   where you want to add the new column, and click either Add   column to 
the left or Add column   to the right. The Column Properties window appears.

 2. In the Column field, select   Formula. Additional fields appear   on the window.
 3. In the Heading field, type   a name for the new column.
 4. In the Width field, type   the width of the column in inches. Use decimals such as .50 for half of an inch.
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 5. Type a name for the formula   in the Formula Name field. You can use this formula when setting   
conditions for this inquiry. However, you cannot use the formula in   other inquiries. 
If you plan to use this same formula in other inquiries, copy and paste   it to a temporary file so you can 
then paste it into another inquiry without   retyping it. If you want, after Step 8, you can press Ctrl+A in 
the Formula area to select the entire formula and then copy it.

 6. In the Formula field, click   . The Formula Editor window appears.
 7. Build your formula by clicking   items in the Available Columns area of the window, and then typing 

operators   to define the relationship between those items. Existing formulas in the inquiry also appear 
in the Available Columns area. 
If the Show non-numeric columns check box is selected, all numeric and non-numeric available 
items appear, including existing formulas and the Current User Key. 
 l To   select an item, click it in the list. It appears in the Formula area of   the window.
 l Type   any of the following operators directly into the Formula area of the window: 

Operator Description
+ Addition

- Subtraction

* Multiplication

/ Division

You can also use other Microsoft SQL Server functions. However,   if you use SQL statements, you 
must write them using the actual database   names for columns, not those displayed in lists.
More about creating formulas

 8. Click the Verify   button. If Ajera cannot process your formula, it displays an error message.   Correct 
the formula, and click the Verify   button until Ajera no longer displays an error message.

 9. If the formula results in a percentage and is in the format of A/B or A/B * 100, right-click the column 
heading and select Properties. On the Number Format tab, select the Percent column check box. 
This ensures that the percentages total correctly. 
If the formula is not in the correct percentage format, an error message appears, and you cannot save 
the column until you correct the formula or clear the Percent column check box.

 10. Click OK.

Note:  l If needed, you can   right-click the column heading and select Properties to set 
conditions on the formula. 

 l If the formula uses the SQL Min/Max function, you can right-click   the column 
heading and apply   a date range. 

 l If you delete a column that uses a formula referenced in a condition or another 
formula in the inquiry, a warning  and a proceed/cancel option appear. If the 
formula is referenced in a link, no warning appears.

Hiding an inquiry column
If your security settings allow you to change inquiries, you can change an inquiry so that it hides a column all 
the time or hides a column only when it contains no data.
For example:
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 l You might hide a column all the time if the sole purpose of the column is to be referenced by another 
column or a formula. The information in the column itself is not important to you. 
For example, you use an order key to sort an inquiry. You don't want the column to appear.

 l You might hide a column when it contains no data if you are using an inquiry more as an information 
source, rather than a formal report. You want to see information only if it is available. 
For example, you add the Written off column to the Project inquiry, but want the column to appear 
only if there is a written-off amount.

To hide an inquiry column

 1. From the  >  Reports > Standard Inquiries or Custom Inquiries menu, select the inquiry you 
want.

 2. Right-click the heading of the column you want to hide, and click Properties. 
 3. On the General tab, from the Visibility field, select:

 l Hide If No Data to hide the column if it contains no data.
 l Always Hide to hide the column all the time.

 4. Click OK.

 5. The  button appears in the Inquiry toolbar. If you click this button, all hidden 
columns appear in the inquiry, with their headings dimmed to indicate that the columns are normally 
hidden. 

Note: If you preview, print, or export an inquiry with hidden columns shown, then those columns 
also appear in the previewed, printed, or exported file. 

 6. The   button appears in the Inquiry toolbar; click this button to hide the columns 
again.

Note: If you preview, print, or export an inquiry with hidden columns hidden, then those columns 
do not appear in the previewed, printed, or exported file. 

Showing inquiry data pertaining only to the user
If your security settings allow you to change inquiries, you can change an inquiry so that it shows data 
pertaining only to the current user. 
This change affects only employee key fields. It allows different employees in your firm to log into Ajera, use 
the same inquiry, and see only their data because Ajera has identified the current user from the login 
information.
You can limit inquiry data to the current user in the following:

 l A formula column
 l An inquiry
 l A link

Showing user data in a formula column
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You can use a formula to create an inquiry column so that the column shows only the data pertaining to the 
current user. 
For example, you create a formula column in the Project inquiry (SELECT [Cost] where [Billing Manager Key] 
= [Current User Key]). When billing managers log into Ajera and use the inquiry, they see cost only on projects 
for which they are the billing managers.
To create a column using a current user formula:

 1. Follow Steps 1-6 in Creating a new inquiry column.
 2. Select the Show non-numeric columns check box. The Current User Key appears at the bottom of 

the Available Columns area. 
 3. Build your formula by clicking Current User Key and other  items in the Available Columns area, and 

typing operators   to define the relationship between those items. Existing formulas in the inquiry also 
appear in the Available Columns area. 

Note: You can also use other Microsoft SQL Server functions. However,   if you use 
SQL statements, you must write them using the actual database   names for 
columns, not those displayed in lists.
More about creating formulas

 4. Click the Verify   button. An error message appears if Ajera cannot process your formula.   Correct the 
formula, and click the Verify   button until the error message no longer appears.

 5. Click OK.

Note:  l You can   right-click the column heading and click Properties to set conditions on the 
formula. 

 l If you delete a column that uses a formula referenced in a condition or another 
formula in the inquiry, a warning  and a proceed/cancel option appear. If the formula 
is referenced in a link, no warning appears.

Showing user data in an inquiry
You can set a condition for an inquiry so that the inquiry shows only the data pertaining to the current user. 
For example, you set a condition for the Payroll Accrual inquiry (Employee Key Is Current User). When 
employees log into Ajera and use the inquiry, they see only their accrued hours, not their coworkers' hours. 
To set a current user condition for an inquiry:

 1. From the  > Reports > Standard Inquiries or Custom Inquiries menu, select the inquiry you 
want.

 2. Click  .
 3. Click the Conditions tab.

 4. In the field that contains text asking you to select a column, click  and select an employee key field 
(for example, Project Manager Key).

 5. In the field to the right, select Is Current User.
 6. Click OK.
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Showing user data in an link
You can set a condition for a link so that when you click the link, it opens the linked inquiry with data that 
pertains only to the current user. 
To set a current user condition for a link:

 1. From the  > Reports > Standard Inquiries or Custom Inquiries menu, select the inquiry you 
want.

 2. Right-click the heading of the column containing the link, and click Properties. 
 3. Click the Link   tab.

 4. In the field that contains text asking you to select a column, click  and select an employee key field 
(for example, Principal In Charge Key).

 5. In the field to the right, select Is Current User.
 6. Click OK.

Changing an inquiry
You cannot change a standard inquiry, but you can use it to create   a new inquiry. 

To change an inquiry

 1. From the  >  Reports > Standard Inquiries  menu, click the inquiry you want to change.
 2. Change   the columns on the inquiry, as needed. You can add, move, delete,   and sort columns. You 

can also group information and link to other inquiries.
 3. Click the Properties   button. 
 4. Change the short description   in the Informational Text field, as needed.
 5. Set   conditions or change   conditions to limit the data that appears in the inquiry.   
 6. Do one of the following:

 l To save your changes as a new inquiry, click Save as, type the new name in   the Custom Inquiry 
Name field, and click OK.

 l To apply your changes to the existing inquiry, click   Save.

Deleting an inquiry
You cannot delete a standard inquiry, but you can delete an inquiry   that you create.

To delete an inquiry

 1. From the  >  Reports   menu, click Custom Inquiries > Manage Custom Inquiries.   
 2. Click the row of the inquiry   you want to delete, and click the Delete   button.
 3. Click OK   to delete it.
 4. Click Close.
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Other tasks

Adding a link to an inquiry
You can add a link to an inquiry so that whenever you click the link,   it displays another inquiry that contains 
related information. For example,   on the Project Manager inquiry, you may want to add a link to expense   report 
information. 
When you add a link, all rows in the column show as a link. However,   depending on the conditions you set for 
the link, when you click a link,   it opens the linked inquiry with data that pertains only to the row you   clicked. 
For example, if you click a link in the Anderson Construction   row of a Client Invoices column, the inquiry 
shows only client invoices   for Anderson Construction. 

Note: When you   view an inquiry by clicking a link to it from another inquiry, you can   then 
temporarily set conditions for it and add links on it, but they are   not saved. You must set the 
conditions on the link you use to open the   inquiry. 

You can also access the inquiry from the  > Reports > Standard Inquiries  menu, as 
described in the following instructions, and then set conditions   for it and add links on it.

To add a link to an inquiry

 1. From the  > Reports > Standard Inquiries Inquiry   menu, select the inquiry where you want to 
add a link.

 2. To add a link to an existing   column, right-click the column heading and select Properties. The 
Column Properties window appears.

 3. Click the Link   tab.
 4. Select the inquiry where   you want the link to go. 
 5. If you want the destination   of your link to show only specific information associated with the row   you 

click, proceed to the next step of these instructions to set conditions   for the link. 
Otherwise, click OK,   and you are finished adding the link. 

Setting conditions for the link

 6. In the field on the left   that contains text asking you to select a column, click    and select the column 
in the linked inquiry where you want to set a condition.   Even if a column does not appear on the 
inquiry, you can still set conditions   for it that affect the information that appears on the inquiry.

Note: You can select a regular column or a key   field column.

 7. Two fields appear to the   right where you set the conditions for the column you selected. The Condition
   field contains an operator and the second field contains a value or column   from the inquiry where you 
are adding the link.
You set conditions much in the same way you   write a formula. You define a relationship between the 
column you selected   and another value or column. Begin by exploring   the available options in both of 
these fields.  
Examples
In this example, you add a link on the Project   inquiry to the Contact inquiry. You want to show the 
billing contact   only for the project, not all billing contacts for all projects. In the last   field on the right, 
you selected a column; therefore, when displaying   the result of the link, Ajera compares the values in 
the columns you selected   for the first and last field on this row.
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In this example, you add a link on the Client   inquiry to the Client Invoice inquiry. You want to show 
only client invoice   amounts greater than 10,000. In the field on the right, you selected a   value; 
therefore, when displaying the result of the link, Ajera compares   the column contents with that value.

 8. In the Condition field,   select an operator that expresses the relationship you want to establish   
between the column you selected and the value or column in the last field   on the right. 

 9. In addition to the standard   mathematical operators, you may also find these operators useful:

Operator Description
One Of Use this operator to select more than one value. In the field at the   far right, type the 

values separated by a semicolon ;
For example, if your column is Status and you want to show all invoices   that have a 
status of active or preliminary, you enter the following in   the field at the far right: 
active;preliminary

Not One 
Of

Use this operator to select all but a specific value or values. In the   field at the far right, 
type the values separated by a semicolon ;
For example, if your column is Status and you want to show all invoices   except those 
that have a status of inactive or preliminary, you enter   the following in the field at the 
far right: inactive;preliminary

Matches 
Pattern

Use this operator to show only data that fits a certain pattern. 
When typing a value in the field at the right:

 l Use an underscore to represent a character.
 l Use % to represent any number of characters.

For example, to show all invoice IDs that contain 200 in the same position   as this ID: 
07-200-090G1, you enter %200%.

Is 
Current 
User

For employee key fields, use this operator to show data pertaining only to the current 
user.
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 10. In the last field on the   right, select a column or type a value.
 11. You can set additional conditions,   as needed. Notice that a selection field now appears on the next 

row for   you to set another condition. The order of the conditions does not matter,   as all conditions are 
always applied regardless of order.

 12. To delete a condition, click   the Delete button at the far right   of the condition.
 13. Click OK.

Changing an inquiry link

To change an inquiry link

 1. Right-click the column heading   of the column that contains the links you want to change, and click                 
Properties. 

 2. Click the Link   tab.
 3. To direct the link to a   different inquiry, in the first field on the window, click the arrow and   select the 

inquiry you want.
 4. If needed, change   the conditions for the link, or delete a condition by clicking the   Delete button next to 

it. 
 5. Click OK.

Removing a link from an inquiry

To remove a link from an inquiry

 1. Right-click the column heading   for the link you want to remove, and click Properties. 
 2. Click the Link   tab.
 3. In the field near the top   of the window that displays the link destination, select the blank entry, which 

indicates None.
 4. Click OK.

Setting conditions for an inquiry
You can set conditions to limit the data that appears in an inquiry.   For example, you may want to see only 
active projects on a Project inquiry.
You set conditions for an inquiry by setting conditions for one or more   of the columns on that inquiry.

Note: When you view an inquiry by clicking a link   to it from another inquiry, you can temporarily set 
conditions for it   but they are not saved. Instead, access the inquiry from the Inquiry menu 
and then set conditions for it, as   described in the following instructions. You can also set the 
conditions   on the link you use to open the inquiry. 

To set up conditions for an inquiry

 1. From the  >  Reports > Standard Inquiries or Custom Inquiries   menu, select the inquiry you 
want. 

 2. Click .
 3. Click the Conditions   tab. 
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 4. In the field that contains   text asking you to select a column, click  and select the column on which 
you want to   set a condition. Even if a column does not appear on the inquiry, you   can still set 
conditions for it that affect the information that appears   on the inquiry.

Note: You can select a regular column or a key   field column.

 5. Two fields appear to the   right where you set the conditions for the column you selected. 
You set conditions much in the same way you   write a formula. You define a relationship between the 
column you selected   and another value or column. Begin by exploring   the available options in both of 
these fields.  

 6. In the middle field to the   right, select an operator which expresses the relationship you want to   
establish between the column you selected and the value or column in the   last field on the right. 

 7. In addition to the standard   mathematical operators, you may also find these operators useful:

Operator Description
One Of Use this operator to select more than one value. In the field at the   far right, type the 

values separated by a semicolon ;
For example, if your column is Status and you want to show all invoices   that have a 
status of active or preliminary, you enter the following in   the field at the far right: 
active;preliminary

Not One 
Of

Use this operator to select all but a specific value or values. In the   field at the far right, 
type the values separated by a semicolon ;
For example, if your column is Status and you want to show all invoices   except those 
that have a status of inactive or preliminary, you enter   the following in the field at the 
far right: inactive;preliminary

Matches 
Pattern

Use this operator to show only data that fits a certain pattern. 
When typing a value in the field at the right:

 l Use an underscore to represent   a character.
 l Use % to represent any number   of characters.

For example, to show all invoice IDs that contain 200 in the same position   as this ID: 
07-200-090G1, you enter %200%.

Within 
Last X 
Days

For date fields, use this operator to show only data for a date range   based on the 
current date.
In the field at the right, type the number of days, as follows:

 l Type 0 to include data for   only today's date.
 l Type a positive number to   include data for that number of days before today's 

date and today's date.
 l Type a negative number to   include data for that number of days after today's 

date and today's date.
For example, you type one of the following in the field at the right:

 l 0 to include data for today   only
 l 1 to include data for yesterday   and today 
 l -1 to include data for tomorrow   and today 
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Operator Description
Not 
Within 
Last X 
Days

For date fields, use this operator to exclude data for a date range   based on the current 
date.
In the field at the right, type the number of days, as follows:

 l Type 0 to exclude data for   only today's date.
 l Type a positive number to   exclude data for that number of days before 

today's date, today's date,   and all future dates.
 l Type a negative number to   exclude data for that number of days after today's 

date, today's date,   and all past dates.
For example, you type one of the following in the field at the right:

 l 0 to exclude data for today   only
 l 1 to exclude data for yesterday,   today, and the future (includes data for before 

yesterday)
 l -1 to exclude data for the   past, today, and tomorrow (includes items after 

tomorrow)

Is 
Current 
User

For employee key fields, use this operator to show data pertaining only to the current 
user.

 8. In the last field on the   right, review the values that are available and make a selection.
 9. You can set additional conditions,   as needed. Notice that a selection field now appears on the next 

row for   you to set another condition. The order of the conditions does not matter,   as all conditions are 
always applied regardless of order. 

 10. To delete a condition, click   the Delete button at the far right   of the condition.
To save the conditions,   click OK.

Changing or deleting inquiry conditions

Note: When you view an inquiry by clicking a link   to it from another inquiry, you cannot set 
conditions for it then as they   are not saved. You must access the inquiry from the Inquiry 
menu and then set conditions for it, as   described in the following instructions. 
You can also set the conditions   on the link you use to open the inquiry.

To chance or delete inquiry conditions

 1. From the  >  Reports > Standard Inquiries   menu, select the inquiry you want. 

 2. Click   at the upper right of the window.   
 3. Click the Conditions   tab. 
 4. Set   another condition, or change existing conditions by changing   the information in the fields as 

needed.
 5. To delete a condition, click the    Delete button to the right   of it.
 6. Click OK.
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Displaying data in a column for a specific time period
For many date columns and certain columns that contain dollar amounts or hours,   you can select to display 
only data for a specific time period. 
To determine if a column accepts a date range, right-click the column and click Properties to see if the 
General tab contains the Date Range field.
You restrict data that appears in a column by using the Column Properties window. In that window, you can 
assign the column one of the following:

 l Cutoff   date or date range
 l Time   period based on the current date or cutoff date

Note:  l When you set a time period for a column, that time period applies only   to data in that 
column, not the entire   inquiry. If no data applies to the time period you set, the 
inquiry   displays blank rows in that column.

 l When you apply a date range to a column and set a condition on an inquiry, any rows 
that don't meet both the date range and the condition do not appear. 
For example, you set a condition on the Vendor Invoice inquiry that the invoice 
amount must be greater than $500. You then apply a date range of Range Prompt to 
the Invoice Amount column. Any invoices with amounts less than $500 and not 
within the range prompt entered are omitted.

 

Assigning a cutoff   date or date range
 1. Right-click the column heading   (where you want to display only information which occurs on or before   

a specific date or within a range of dates), and click Properties. 
 2. In the Date Range field,   select either Cutoff prompt or   Range prompt.

If you 
select

Then

Cutoff 
prompt

Ajera assigns the current date as the cutoff date and displays it at   the top of the inquiry 
in blue underlined text. 
To change the cutoff date, click the blue underlined text, and select   a date

Range 
prompt

Ajera displays All   Dates at the top of the inquiry in blue underlined text.  
If you assigned a cutoff prompt to another column in the inquiry,   the blue underlined 
text appears as 01/01/1900   - <current   date >.

Click the All   Dates text, and select the date range you want to assign to the   column.
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Note:  l About Cutoff prompt and Range prompt text. Although   the prompt text 
appears at the top of the report, it applies to only the   columns where you assigned 
dates, not   to every column on the report. You must assign the date to each   
column where you want it to apply.  
If you set different cutoff or range dates   for other columns, the prompt at the top 
applies to all columns where   you assigned date conditions. If you have a mixture 
of cutoff and range   dates, the cutoff condition uses the latest date   in the date 
range.   

 l Rename the column. When you apply   a date condition to a column, change the 
title of the column to reflect   it. In this way, you later know what information you 
are seeing in a column.   For example, you may retitle a column that reflects   the 
billed amount for the third quarter from Billed to Billed Q3. To later   check the date 
condition you assigned to a specific column, right-click   the column heading and 
click Properties.  

 l Keep date restrictions simple. Unless you have a specific   need and 
understand what you want to accomplish, do not assign different   types of date 
restrictions to different columns. 

Assigning   a time period based on the current date or cutoff date
In addition to the Cutoff Prompt and Range Prompt, other options are   available. These options, such as 91   to 
120 days ago are helpful when you want to view aging (such as   client invoice aging) or payroll information 
(such as QTD ).
Ajera bases the time period on the current date. However, if you already   used a cutoff date for another column, 
then it uses the cutoff date, which   appears in blue underlined text at the top of the inquiry.

 1. Right-click the column heading   you want to show and click Properties. 

 2. In the Date Range field,   select the option you want.
 3. Click OK.
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Displaying data in an inquiry for a specific time period
To display only data for a specific time period that affects every   column in the entire inquiry, you set a 
condition in the Inquiry Properties window.   This condition controls what rows show in the inquiry. 
When you set a condition for the entire inquiry, Ajera uses it first,   and then applies any conditions you set for 
columns. For example, you   set an inquiry condition to show only data later than August 1 and a column   
condition to show only data 30 days later than the system date, which   is September 1. The inquiry displays 
blank rows in the column if the data   for that row is before September 31.

Note: When you apply a date range to a column and set a condition on an inquiry, any rows that 
don't meet both the date range and the condition do not appear. 
For example, you set a condition on the Vendor Invoice inquiry that the invoice amount must 
be greater than $500. You then apply a date range of Range Prompt to the Invoice Amount 
column. Any invoices with amounts less than $500 and not within the range prompt entered 
are omitted.

To display data in an inquiry for a specific time period

 1. Click  .
 2. Click the Conditions   tab.

 3. Using the three fields on   the next available row, write a simple formula that expresses the exact   data 
you want to display in the inquiry, as follows:

In this field Do this
Field at left Select the date column you want to use.

Field in middle Enter an operator:
> for greater than
< for less than 
= for equal to

Field at right Either select the type of date, or type a date in mm/dd/yyyy format.

 4. Click OK.

Producing inquiries

Viewing and printing an inquiry
To view and print an inquiry
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 1. To open an inquiry, select   it from the  >  Reports > Standard Inquiries or Custom Inquiries 
menu.

 2. To preview the inquiry as   it appears when printed, click  , and select Print Preview.  

To then return to the normal view, click    , and select Print Preview   again.

 3. To set margins, page orientation,   and paper type for printing the inquiry, click  , and select 
Page   Setup.

 4. To print the inquiry, click    , and select Print.

Exporting to Excel

Exporting an inquiry to Excel
You have three options when exporting an inquiry to Excel.

Note: Excel   does not allow the following characters: \ / : * ? [ ]. If   the inquiry name contains these 
characters, they are removed during the   export. 

Choose this To get this
Microsoft Excel (.xls) An Excel file of the data displayed in the inquiry with groups and subtotals   

retained. Links are highlighted but not active. 
You cannot apply Excel tools such as graphs and pivot tables to the   data.

Microsoft Excel 
Preview - Data   Only

A preview in Excel of the data in the inquiry with groups and subtotals   not 
retained. 
You can apply Excel tools such as graphs and pivot tables to the data.

Microsoft Excel - Data   
Only (.xls, .xlsx)

An Excel file of the data in the inquiry with groups and subtotals not 
retained. 
You can apply Excel tools such as graphs and pivot tables to the data.

Note: This is   similar to the preceding option, except it creates an 
Excel file, rather   than a preview.

Exporting to Excel (.xls)
This option exports only the data displayed in the inquiry to Excel.   Choose this option if you want only an 
Excel copy of the inquiry results.

 1. From the  >  Reports > Standard Inquiries   or Custom Inquiries menu, click the inquiry you want 
to export.

 2. In the toolbar at the top   of the window, click the Export   button, and select Microsoft Excel (.xls). 
 3. Browse to the location where   you want to save the inquiry.
 4. Type a name in the File   Name field, and select a format in the Save as Type field.
 5. Click Save.

Exporting to Excel - Data Only (.xls, .xlsx)
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This option exports the inquiry data to Excel, including inquiry rows   that are not displayed. The amount of data 
that can be exported depends   on your operating system and version of Excel. If the data is too large,   set 
inquiry properties to limit the number of rows.
Choose this option if you want to apply tools such as graphs and pivot   tables to the data in Excel. 

 1. From the  >  Reports > Standard Inquiries   or Custom Inquiries menu, click the inquiry you want 
to export.

 2. In the toolbar at the top   of the window, click the Export   button, and select Microsoft Excel -   Data 
Only (.xls, .xlsx). 

 3. Browse to the location where   you want to save the inquiry.
 4. Type a name in the File   Name field, and select a format in the Save as Type field.
 5. Click Save.

Note: You can   export the data to an existing Excel file. If the inquiry name and the   sheet tab name 
in the existing Excel file are the same, the Excel data   is overwritten. If the inquiry name and 
sheet tab name are different,   a new sheet with the exported data is added to the Excel 
workbook.

Exporting to Excel Preview - Data Only
This option previews the inquiry data in Excel, including inquiry rows   that are not displayed. The amount of 
data that can be previewed depends   on your operating system and version of Excel. If the data is too large,   
set inquiry properties to limit the number of rows.
Choose this option if you want to immediately view the inquiry data   in Excel and apply tools such as graphs 
and pivot tables. 

 1. From the  >  Reports > Standard Inquiries   or Custom Inquiries menu, click the inquiry you want 
to export.

 2. In the toolbar at the top   of the window, click the Export   button, and select Microsoft Excel Preview   - 
Data Only. A preview in Excel of the inquiry appears. 

 3. To save the data in an Excel   file, from the File menu or Microsoft Office button, select Save As.
 4. Browse to the location where   you want to save the inquiry.
 5. Type a name in the File   Name field, and select a format in the Save as Type field.
 6. Click Save.

Exporting an inquiry to Outlook
To export an inquiry to email, you must have Microsoft Outlook 2002 or greater installed.

To export an inquiry to Outlook

 1. From the  >  Reports > Standard Inquiries or Custom Inquiries   menu, click the inquiry you want 
to export.

 2. In the toolbar at the top   of the window, click the Export   button, and select Send as Email (Outlook). 

Note: If Microsoft Outlook 2002 or greater is not installed, an error message appears.
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 3. A new email window appears, with the inquiry attached as a PDF file to the email and the name of the 
inquiry displayed in the Subject Field. You can change the contents of the Subject field, as needed.

 4. Enter an email address in the To field, and type a message to the recipient in the message area.
 5. Click Send.

Exporting an inquiry to Acrobat

To export an inquiry to Acrobat

 1. From the  > Reports > Standard Inquiries or Custom Inquiries   menu, click the inquiry you want 
to export.

 2. In the toolbar at the top   of the window, click the Export   button, and select Adobe Acrobat.   
 3. Browse to the location where   you want to save the inquiry.
 4. In the File Name field,   type a name for the file.
 5. Click Save.

Exporting an inquiry to another database
If your firm is using only one database, inquiries that you create automatically   appear on the Inquiry menu for 
employees whose security settings allow   them access. 
You only need to export an inquiry when you want to do one of the following:

 l Share it with others   who are using a different database. 
 l Back up your custom inquiries before installing an Ajera update that contains Inquiry changes.

To export an inquiry

 1. From the  >  Reports   menu, click Custom Inquiries > Manage Custom Inquiries.   
 2. Click the inquiry that you   want to export. 

Note: To select more than one inquiry, press the Ctrl   key while clicking on the next inquiry.

 3. Click the Export   button.
 4. Browse to the location where   you want to export the inquiry, and click OK.   The file name includes a 

file extension of .iq to indicate that it is   an inquiry.
 5. An employee with access   to the other database must now import   the inquiry into that database. It then 

appears on the Inquiry menu   for all employees with security access to it.

Importing an inquiry from another database
If your firm is using only one database, inquiries that other employees   create automatically appear on the 
Inquiry menu if your security settings   allow you access to them.
You only need to import an inquiry when one of the following occurs:

 l Another person (such as your   consultant) creates the inquiry in a different database and then exports   
it for your use. 

 l You backed up your custom inquiries by exporting them so that you could install an Ajera update that 
contains Inquiry changes. 

To import an inquiry
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 1. Save the inquiry you want   to import to a location accessible to you.

 2. From the  >  Reports   menu, click Custom Inquiries > Manage Custom Inquiries.   
 3. Click the Import   button.
 4. Browse to the location where   the inquiry is stored. Inquiries have a file extension of .iq. Select   the 

inquiry, and click Open. 
 5. Close the Manage Custom   Inquiries window. The inquiry appears on the Inquiry menu for all 

employees   with security access to it.

Financial statements

About financial statement designs
Overview
Worksheets in a workbook
Financial Statement Designer
Reporting entities
Statement groups

Overview
Use the Financial Statement Designer to create the financial statement designs you want. You  can create and 
print balance sheets, profit and loss statements, statements of cash flow, company budgets, key ratios, and 
other financial statements needed by your firm.
You can begin in one of two ways: (1) start with a blank worksheet   and create your own design, or (2) open a 
template and make changes to fit your needs. 

Worksheets in a workbook
If you want, you can design a different financial statement   on each worksheet in the workbook. For example, a 
workbook can contain   worksheets for a balance sheet, profit and loss statement, and statement   of cash 
flows. 
Each workbook contains a Workbook Properties   sheet that allows you to set global properties for each 
worksheet   and for the entire workbook. 

Financial Statement Designer
The basic actions in the Financial Statement Designer are select,   define, and view:

 l You select cells in the worksheet.
 l You use properties or manually   entered text to define the selection.
 l You then view the results on the Preview tab, changing the design as needed.

Design tab
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Use the Design   tab of the Financial Statement Designer to define the contents and appearance   of your 
statement. 
The tab is divided into three sections:   

 l The   toolbar is where you apply fonts   and other style options to the selected cell, row, or column. 
 l The   worksheet is where you select   the cell, row, or column that you want to define. 
 l The   properties area is where you   define the contents of the selected cell, row, or column. 
The properties area displays different options   depending on what you select in the worksheet. 

Preview tab
Use the Preview tab to view   the statement with values from your Ajera database. 
Click     (Refresh) to update your information on the Design   and Preview tabs.
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Reporting entities 

unavailable in ajeraCore unless you have the Departments add-on
You   can also add reporting entities   to your design to create comparative financial statements or multilevel   
profit and loss statements. Reporting   entities are groups of department that you create for financial reporting.

Statement groups
A statement group is one or more financial statements that you or others in your firm can preview or print 
without using the Financial Statement Designer. 
The benefits are:

 l There is no need to access the Financial Statement Designer.
 l You can print more than one statement at a time.

You can create statement groups if you have permission to manage financial statements. You can preview or 
print a statement group only if you are given access to that group. 

Concepts

About defining pieces of a statement
To define the pieces of a financial statement,   you first select a cell, row, or column in the worksheet. You then 
manually enter information or use a property  to define the selection.

Entering information 
You can manually enter information directly   into a cell if a property does not fit your information need.
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For example, you can enter a statement   title, such as Profit and Loss Statement, or you can enter a formula   
to define relationships between cells. 
Ajera supports common spreadsheet formulas.

Using properties 

To define Use these
Contents of a selected 
cell, row, or column

Contents   properties
These properties reference the Ajera database so that when you view or 
print  a statement, it retrieves the current information from the database. 
Because information is not manually entered, properties make a design 
more reusable.
If a property includes a day or time period, it may also reference the   Month-
End Date field   on the Workbook Properties sheet or the Fiscal Year fields 
in  > Setup > Company >  Preferences.
To apply:

 1. Select a cell, row, or column   in the worksheet.
 2. Choose an option in the   properties area. When you select a 

contents property, a label for it appears   in the worksheet.

Appearance of a 
selected cell, row, or 
column

Formatting   properties
These properties determine font styles, text alignment, numerical 
precision,   number format, and borders.
To apply:

 1. Select a cell, row, or column   in the worksheet.
 2. Choose an option in the   toolbar.

Certain aspects that 
apply to a statement or 
to all statements in a   
workbook

Global   properties
These properties include the print settings, accounting basis, appearance   
of elements such as currency symbols, and date on which the financial   
information is based in a statement.
To apply:

 1. Click the Workbook   Properties subtab.
 2. Select a property.

About the Month-End Date field
To determine the time period for the financial information in your statement, Ajera uses the Month-End Date 
field on the Workbook Properties sheet  in conjunction with the following:

 l Fiscal Year fields in  > Setup > Company > Preferences

 l Multi-company only. Fiscal Year fields in  > Setup > Company > Companies
 l Content List   options (if selected) that are based on the Month-End Date field

For descriptions of all the Content List options, see Content List options.
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Following are examples of how some of the Content List options work in conjunction with the Month-End Date 
field and the Fiscal Year fields. The examples are not meant to be comprehensive.

If you have the following fiscal year and month-end dates:

This date Is
Fiscal Year Start January 1, 2012

Fiscal Year End December 31, 2012

Month End December 31, 2012

Then when you do the following:

Select this Amounts for this time period appear
Company button:

Month Start Date December 1, 2012

Month End Date December 31, 2012

For N Months Ended MonthEndDate For 12 Months Ended December 2012

For the N Quarter Ended QuarterEndDate For the 4th Quarter Ended December 31, 2012

Fiscal Year Start Date January 1, 2012

Fiscal Year End Date December 31, 2012

Activity button:

This Month This Year, This Month Last 
Year, This Month Two Years Ago, and so 
on

December 2012, December 2011, December 2010, 
and so on

January This Year, January Last Year, 
January Two Years Ago, and so on

January 2012, January 2011, January 2010, and so on

This Quarter This Year, This Quarter Last 
Year, This Quarter Two Years Ago, and so 
on

4th Quarter 2012, 4th Quarter 2011, 4th Quarter 2010, 
and so on

Balance button:

Current Balance This Year, Current 
Balance Last Year, Current Balance Two 
Years Ago, and so on

Current date 2012, current date 2011, current date 
2010, and so on

Balance Last Quarter This Year, Balance 
Last Quarter Last Year, Balance Two 
Quarters Ago Last Year, and so on

3rd Quarter 2012, 3rd Quarter 2011, 3rd Quarter 2010, 
and so on

Year End Balance This Year, Year End Current date 2012; December 31, 2011; December 31, 
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Select this Amounts for this time period appear
Balance Last Year, Year End Balance Two 
Years Ago, Year End Balance Three Years 
Ago, and so on

2010; and so on

Budget button:

Note: When reporting budget amounts, the QTD and YTD options are based on and 
restricted by the month-end date. The other budget options are based on that date 
but not restricted by it.

Budget This Month This Year, Budget This 
Month Last Year, Budget This Month Two 
Years Ago, and so on

December 2012, December 2011, December 2010, 
and so on

January Budget This Year, January Budget 
Last Year, January Budget Two Years 
Ago, and so on

January 2012, January 2011, January 2010, and so on

Budget This Quarter This Year, Budget 
This Quarter Last Year, Budget This 
Quarter Two Years Ago, and so on

4th Quarter 2012, 4th Quarter 2011, 4th Quarter 2010, 
and so on

Cash Flow button:

This Month This Year, This Month Last 
Year, This Month Two Years Ago, and so 
on

December 2012, December 2011, December 2010, 
and so on

January This Year, January Last Year, 
January Two Years Ago, and so on

January 2012, January 2011, January 2010, and so on

This Quarter This Year, This Quarter Last 
Year, This Quarter Two Years Ago, and so 
on

4th Quarter 2012, 4th Quarter 2011, 4th Quarter 2010, 
and so on

Custom button:

Custom date properties that you define.  l If the entire date property occurs before the 
month-end date, financial information for the 
entire date property appears.

 l If the entire date property occurs after the 
month-end date, no financial information 
appears.

 l If the date property begins before the month-
end date but ends after it, financial information 
from the beginning of the date property through 
the month-end date appears. Example
If the custom date property is from 12/15/2010 
to 1/12/2011 and the month-end date is 
12/31/2010, financial information from 
12/15/2010 to 12/31/2010 appears. 
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Next: Designing   a financial statement

Changing or copying

Changing a financial statement design

To change a financial statement design

 1. Open the design, if needed.
 2. Click   the Design tab.
 3. Change   the global properties for the worksheet or the workbook, as needed. For example, click the 

Workbook Properties subtab and do the following:

To change this Do this
Date on which Ajera determines the 
time period for the financial 
information   in the workbook

Change the date in the Month-End   Date field.

Accounting basis of the workbook Select an option in the Report Basis field.

Department, company, or reporting 
entity of the worksheet

unavailable in ajeraCore unless you have the 
Departments add-on
Select the department or reporting entity to which the 
worksheet is restricted. If you use multi-company, you 
can also restrict by company.
(Select the blank option at the top of a field if you want to 
clear   the selection.)

How zeros, currency, negative 
numbers, commas, and so forth 
display   in the statement

Select an option in those fields.

 4. Change the row or column definitions, as needed. (To view a definition, select a row or column. If a 
property other than a custom date property defines the row or column, it is highlighted in the properties 
area, below the worksheet.) For example, after selecting the row   or column:

To change this Do this
Account in an Amounts row  1. Change the account in the Account Filter 

section.  
 2. Change the row heading accordingly.

Itemization or summarization of an 
account in an Amounts row

Click the Itemized or Summarized button in the 
Grouping section.

Whether an account in an Amounts row 
displays as a positive or negative   value

Select or clear the Reverse sign check box.

Department or reporting entity   in a 
column or an Amounts row 

unavailable in ajeraCore unless you have the 
Departments add-on
Delete or select a different department or reporting 
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To change this Do this
entity in the Row Filter section.

Specific time frame or point in time in a 
column

 1. Select a different time frame or point in time in 
the Content List (for example, Activity This 
Month This Year).

 2. Change the column heading accordingly.

 5. Change   the cell formatting settings, as needed. For example, after clicking the cell or cells:

To change this Do this
Font family, size, 
color, or style

Select an option in the Font group of the toolbar.

Cell border or fill
Click  (Border) in the Font group of the toolbar,   and select an option 
in the Border Editor   window.

Alignment of cell 
contents

Select in option in the Alignment group of   the toolbar.

Merged or split cells
Click  (Merge/Split) in the Alignment group of the toolbar. 

 6. Change   the formula settings, as needed. For example, after clicking the formula   cell:

To change this Do this
Formula Change or enter a new formula. Ajera supports common spreadsheet 

functions.   

 7. Click   the Preview tab to view the results   of your changes. 
 8. Click Save   or Save As to save the workbook.   The workbook appears in the Financial Statement 

Design window for all   employees with access to it.

Copying a financial statement design
You can copy the financial statement design to another worksheet, either   in the same workbook or in a 
different workbook. When you copy a design, all the Workbook Properties settings for that design are copied 
as well.

To copy a financial statement design

 1. Open the design, if needed.
 2. On   the Design tab, click the top-left   cell  in the worksheet to select all the cells in the 

worksheet.

 3. In the toolbar, click   (Copy).
 4. In   the worksheet you want to copy the design to, click the top-left cell      to select all the 

cells.

 5. In the toolbar, click   (Paste).

199 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

Understanding reporting options



 6. Click Save   or Save As to save the workbook.   The workbook appears in the Financial Statement 
Design window for all   employees with access to it. 

Deleting a financial statement workbook

To delete a financial statement workbook

 1. From the  >  Reports   menu, click Manage Financial Statements > Designs.   A blank worksheet 
appears.

 2. Click the Open   button at the bottom. The Financial Statement Design window   appears.
 3. Select the workbook you   want to delete, and click the Delete   button. 
 4. Click Yes   to delete it.
 5. Click Close. 

Changing the Profit and Loss Statement (account groups) template design
The Profit and Loss Statement - Account Groups template creates a profit and loss  statement based on the 
default account groups in Ajera. 
If you have already customized the account groups list for your firm,   you will need to change the template 
design to fit your firm's needs.
To do this:

 l Step 1: Verify the rows
 l Step 2: Verify the columns

Step 1: Verify the rows
Each account group you have set up to print on your current profit and loss  statement will need to appear in the 
statement design in the Financial   Statement Designer.

 1. From   the  >  Reports menu, click Manage Financial Statements > Designs. A blank   worksheet 
appears.

 2. Click Open , and double-click Template - Profit   and Loss Statement - Account groups. The Profit 
and Loss Statement - Account Groups template   design appears. 

 l The   design contains the following sections: Income, Costs, and Expenses. 
 l The   Amounts row in each section is based on an account group. 

 3. In the template design,   start with the first Amounts row in the design. Verify that each Amounts   row is 
correct:
 a. Click the Amounts   row in the worksheet. The account group for that row is highlighted in the 

properties   area, below the worksheet. 

 b. If this account   group does not exist or is incorrect, click  in the Account Group list and select   
the correct account group. (For more information, see Setting   up Amounts rows.)

 4. To   delete an Amounts row, right-click the row and click Delete.

 5. To   add an Amounts row:
 a. Right-click   the totals row and click Insert.   A blank row appears above the current row.
 b. Click the blank   row, and click the Amounts button.
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 c. Click the Account Groups button.

 d. Click  in the Account Group list and select the correct account group.
 e. Click the Summarized button.
 f. Based   on the account group, select or clear the Reverse   sign check box.
For   example, this check box is cleared for the account groups in the Costs   and Expenses sections in 
the design, and selected for the account groups   in the Income section.

 6. If   you have accounts without account groups, you will need to set up new   Amounts rows for these 
accounts so that they appear on the statement.   You can set up an Amounts row by account range, ID 
range, or account type.   (For more information, see Setting   up Amounts rows.)

 7. Click the totals rows and   verify that the formula in each cell is correct. If a formula is incorrect,   double-
click the cell and change the formula. (For more information, see   Setting up totals and Entering   
formulas in the worksheet.) 

Step 2: Verify the columns
Each column you have set up to print on your current profit and loss statement   will need to appear in the 
statement design.
The design contains the following defined columns: This Month, Last   Year, Variance (between months), Year 
to Date, Last Year, Variance (between   years).

 1. In   the Column Setup row, verify that the defined columns match the columns   in your current profit and 
loss statement. 
If a column is not the same, do one of the   following:
 l For a column defined by a property, click the cell,   click a Content List button, and double-click the 

correct option in   the properties area. (For more information, see Setting   up columns.) 
 l For a column defined by a formula, double-click the   cell and change the formula. (For more 

information, see Entering   formulas in the worksheet.) 
 2. To   delete a column, do one of the following:

 l Right-click the column letter at the top of the worksheet   and click Delete.
 l Right-click a defined cell in the Column Setup   row and click Clear Contents.

 3. To   add a column:
 l If needed, right-click a column letter at the top of   the worksheet and click Insert.
 l Click a blank cell in the Column Setup row, and select   the correct option in the properties area or 

enter a formula. 

Changing the Balance Sheet (account groups) template design
The Balance Sheet - Account Groups template creates a balance sheet   based on the default account groups 
in Ajera. 
If you have already customized the account groups list for your firm,   you will need to change the template 
design to fit your firm's needs.
To do this:

 l Step 1: Verify the rows
 l Step 2: Verify the columns
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Step 1: Verify the rows
Each account group you have set up to print on your current balance   sheet will need to appear in the statement 
design in the Financial Statement Designer.

 1. From   the  >  Reports menu, click Manage Financial Statements > Designs. A blank   worksheet 
appears.

 2. Click Open, and double-click Template - Balance   Sheet - Account Group Summary. The Balance 
Sheet - Account Group Summary template design appears.   

 l The   design contains the following sections: Assets, Liabilities, and Equity.   
 l The   Amounts row in each section is based on an account group, except the Net   Income row in 

the Equity section. This row is based on your profit and   loss account types.
 3. In   the template design, start with the first Amounts row in the design. Verify that each Amounts row is 

correct: 
 a. Click the first   Amounts row in the worksheet. The account group for that row appears in   the 

properties area, below the worksheet. 

 b. If this account   group does not exist or is incorrect, click  in the Account Group list and select   
the correct account group. (For more information, see Setting   up Amounts rows.)

 4. To   delete an Amounts row, right-click the row and click Delete.
 5. To   add an Amounts row:

 a. Right-click   the totals row and click Insert.   A blank row appears above the current row.
 b. Click the blank   row, and click the Amounts button.
 c. Click the Account Groups button.

 d. Click  in the Account Group list and select the correct account group.
 e. Click the Summarized button.
 f. Based on the   account group, select or clear the Reverse   sign check box. 
For example, this check box is cleared for   the account groups in the Assets section in the design, and 
selected for   the account groups in the Liabilities and Equity sections.

 6. If   you have accounts without account groups, you will need to set up new   Amounts rows for these 
accounts so that they appear on the statement.   You can set up an Amounts row by account range, ID 
range, or account type.   (For more information, see Setting   up Amounts rows.)

Step 2: Verify the columns
Each column you have set up to print on your current balance sheet will   need to appear in the statement 
design.
The design contains a defined column for Current Balance. Each Amounts   row will print the current balance, 
except for the Equity section. This   section will print the retained earnings balance for the Capital account   
group and this year's activity amount for the Net Income account types.   

To add a column:
 1. If needed, right-click a   column letter at the top of the worksheet and click Insert.
 2. Click a blank cell in the   Column Setup row, and select the correct option in the properties   area or enter 

a formula. 
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Changing the Statement of Cash Flows template design
A statement of cash flow shows you the movement of cash through your company. It presents the cash 
receipts and payments of the company over a period of time. It complements the profit and loss statement by 
providing information on the company's liquidity and financial flexibility. It also show the change of cash and 
cash equivalents during the period.
The Statement of Cash Flows template creates a cash-flow statement based   on the default account groups in 
Ajera. Please work with your CPA to verify that the account groups in the statement   are correct for your firm.
To change the Statement of Cash Flows template, do this:

 l Step 1: Verify the rows
 l Step 2: Verify the columns

Step 1: Verify the rows
Each account group you have set up to print on your current cash-flow   statement will need to appear in the 
statement design in the Financial   Statement Designer.

 1. From   the  >  Reports menu, click Manage Financial Statements > Designs. A blank   worksheet 
appears.

 2. Click Open, and double-click Template - Statement   of Cash Flows. The Statement   of Cash Flows 
template design appears. 

 l The design contains the following sections:   Cash Provided by Operating Activities, Cash 
Provided by Investing Activities,   and Cash Provided by Financing Activities. 

 l The Amounts row in each   section is based on one or more account groups, except the   Net 
Income row. This row is based on your profit and loss account   types.

 3. In   the template design, start with the second Amounts row in the design.   Verify that each Amounts 
row is correct:
 a. Click the row   in the worksheet. The account group for that row appears in the properties   area, 

below the worksheet. 

 b. If this account   group does not exist or is incorrect, click  in the Account Group list and select   
the correct account group. (For more information, see Setting   up Amounts rows.)

 4. To   delete an Amounts row, right-click the row and click Delete.
 5. To   add an Amounts row:

 a. Right-click   the totals row and click Insert.   A blank row appears above the current row.
 b. Click the blank   row, and click the Amounts button.
 c. Click the Account Groups button.

 d. Click  in the Account Group list and select the correct account group.
 e. Click the Summarized button.
 f. Based on the   account group, select or clear the Reverse   sign check box. 

For example, this check box is cleared for   the Accounts Payable Net and Repurchase of 
Common Stock and Dividend Payments   account groups in the design, and selected for the other 
account groups.

 6. If   you have accounts without account groups, you will need to set up new   Amounts rows for these 
accounts so that they appear on the statement.   You can set up an Amounts row by account range, ID 
range, or account type.   (For more information, see Setting   up Amounts rows.)

203 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

Understanding reporting options



 7. Click the totals rows and   verify that the formula in each cell is correct. If a formula is incorrect,   double-
click the cell and change the formula. (For more information, see   Setting up totals and Entering   
formulas in the worksheet.) 

Step 2: Verify the columns
Each column you have set up to print on your current cash-flow statement   will need to appear in the statement 
design.
The design contains the following defined columns: This Quarter, This   Year, Last Year.

 1. In   the Column Setup row, verify that the defined columns match the columns   in your current cash-flow 
statement. 
If a column is not the same, do one of the   following:
 l For a column defined by a property, click the cell,   click a Content List button, and double-click the 

correct option in   the properties area. (For more information, see Setting   up columns.) 
 l For a column defined by a formula, double-click the   cell and change the formula. (For more 

information, see Entering   formulas in the worksheet.) 
 2. To   delete a column, do one of the following:

 l Right-click the column letter at the top of the worksheet   and click Delete.
 l Right-click a defined cell in the Column Setup   row and click Clear Contents.

 3. To   add a column:
 l If needed, right-click a column letter at the top of   the worksheet and click Insert.
 l Click a blank cell in the Column Setup row, and select   the correct option in the properties area or 

enter a formula. 

Printing or exporting

Printing a financial statement
If you have permission to manage financial statements, you can print and verify a statement design from 
within the Financial Statement Designer.
Only the current worksheet prints; you can click the worksheet subtabs and print other financial statements in 
the workbook. 

Note:  l To print a statement group, see Printing a statement group.
 l If a white line appears in your printed statement, check the financial statement 

design. When a hidden row or column intersects with a group of merged cells, any 
text inside the area where they intersect will not print.

To print a financial statement

 1. Open the statement, if needed.
 2. Verify that the Month-End   Date field on the Workbook Properties sheet correctly specifies the   time 

period for the financial information in your statement.
 3. Change the other global   properties for the statement on the Workbook   Properties sheet, as needed. 

For example, you may choose to filter by department or to change the report basis.
 4. Click the Preview tab to view the statement with   values from your Ajera database. 
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 5. If needed, change   the design on the Design tab.   
 6. The statement will print   at the scale selected in the Zoom group on the toolbar. To  print at actual size, 

click the 100% zoom  button.
 7. If you do not want to see the page breaks, click the Print button on the Preview tab. You can skip the 

rest of these instructions.
 8. To see the page breaks, click the Print button on the Design tab. The Print Preview window appears.

 9. Click the page forward and backward    buttons to view the entire statement. You can change 
page   breaks, footers, and column   or row headings, as needed.

 10. Click  (Print).

Exporting a financial statement workbook
Financial statement workbooks that you create automatically appear in   the Financial Statement Design 
window for anyone with access to that window. 
You need to export a workbook only when you want to share it with others   who are using a different database 
in your company or in another company.

Note:  l If the exported design contains a custom date property, only the property label 
exports; none of the other property options are included. Anyone who imports the 
workbook will need to re-create the custom date property. Example

 l A custom date property contains the description January 2011 and the dates 
January 1, 2011, and January 29, 2011. The exported design displays 
[January2011] in the worksheet, but no financial information appears for that 
property because no other property options were included. Anyone who imports 
the design must re-create the custom date property using January 2011 as the 
description and January 1, 2011, and January 29, 2011, as the dates.

 l If the exported design contains a company logo, the logo is embedded into the 
design; it is not an active link to the Ajera database. Anyone who imports the 
workbook may need to delete and add the logo property back into the design to 
ensure that the company logo they want appears.

 

To export a statement workbook to another database

 1. Open the workbook, if needed.
 2. On the Design   tab, click the Export button.
 3. Browse to the location where   you want to export the workbook, and click Save.   The file name 

includes a file extension of .fsd to indicate that it is   an Ajera Financial Statement Designer 
spreadsheet document. Email or share   the document with others.

 4. An employee with access   to the other database must now import   the workbook into that database. It 
then appears in the Financial   Statement Design window for anyone with access to that window.

Exporting a financial statement to Excel
You can export a financial statement to Microsoft Excel 2003. 
The exported statement contains the formulas and financial information from the   Ajera database that you 
specified in the design. It is not linked to the   Financial Statement Designer.  

To export a financial statement to Excel
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 1. Open the statement, if needed.
 2. Click the Preview   tab, and click the Export button.
 3. Browse to the location where   you want to export the statement, and click Save.   The file name 

includes a file extension of .xls to indicate that it is   a Microsoft Excel spreadsheet document.

Importing a financial statement workbook
Financial statement workbooks that other employees create automatically appear in   your Financial Statement 
Design window. 
You need to import a workbook only when another person (such as your   consultant) creates the workbook in a 
different database and then exports   it for your use.

Note:  l If the imported design contains a custom date property, only the property label 
imports; none of the other property options are included.  You must re-create the 
custom date property. 
Example
A custom date property contains the description January 2011 and the dates 
January 1, 2011, and January 29, 2011. The imported design displays 
[January2011] in the worksheet, but no financial information appears for that 
property because no other property options were included. You must re-create the 
custom date property using January 2011 as the description and January 1, 2011, 
and January 29, 2011, as the dates.

 l If the imported design contains a company logo, the logo is embedded into the 
design; it is not an active link to the Ajera database. You may need to delete and add 
the logo property back into the design to ensure that the company logo you want 
appears.

To import a financial statement workbook:

 1. Save the workbook you want   to import to a location accessible to you.

 2. From the  >  Reports   menu, click Manage Financial Statements > Designs.   A blank worksheet 
appears.

 3. On the Design   tab, click the Import button.
 4. Browse to the location where   the workbook is stored. An exported workbook has a file extension of 

.fsd   to indicate that it is an Ajera Financial Statement Designer spreadsheet   document.
 5. Select the workbook and   click Open. The workbook appears   in the Financial Statement Designer.

Note: If the workbook you want to import is from an earlier version of the Financial Statement 
Designer, a window appears asking if you want to update the design. Click Yes. Review 
the workbook properties as some options may have changed.

 6. Click Save   or Save As to save the workbook.   The workbook appears in the Financial Statement 
Design window for anyone with access to that window.

Working in the worksheet

Entering formulas in the worksheet
Follow these instructions as part of designing   a financial statement.
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Note: If you create a formula that references an amounts total, make sure it references a Total cell, 
not an Amounts cell. This makes the formula more robust, especially if the Amounts row is 
summarized and you later decide to change it to itemized.

To enter formulas in the worksheet

 1. Enter a formula. Ajera supports   common spreadsheet formulas. For example: 

For this 
formula 
type

Do this

Amount 
totals of 
adjacent 
rows

 1. Click a row.
 2. Click the Total   button to automatically create a formula that sums the 

values of all the   amount cells between the current row and the preceding 
Total   row or Column Setup row for each   defined column. For example: 
=SUM(B8:$B$9)

 3. In the Format group of the   toolbar, select   Currency.

 4. Click the increase precision      or decrease precision  button in the 
Format group of the toolbar,   as needed.

Amount 
totals of 
nonadjacent 
rows

 1. Double-click a cell.
 2. Press the equals (=) key.
 3. Enter a formula that sums   the values of selected amount cells. Separate 

nonadjacent rows with a   comma. For example: =SUM(B8, B11, B13).
 4. In the Format group of the   toolbar, select   Currency.

 5. Click the increase precision      or decrease precision  button in the 
Format group of the toolbar,   as needed.

Percentages  1. Double-click a cell.
 2. Press the equals (=) key.
 3. Enter a formula that divides   the values of selected cells to determine a 

proportion in relation to   a whole (usually 100). For example, =B5/$B$9.
 4. In the Format group of the   toolbar, select   Percent.

 5. Click the increase precision      or decrease precision  button in the 
Format group of the toolbar,   as needed.

Ratios  1. Double-click a cell.
 2. Press the equals (=) key.
 3. Enter a formula that divides   the values of selected cells to determine how 

many times the first quantity   is contained in the second quantity. For 
example, =D9/D25.

 4. In the Format group of the   toolbar, select   Number.

 5. Click the increase precision      or decrease precision  button in the 
Format group of the toolbar,   as needed.
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 2. Click the Workbook   Properties subtab on the Design   tab, and determine how numbers, currency, 
and percentages will display   in the statement.

 3. Click the Preview   tab to view the results.

Creating footers in the statement
Follow these instructions as part of designing   a financial statement.
You can create footers that appear at the bottom of each page of a printed financial statement; they do not 
appear in the worksheet.
Repeat these instructions for other financial statements in the workbook, as needed.

To create footers in the statement

 1. Open the statement, if needed.
 2. On   the Design tab, click the Workbook Properties subtab.
 3. In the column for that statement, click the cell in the Footer Text row. The Financial Statement Footer 

window appears.
 4. To add a footer to the bottom left of each page, click the Left Section area and double-click an option 

(for example, Page #) in the list near the top of the window. The property label appears in the Left 
Section area.
Repeat for the center and right sections, as needed.

 5. Click OK.

Repeating column or row headings in the statement
Follow these instructions as part of designing   a financial statement.
You can repeat one set of column headings and one set of row headings per financial statement. The column 
headings appear at the top of each printed page, and the row headings appear on the left side of each page.
Repeat these instructions for other financial statements in the workbook, as needed.

To repeat column or row headings in a statement

 1. Open the statement, if needed.
 2. On   the Design tab, select the columns or row that you want to repeat.
 3. Click the Repeat button on the Financial Statement Designer toolbar. The columns or rows are 

shaded blue to indicate that they will repeat in the printed statement. When you scroll through the 
design, the blue-shaded columns or rows remain in place.

 4. If you do not want them to repeat, select the blue-shaded columns or rows on the Design tab and click 
the Repeat button again. The shading is removed.

Inserting page breaks in the worksheet
Follow these instructions as part of designing   a financial statement.
You can insert page breaks into a financial statement design so that   the statement is divided the way you 
want over multiple pages.
Repeat these instructions for other financial statements in the workbook, as needed.

To insert page breaks:
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 1. Open the worksheet, if needed.
 2. On   the Design tab, click the Print button. The Print Preview window   appears.

 3. Click the page forward or   backward  buttons to view the entire statement and   determine 
where to insert page breaks. 

 4. Click the Close   button to close the Print Preview window and return to the Design   tab.
 5. Click a row where you want   to insert a page break, and click the Page   Break button.
 6. Click the Print   button to view the results in the Print Preview window. 
 7. Repeat these instructions   for each page, as needed.

Note: If you   want a page break in the middle of a group of accounts, you must set up   two 
Amounts rows with the appropriate ranges in each row and insert a   page break between 
the two rows. 

Hiding rows or columns in the worksheet
Follow these instructions as part of designing   a financial statement.
The Hide Row or Hide Column button on the Financial Statement Designer toolbar is useful   if you want to 
reference certain information in your design, but do not   want it to appear on the printed statement. Example
To display revenue per employee in a statement,   you manually enter the total number of employees into a cell 
and   hide the cell. In another cell, you   create a formula that references the hidden cell. Before   producing the 
statement, you update the employee number in the cell.

Note: When a hidden row or column intersects with a group of merged cells, any text inside the 
area where they intersect will not print.

To hide a row or column:

 1. Click the row or column   of the cell you want to hide. 

 2. Click   (Hide Row) or     (Hide Column) on the toolbar.
The hidden row or column is shaded in the   worksheet. 

To unhide a row or column:

 1. Click   the row or column you want to unhide. 

 2. Click     (Unhide Row) or   (Unhide Column) on the toolbar.

Adding, deleting, and renaming worksheets
You can use the subtabs at the bottom of the Financial Statement Designer worksheet to   add, delete, or 
rename a worksheet.

To add, delete, or rename a worksheet

 1. Open the worksheet, if needed.
 2. Do the following:
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To Do this
Add a worksheet Click (Insert Worksheet subtab)  . 

Delete a worksheet Right-click a worksheet subtab and click Delete.

Rename a worksheet Double-click a worksheet subtab and enter a new name.

Using shortcut keys in the worksheet
Use these shortcut keys in the Financial Statement Designer as follows:

To do this in the worksheet Press the following on your keyboard
Change or enter a formula Equals sign (=)

Copy a selection and place it on the clipboard Ctrl+C or
Ctrl+Insert

Paste information from the clipboard into selected cells Ctrl+V

Cut a selection and place it on the clipboard Ctrl+X

Move one cell up, down, left, or right Arrow keys

Extend selection by one cell up, down, left, or right Shift+Arrow keys

Move one screen up Page Up

Move one screen down Page Down

Move one screen to the left Ctrl+Page Up

Move one screen to the right Ctrl+Page Down

Extend selection one screen up Shift+Page Up

Extend selection one screen down Shift+Page Down

Extend selection one screen to the left Shift+Ctrl+Page Up

Extend selection one screen to the right Shift+Ctrl+Page Down

Move to first column Home

Move to last column End

Move to first cell Ctrl+Home

Move to last cell Ctrl+End

Extend selection to first cell Shift+Ctrl+Home

Extend selection to last cell Shift+Ctrl+End

Select row Shift+Spacebar

Select column Ctrl+Spacebar
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To do this in the worksheet Press the following on your keyboard
Select sheet Shift+Ctrl+Spacebar

Cancel an entry in a cell or formula bar Esc

Complete an entry in a cell or formula bar Enter

Move one cell to the right Tab

Move one cell to the left Shift+Tab

Right-clicking in the worksheet
The worksheet in the Financial Statement Designer is a spreadsheet of   cells arranged in a 500-row by 500-
column grid. You can perform common   spreadsheet tasks, such as the following:

To do this Right-click this
Cut a selection from the worksheet and 
place it on the clipboard

A cell, row, or column and click Cut.

Copy a selection from the worksheet and 
place it on the clipboard

A cell, row, or column and click Copy.

Paste information from the clipboard into 
selected cells in the worksheet

A cell, row, or column and click Paste.

Insert a row One of the following:
 l A   row and click Insert.
 l A cell and click Insert > Row.

Delete a row One of the following:
 l A   row and click Delete.
 l A cell and click Delete > Row.

Hide a row A row and click Hide.
The hidden row is shaded to indicate that it does not appear 
in the   preview or print on the statement.

Unhide a row A shaded row and click Unhide.
The shown row is unshaded.

Insert a column One of the following:
 l A   column and click Insert.
 l A cell and click Insert > Column.

Delete a column One of the following:
 l A   column and click Delete.
 l A cell and click Delete > Column.

Hide a column A column and click Hide.
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To do this Right-click this
The hidden column is shaded to indicate that it does not 
appear in the   preview or print on the statement.

Unhide a column A shaded column and click Unhide.
The shown column is unshaded.

Apply a border to a cell, row, or column A cell, row, or column and click Borders.

Remove the contents of a cell A cell and click Clear Contents.

Custom date properties

About custom date properties
You create a custom date property in the Financial Statement Designer if the standard Activity, Balance, or 
Cash Flow properties do not provide the time period you want. For example, the Activity property in the 
properties area provides information by month, quarter, or year to date, but you want information by week.
A custom date property consists of a description, beginning date, ending date, and any cash-flow options that 
may apply. For account balances, leave the beginning date blank. Custom account balances will not include 
all previous closing entries. Ajera saves custom date properties to its database, making them available in all 
your financial statement designs.  

About other reporting dates

Custom date properties work in conjunction with the actual date entered in the Month-End Date field on the 
Workbook Properties sheet and with the reporting period in statement groups:

 l If the ending date of the custom date property falls before the date entered in the Month-End Date 
field, Ajera overrides this field and uses the custom ending date. Example
You enter October 17, 2011, as the Month-End Date, and October 10, 2011, as the custom ending 
date. The custom date property provides information through October 10.

 l If the ending date of the custom date property falls after the date entered in the Month-End Date field, 
Ajera overrides the custom ending date and uses the actual date entered in the Month-End Date field. 
Example
You enter October 17, 2011, as the Month-End Date, and October 24, 2011, as the custom ending 
date. The custom date property provides information through October 17.

 l If the ending date of the custom date property falls after the reporting period in a statement group, 
Ajera overrides the month-end date and provides information from the custom beginning date through 
the last day of the reporting period. Example
You enter October 17, 2011,  as the Month-End Date; September 24, 2011, and October 24, 2011, 
as the custom beginning and ending dates, respectively; and September 2011 as the reporting period 
for the statement group. The custom date property provides information for September 24-30, 2011.

About importing

When you import a design from another database, the label for any custom date property appears in the 
worksheet but the beginning date, ending date, and cash-flow options are not included in the design. You must 
re-create the property using the same description, dates, and cash-flow options.
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Creating custom date properties
If the standard Activity, Balance, or Cash Flow properties in the Financial Statement Designer do not provide 
the time period you want, you can create a custom date property. Example 
The Activity property in the properties area provides information by month, quarter, or year to date, but you 
want information by week.

A custom date property consists of a description, beginning date, ending date, and any cash-flow options that 
may apply. Ajera saves the property to its database, making it available in all your Financial Statement 
Designer designs. 

To create custom date properties

 1. Click an Amounts or Column Setup cell in the worksheet. The Content List buttons, options, and   
fields appear. 

 2. Click the Custom button. All available custom date properties appear.

 3. Click  (Plus).
 4. In the Custom Date Properties window, type the name of the custom date property in the Description 

field. The maximum length is 78 characters.
As you type, the Property field displays how the description will appear in the Ajera database. Ajera 
removes any spaces or special characters such as \ / : * ? " < > | , -.

 5. Define the property:  

If you want this Do this
Account activity for a time frame that you specify; 
excludes closing entries

Beginning Date: Enter the first date in the 
date property.

Ending Date: Enter the last date in the date 
property.

Cash Flow Options: Select Not Used.

Account balances at a point in time that you 
specify; excludes closing entries

Beginning Date: Leave blank. 
The field defaults to 1/1/1900.

Ending Date: Enter the last date in the date 
property.
Ajera will total all activity from 1/1/1900 
through the Ending Date.

Cash Flow Options: Select Not Used.

Debit or credit account activity for a time frame that 
you specify

Beginning Date: Enter the first date in the 
date property.

Ending Date: Enter the last date in the date 
property.

Cash Flow Options: Select one of the 
following:

 l Show debits only.
 l Show credits only.
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The beginning and ending dates work in conjunction with the month-end date on the Workbook 
Properties sheet and the reporting period for a statement group. 

 6. Click Save.
 7. Repeat these instructions for each custom date property you want to create.

Changing a custom date property 

To change a custom date property

 1. Click an Amounts or Column Setup cell in the worksheet. The Content List buttons, options, and   
fields appear. 

 2. Click the Custom button. All available custom date properties  appear.

 3. Click the custom date property you want to change, and click  (Change). 
 4. In the Custom Date Property window, change the following information:

Field Description
Description The name of the custom date property. The maximum length is 78 characters.

As you type, the Property field displays how the description will appear in the 
worksheet and in the Ajera database. Ajera removes any spaces or special 
characters such as \ / : * ? " < > | , -.

Retained 
Earnings

If using a non-month-end date, check to reflect the correct balance in the Retained 
Earnings and Net Income rows on the Balance sheet.
Example: To report the balances as of a point in time and display the correct 
amount for Retained Earnings and Net Income, set up all custom Balance Sheet 
date properties as follows:
February 2014 :  Beginning date: 1/1/1901. Ending date:  2/22/14.  Mark the Retained 
Earnings check box.

Date 
Range

The dates for the custom date property, which work in conjunction with the month-
end date on the Workbook Properties sheet  and the reporting period for a statement 
group. 

Field Description
Beginning Date The first date in the date property. 

If you leave this blank, the field defaults to 1/1/1900.

Ending Date The last date in the date property.

Cash Flow 
Options

Any cash-flow options that may apply.
 l Not Used: Select for any financial statement that is not a statement of 

cash flow.
 l Show debits only: Select if you want only debit information to appear in the 

date property. 
 l Show credits only: Select if you want only credit information to appear in 

the date property. 

 5. Click Save or Save As if you want to save it as a new custom date property.
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Deleting a custom date property
Deleting a custom date property from a Financial Statement Designer design is easy. However, because 
custom date properties are stored in the Ajera database:

 l When you delete a property in a design, Ajera deletes the property from its database. 
 l The label of a deleted property appears in the worksheet of any design that uses that property, but the 

beginning date, ending date, and cash-flow options are not included. No financial information for that 
property will appear in the statement.

To delete a custom date property

 1. Click an Amounts or Column Setup cell in the worksheet. The Content List buttons, options, and   
fields appear. 

 2. Click the Custom button. All available custom date properties appear.

 3. Select the custom date property you want to delete, and click  (Minus). 
 4. Click Yes   to delete the custom date property.

Statement groups

About statement groups
A statement group is one or more financial statements that you or others in your firm can preview or print 
without using the Financial Statement Designer. 
You might create a statement group for a project manager that consists of a profit and loss statement, balance 
sheet, and statement of cash flows. Or you might create a statement group comprising two copies of the profit 
and loss statement: one set to print for accrual, and the other for cash basis. 
You must have permission to manage financial statements before you can create or change statement 
groups. Only statements in the Financial Statement Designer format can be included in a group. 
As you do with reports, set security for a statement group so that it is available to all who need it. Coworkers 
with access to the statement group will be able to print or preview it from  > Reports > Financial > Financial 
Statements.
All financial statements in a workbook print when printed as part of a statement group.

Creating a statement group
If you have permission to manage financial statements, you can create statement groups. Only statements 
created in the Financial Statement Designer can be included in a group.
To create a statement group, follow these steps:

 l Step 1: Set up the statement group
 l Step 2: Preview or print the statement group to verify setup
 l Step 3: Set security for the statement group

Step 1: Set up the statement group
Set up a statement group so that it contains the financial statements required for that group. 

 1. From the  >  Reports menu, click Manage Financial Statements > Groups. 
 2. Enter the following information:

215 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

Understanding reporting options



Field Description
Group 
name

A short description of the statement group

Report The workbook you want to add to the statement group
Do the following:

 1. Click .
The Financial Report List window appears, displaying the 
available financial statement workbooks.

 2. Click the workbook you want and click the Select button. 
The workbook name appears and default values appear in 
the other columns.

Report 
basis

The type of accounting basis used for printing the workbook:   accrual 
or cash
Do one of the following:

 l Accept the default value. 
Ajera will use the accounting basis selected on the 
Workbook Properties sheet of the workbook.

 l Click  and change the report basis to Accrual or Cash. 
Ajera will override the accounting basis selected on the 
Workbook Properties sheet of the workbook, if needed. 

Department unavailable in ajeraCore unless you have the Departments add-
on
The department to which the workbook is restricted when printing the 
statement group

Ajera will print information for the department selected, in conjunction 
with any other filters you may have selected in the financial 
statement design.
Do one of the following:

 l Accept the default value.
Ajera will use the department filter selected on the Workbook 
Properties sheet of the workbook.

 l Click  and select to print information for each department 
or an individual department.

Reporting 
entity

unavailable in ajeraCore unless you have the Departments add-
on
The reporting entity to which the workbook is restricted when printing 
the statement group. 

Ajera will print information for the reporting entity selected, in 
conjunction with any other filters you may have selected in the 
financial statement design.

216 – Deltek Ajera 10 © 2024 Deltek Inc. All rights reserved.

Understanding reporting options



Field Description
Do one of the following:

 l Accept the default value.
Ajera will use the reporting entity filter selected on the 
Workbook Properties sheet of the workbook.

 l Click  and select to print information for each reporting 
entity or an individual reporting entity.

Company Multi-company only.

The company to which the workbook is restricted when printing the 
statement group

Ajera will print information for the company selected, in conjunction 
with any other filters you may have selected in the financial 
statement design.
Do one of the following:

 l Accept the default value.
Ajera will use the company filter selected on the Workbook 
Properties sheet of the workbook.

Note: If you select a column in the workbook and apply a 
company filter for the selected column, that selection will 
override any company filters set on the Workbook 
Properties window.

 l Click  and select to print information for each company or 
an individual company.

Copies The number of copies to print
Do one of the following:

 l Accept the default value, which is 1.
 l Enter a different number if you want to print multiple copies.

 3. Click the next row and repeat Step 2 for any financial statement workbook you want to add to this 
group.

 4. Click Save. The statement group appears on the Existing tab.

Step 2: Preview and print a statement group to verify setup
 1. Click the Existing tab.
 2. The reporting period is always set for the previous month. If needed, click   (Change View), select a 

different period, and click OK.
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Note:  l If you select a date range, the end date is used to assign the current month. For 
example, if you enter a date range of 01/15/11 to 02/14/11, the current month is 
considered February 2011.

 l If a statement contains a custom date property, only information as of the period 
selected will be included. For example, if your custom date property contains a 
date range of 9/15/11-10/5/11 and the period selected is September, activity for 
10/1-10/5 will not be included.

 l You can also change the reporting period on the Financial Statement print preview 
window or the Financial Statement preview window. If you change it there, click 

 (Refresh).

 3. Click the statement group, and click the Preview button. 
 4. If you do not want to preview the statement group before printing, click the Print button. Skip the rest 

of these instructions.
 5. To preview the statement group before printing, click the Preview button. 
 6. Do one of the following:

 l If all the statements in the statement group look fine, click the Print button.
 l If you want to make changes or don't need to print, click the Close button and change the 

statement group or change a financial statement design.

Step 3: Set security for the statement group
If needed, set security for the statement group so that it is available to the employees who need it.

 1. From the  >  Setup menu, click Company > Roles.
 2. Select the role you want and click Edit.
 3. On the Reports tab, select the Allow check box   for Financial\Financial Statements\<statement 

group>.  
The statement group now appears under Reports > Financial > Financial Statements for members of 
this role. 

Changing a statement group
If you have permission to manage financial statements, you can change a statement group.

To change a statement group

 1. From the  >  Reports menu, click Manage Financial Statements > Groups.
 2. On the Existing tab, click the statement group you want to change, and click Edit. The statement 

group setup appears, showing the workbooks in the group and their statement group settings.
 3. Change the following settings, as needed:

Field Description
Group 
name

A short description of the statement group

Report The workbook you want to add to the statement group
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Field Description
Do the following:

 1. Click .
The Financial Report List window appears, displaying the available 
financial statement workbooks.

 2. Click the workbook and click Select. 
The workbook name appears and default values appear in the other 
columns.

Report 
basis

The type of accounting basis used for printing the workbook:   accrual or cash
Do one of the following:

 l Accept the default value. 
Ajera will use the accounting basis selected on the Workbook Properties 
sheet of the workbook.

 l Click  and change the report basis to Accrual or Cash. 
Ajera will override the accounting basis selected on the Workbook 
Properties sheet of the workbook, if needed. 

Department The department to which the workbook is restricted when printing the statement 
group 

Ajera will print information for the department selected, in conjunction with any 
other filters you may have selected in the financial statement design.
Do one of the following:

 l Accept the default value.
Ajera will use the department filter selected on the Workbook Properties 
sheet of the workbook.

 l Click  and select to print information for each department or an 
individual department.

Reporting 
entity

The reporting entity to which the workbook is restricted when printing the statement 
group.

Ajera will print information for the reporting entity selected, in conjunction with any 
other filters you may have selected in the financial statement design.
Do one of the following:

 l Accept the default value.
Ajera will use the reporting entity filter selected on the Workbook 
Properties sheet of the workbook.

 l Click  and select to print information for each reporting entity or an 
individual reporting entity.

Company Multi-company only. The company to which the workbook is restricted when 
printing the statement group

Ajera will print information for the reporting entity selected, in conjunction with any 
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Field Description
other filters you may have selected in the financial statement design.
Do one of the following:

 l Accept the default value.
Ajera will use the company filter selected on the Workbook Properties 
sheet of the workbook.

Note: If you select a column in the workbook and apply a company filter for 
the selected column, that selection will override any company filters 
set on the Workbook Properties window.

 l Click  and select to print information for each company or an individual 
company.

Copies The number of copies to print
Do one of the following:

 l Accept the default value, which is 1.
 l Enter a different number if you want to print multiple copies.

 4. Click the next row and repeat Step 3 for any financial statement workbook you want to change.
 5. Click Save. 

Deleting a statement group

To delete a statement group

 1. From   the  >  Reports menu, click Manage Financial Statements > Groups. 
 2. On the Existing tab, click   the statement group you want to delete, and click   the Delete button.
 3. Click   Yes to delete the statement group. 

For managers

Previewing or printing a statement group
If you have access to a statement group, you can preview or print it from the Reports menu.
When you print a statement group, all statements in the group print. Unless the statement group consists of 
only one statement, you cannot print individual statements. 

Note: If you have permission to manage financial statements and want to print a single statement 
or a single worksheet, see Printing a financial statement.

To preview or print a statement group
 1. From the  >  Reports menu, click Financial > Financial Statements > <statement group>. 
 2. The reporting period is always set for the previous month. If needed, click   (Change View), select a 

different period, and click OK.
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Note:  l If you select a date range, the end date is used to assign the current month. For 
example, if you enter a date range of 01/15/11 to 02/14/11, the current month is 
considered February 2011.

 l You can also change the reporting period on the Financial Statement preview 
window. If you change it there, click  (Refresh) to update the data.

 3. If you do not want to preview the statement group before printing, click the Print button. Skip the rest 
of these instructions.

 4. To preview the statement group before printing, click the Preview button. The Financial Statement 
preview window, with a subtab for each statement in the group, appears. If the statement group is set 
up to print for each department or each reporting entity, then a subtab for each department or each 
reporting entity appears.

 5. Click the Print button.

Exporting a statement group to Excel
You can export a financial statement group to Microsoft Excel 2003. 

Depending on your security permissions, you can export a financial statement group from two places on the 
 > Reports menu. 

 l To export from the  > Reports > Financial > Statement Groups menu option, you must have access 
to that statement group.

 l To export from the  > Reports > Manage Financial Statements > Groups menu option, you must 
have permission to manage financial statements.

The exported statement group contains the formulas and financial information from the   Ajera database that is 
specified in the designs. The group is not linked to the   Financial Statement Designer.  

To export from the Financial Statements > <statement group> menu option:

 1. From the  >  Reports menu, click Financial > Financial Statements > <statement group>. 
 2. The reporting period is always set for the previous month. If needed, click   (Change View), select a 

different period, and click OK.

Note:  l If you select a date range, the end date is used to assign the current month. For 
example, if you enter a date range of 01/15/11 to 02/14/11, the current month is 
considered February 2011.

 l If a statement contains a custom date property, only information as of the period 
selected will be included. For example, if your custom date property contains a 
date range of 9/15/11-10/5/11 and the period selected is September 2011, activity 
for 10/1-10/5 will not be included.

 l You can also change the reporting period on the Financial Statement preview 
window. If you change it there, click  (Refresh) to update the data.

 3. If you do not want to preview the statement group before printing, click the Print button. Skip the rest 
of these instructions.

 4. To preview the statement group before printing, click the Preview button. The Financial Statement 
preview window, with a subtab for each statement in the group, appears. If the statement group is set 
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up to print for each company (multi-company only), department, or reporting entity, then a subtab for 
each company, department, or reporting entity appears. 

 5. Click the Print button.

To export from the Manage Financial Statements > Groups menu option:

 1. From the  >  Reports menu, click Manage Financial Statements > Groups. 
 2. Click the Existing   tab.
 3. The reporting period is always set for the previous month. If needed, click  (Change View), select a 

different period, and click OK. See the Note in the preceding section for more information about 
reporting periods.

 4. Click the financial statement group you want to export, and click the Preview button.
 5. Click the Export button.
 6. Browse to the location where   you want to export the financial statement group, and click Save.   The 

file name includes a file extension of .xls to indicate that it is   a Microsoft Excel spreadsheet 
document.

Company budgets

About company budgets
Company budgets are used for comparative financial reporting. The budgets   you enter in Ajera can be used in 
financial statements to compare actual   performance to budget. 
You enter budgets only for profit and loss accounts. You can enter one   budget per fiscal year.

Entering a company budget

To enter a company budget

 1. From the  >  Setup   menu, click Company > Budgets. 
 2. Multi-company only. Select a company.
 3. Select either the cash or accrual accounting basis account  to use for your budget. As you work with 

your budget, you can switch between   the two methods, as needed. 
 4. Type the fiscal year of   the budget. 

Note: Ajera   displays the fiscal year in the table beginning with the first month of   your fiscal year 
as selected on the General tab of company preferences.

 5. Type a reference number   or identifier for the budget and a short description.
 6. Enter   any notes about the budget.
 7. The table contains a row   for each revenue and expense account/department combination from your   

chart of accounts. Maximize the size of the window so it displays as much   of the table as possible.
 8. Do one of the following:

 l Distribute an amount across all months of the fiscal   year by entering the amount in the Annual 
column.              

 l Enter an amount for each month of the year. You may   need to use the scroll bar to see all the 
months.             
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Note: To   enter a negative amount, enter a minus sign. For example, in your budget   for the 
Professional Fees Write-Off account, which is an Income account,   you reduce revenue 
by entering an amount with a minus sign.

 9. You can change   the order and grouping of information in the table. For example, you   may want to sort 
by the account number to compare amounts from the same   account for each department. 

 10. Repeat these instructions   to enter information for all the rows in the table.              
 11. Click Save.
 12. Click Close.

Copying a company budget

To copy a company budget

 1. From the  >  Setup   menu, click Company > Budgets.
 2. Multi-company only. Select a company.
 3. Type the fiscal year for   the budget you want to copy. 
 4. Type the fiscal year for   your new budget. 
 5. Click Yes to copy the budget   currently on the screen.
 6. Make changes to the budget   as needed.
 7. Click Save.   
 8. Click Close.

Changing a company budget
Ajera displays the months of the year in the table depending on how your fiscal   year was set up on the General
   tab of  > Setup > Company > Preferences.

To change a company budget

 1. From the  >  Setup   menu, click Company > Budgets. The Budgets   window appears with the 
budget for the current fiscal year.

 2. Multi-company only. Select a company.
 3. Change the  accounting basis,   if needed.
 4. Change the reference number   or identifier for the budget and the short description, if needed.
 5. Change   any notes about the budget.
 6. The table contains a row   for each revenue and expense account/department combination from your  

chart of accounts. To change an account number or identifier, type it or click   .
 7. Change amounts in the table   as follows:

 l Change an amount for a month by typing it or using   the calculator. You may need to use the scroll 
bar to see all the   months.

 l Distribute an amount across all months of the fiscal   year by entering it in the Annual cell. Either 
type the amount or use   the calculator.

 l Delete amounts for an entire row by clicking the row   and clicking Delete.   Click Yes to delete the 
row.
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Note: An   amount that you enter in this table is a debit for an account with a type   of Billable Cost 
or Expense, and a credit for an account with a type of   Income or Other Income.

 8. You can change   the order and grouping of information in the table. For example, you   may want to sort 
by the account number to compare amounts from the same   account for each department. 

 9. Click Save.
 10. Click Close.

Deleting a company budget

To delete a company budget

 1. From the  >  Setup   menu, click Company > Budgets. 
 2. Multi-company only. Select a company.
 3. To delete only amounts for   a row:

 l Click the row, and click the Delete   button.              
 l Click Yes to   delete the row.             

 4. To delete amounts for the   entire budget:             
 l Click the Fiscal Year field, and click the Delete   button.              
 l Click  Yes to  delete the budget.
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timesheets  116

viewing, scheduled hours  84
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multi-company  122

paying  131

printing  129

rejecting  131

submitting  130
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inquiry to Acrobat  191
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exporting to Excel  205

formulas  206

headers and footers  208
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workbooks, importing  206
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H
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menu, changing  171

predefined columns  175

printing  188

producing  150

saving  170

searching  172

toolbar  172
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removing  183
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expense reports  123

invoice adjustments  51
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deleting  61
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labor resources  35
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M
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approving project time  116
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copying  69
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Microsoft SQL Server Reporting Services 
(MSSRS)  165
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exporting inquiry  191

importing inquiry  191

N
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operators for inquiries  183

options for reports  166
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copying  106

deleting  106
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overhead time  91

P

P&L (Profit and Loss) statement
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page breaks in financial statements  208

paying

expense report  131

percent complete  37
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Business Development (BD), adding  71

changing  45

changing status  47

deleting  48

premium time  91

printing

expense reports  129

financial statements  204

inquiries  188

reports  165

statement groups  220

timesheets  92

processed expense report  132

producing

reports  165

Profit and Loss (P&L) Statement

changing template  200

project budgeting  35

bottom-up  41

distributing amounts  37
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top-down  38
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Project Command Center  23

customizing  30

selecting project detail to view  31
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project management  28
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project templates  24
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bottom-up budgeting  41

changing  34
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top-down budgeting  38

project time  119
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BD projects, updating  71

changing  45

deleting  47

employees, adding  79

estimating  28

exporting, schedules  87

managing  28

multiple clients  51

phase status  47

Project Command Center  23

resources, adding  48

scheduling  49

status  46
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time  119

viewing, project detail  31

viewing, project list  30

viewing, schedule hours  81

Q

quick project template  24

R
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phase status  47

project status  46

recalculating

budget totals  44
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rejecting  131

expenses  132

time  115
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report views  169
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deleting  169
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project  137

reporting options

audit  145

custom  156
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financial  136

general  143
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producing reports  147

security  161
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resources  35

adding  48
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rates  36

reviewing

employee workload  87

S

Schedule Manager  77
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employees, changing  80

employees, deleting  80
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employees, scheduling  86

employees, viewing hours  84

exporting, by employees  88

exporting, by projects  87

projects, viewing hours  81

reviewing your schedule  87

schedules, deleting  87

schedules, exporting to Excel  87
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scheduling, projects  83
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viewing, project hours  81

scheduling  77

employee hours by employee  86
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projects  49

security

reporting, for  161

setting conditions for inquiries  183

inquiry conditions  183

shortcuts
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timeline (Gantt chart)  33

sorting

inquiry column  173

statement groups  215

changing  218

creating  215

deleting  220

printing  220
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Cash Flows template  203

status
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submitting

expense reports  130

timesheets  92

timesheets, mobile  109

symbols
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project  119

rejecting  115
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project  119

time by project  119
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timer

with tracking  93
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copying  93

deleting  100
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submitting  92
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